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To reduce the risk of fire or
electric shock, do not
expose this apparatus to
rain or moisture.

To avoid electrical shock,
do not open the cabinet.
Refer servicing to qualified
personnel only.

Important Safety Instructions

* Read these instructions.

* Keep these instructions.

* Heed all warnings.

* Follow all instructions.

* Do not use this apparatus near water.

¢ Clean only with dry cloth.

* Do not block any ventilation openings.
Install in accordance with the
manufacturer’s instructions.

* Do not install near any heat sources such
as radiators, heat registers, stoves, or
other apparatus (including amplifiers) that
produce heat.

* Do not defeat the safety purpose of the
polarized or grounding-type plug. A
polarized plug has two blades with one
wider than the other. A grounding-type
plug has two blades and a third grounding
prong. The wide blade or the third prong
are provided for your safety. If the
provided plug does not fit into your outlet,
consult an electrician for replacement of
the obsolete outlet.

* Protect the power cord from being walked
on or pinched particularly at plugs,
convenience receptacles, and the point
where they exit from the apparatus.

* Only use attachments/accessories
specified by the manufacturer.

* Refer all servicing to qualified service
personnel. Servicing is required when the
apparatus has been damaged in any way,
such as power-supply cord or plug is
damaged, liquid has been spilled or
objects have fallen into the apparatus, the
apparatus has been exposed to rain or

moisture, does not operate normally, or
has been dropped.

WARNING

Excessive sound pressure from earphones
and headphones can cause hearing loss.
In order to use this product safely, avoid
prolonged listening at excessive sound
pressure levels.

For the customers in the U.S.A.

This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses, and can radiate
radio frequency energy and, if not installed
and used in accordance with the
instructions, may cause harmful interference
to radio communications. However, there is
no guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be
determined by turning the equipment off and
on, the user is encouraged to try to correct
the interference by one or more of the
following measures:

- Reorient or relocate the receiving
antenna.

- Increase the separation between the
equipment and receiver.

- Connect the equipment into an outleton a
circuit different from that to which the
receiver is connected.

- Consult the dealer or an experienced
radio/TV technician for help.

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate
this equipment.

All interface cables used to connect
peripherals must be shielded in order to
comply with the limits for a digital device
pursuant to Subpart B of Part 15 of FCC
Rules.

If you have any questions about this product,
you may call;



Sony Customer Information Service Center www.dtsc.ca.gov/hazardouswaste/

1-800-222-7669 or http://www.sony.com/ perchlorate
Perchlorate Material : Lithium battery
Declaration of Conformity contains perchlorate.
Trade Name : SONY For the customers in Taiwan only
Model : PMW-500

Responsible party : Sony Electronics Inc. n
Address 1 16530 Via Esprillo,

San Diego, CA

92127 U.S.A. u
Telephone Number: 858-942-2230 %R 5 A
This device complies with part 15 of the
FCC Rules. Operation is subject to the
following two conditions: (1) this device
may not cause harmful interference, and
(2) this device must accept any
interference received, including
interference that may cause undesired
operation.

For the customers in Canada
This Class B digital apparatus complies with
Canadian ICES-0083.

For the customers in Europe

This product with the CE marking complies

with the EMC Directive issued by the

Commission of the European Community.

Compliance with this directive implies

conformity to the following European

standards:

e EN55103-1: Electromagnetic
Interference(Emission)

* EN55103-2: Electromagnetic
Susceptibility(Immunity)

This product is intended for use in the

following Electromagnetic Environments: E1

(residential), E2 (commercial and light

industrial), E3 (urban outdoors), E4

(controlled EMC environment, ex. TV

studio).

The manufacturer of this product is Sony
Corporation, 1-7-1 Konan, Minato-ku,
Tokyo, Japan.

The Authorized Representative for EMC and
product safety is Sony Deutschland GmbH,
Hedelfinger Strasse 61, 70327 Stuttgart,
Germany.

For the State of California, USA only
Perchlorate Material - special handling may
apply, See
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Foreword

Before Use

After purchasing the PMW-500 Solid-State
Memory Camcorder, before operating, it is
necessary to set the area of use.

(Unless this setting is made, the camcorder will
not operate.)

For details of these settings, see “Setting the Area of
Use” (page 36).

Before attaching/removing optional components or
accessories to/from the PMW-500 (referred to as “the
camcorder”), be sure to turn the power of the camcorder
off.

Mode Indications in This
Manual

Some functions and information are available
only when this camcorder is in a specific
operating mode. This manual indicates those
modes by using the following marks. When these
marks appear, the associated function or
information is available only in that mode.

HD mode: When OPERATION >Format >HD/
SD in the setup menu is set to [HD].

UDF mode: When OPERATION >Format >File
System in the setup menu is set to [UDF].

FAT

FAT mode: When OPERATION >Format >File
System in the setup menu is set to [FAT].
FAT-HD

FAT-HD mode: When OPERATION >Format
>File System in the setup menu is set to [FAT]
and OPERATION >Format >HD/SD in the setup
menu is set to [HD].

FAT-SD

FAT-SD mode: When OPERATION >Format
>File System in the setup menu is set to [FAT]
and OPERATION >Format >HD/SD in the setup
menu is set to [SD].

Foreword / Mode Indications in This Manual

9
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Features

2/5-inch full-HD “PowerHAD FX” CCDs

« IT (Interline Transfer) 2/3—inch progressive
image sensors with 207 million pixels, for full
HD resolution (1920 x 1080)

* “PowerHAD FX” CCDs, featuring a signal
processing ASIC with 14-bit A/D converters
These new image sensor technologies enable
the capture of very high-quality images, with
F11 (59.94i) and F12 (50i) sensitivity and an
SN ratio of 59 dB.

1) With noise suppression on (off value is 54 dB) Noise
suppression uses proprietary Sony signal processing
technology to suppress noise in highfrequency
regions.

SxS memory cards as recording media

Using SxS memory cards, the camcorder offers
nonlinear capabilities such as instant random
access and file-based operation.

You can choose FAT or UDF as the file system
for recording media.

For recording in FAT mode, it offers a choice of
bit rates: either 35 Mbps (HQ mode) or 25 Mbps
(SP mode).
For recording in UDF mode, it offers a choice of
bit rates: either 35 Mbps (HQ mode) or 50 Mbps
(HD422 mode).
By utilizing an efficient compression format, the
camcorder records high-quality HD images for
long recording time of approx. 60 minutes at 50
Mbps (HD422 mode) or approx. 90 minutes at 35
Mbps (HQ mode) on a single 32-GB SxS memory
card (when the recording mode is UDF).
It can also record and play two SD formats:
MPEG IMX 50 Mbps and DVCAM 25 Mbps. !
1) CBK-MDO1 SD Record and Playback Key required.
For details, contact a Sony service representative

Multi-format support

The camcorder supports interlace format
recording (1080/59.94i or 1080/501), progressive
format recording (1080/29.97P, 1080/23.98P,
720/59.94P, 720/29.97P, 720/23.98P, or 1080/
25P, 720/50P, 720/25P), thus offering the
flexibility needed for worldwide HD recording.
It also supports recording and playback of SD
signals (both NTSC and PAL). The camcorder
has an optional capability to record and play back
SD signals in IMX/DVCAM format, and can
output HD signals down-converted to SD.

Light weight, low power consumption

Design features custom video signal processing
ICs, and SxS memory card recording enable
fanless operation and power consumption of 29
W or less. The camcorder’s light weight (3.4 kg
(71b 7.9 0z)) and low center of gravity make it
easy to carry on the shoulder while ensuring
superior stability.

HD recording using the “MPEG-2 Long
GOP” codec and SD recording in MPEG
IMX50/DVCAM format

The camcorder records 1920 x 1080, 1440 x

1080, and 1280 x 720 HD images using “MPEG-
2 Long GOP” codec compression.

Features

A variety of functions for improved
performance under various shooting
conditions

* Picture Cache function

* Optical ND filters and electrical CC filters
* Hyper gamma

* Slow shutter function

* Clip Continuous Rec function

* Frame Recording function

* Time lapse function (interval recording)

* Slow & quick motion function

* Freeze mix function

* Focus magnification function

* Assignable switches

* 3.5-inch high-resolution color LCD monitor
* Remote control



Inherits unique features of XDCAM series

The camcorder inherits the workflow features of
the XDCAM series, including thumbnail display
and metadata management, and improves them
by introducing an improved man-machine
interface.

Camcorder system configuration

Installation of the optional CBK-HDO02 makes it
possible to attach a camera adaptor and connect a
camera extension unit to configure a shooting and
recording system.

Using the Software

The supplied CD-ROM I(abeled “Utility
Software for XDCAM”) contains application and
device driver software required to access to SxS
memory cards from a computer and to manage
material shot with the camcorder.

Information about how to install the software is
provided in PDF format.

You must install the SxS device driver and SxS UDF
driver software on your computer if it is equipped with
an ExpressCard slot and you want to use it to access SxS
memory cards, if you want to connect the camcorder to
your computer, and if you want to connect an optional
SBAC-US10 SxS Memory Card USB Reader/Writer to
the computer.

Using the Software

MaInIen | Jeydeyn
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Reading the CD-ROM
Manuals

Preparations

The following program must be installed on your
computer in order to read the documents
contained on the CD-ROM.

Adobe Reader Version 6.0 or higher

If Adobe Reader is not installed, you can download it
from the following URL:
http://www.adobe.com/

Adobe and Adobe Reader are trademarks of Adobe
Systems Incorporated in the United States and/or other
countries.

Locations and Functions
of Parts and Controls

Power Supply

To read the documents

Do the following:

1 Insert the CD-ROM in your CD-ROM
drive.
A cover page appears automatically in your
browser.
If it does not appear automatically in the
browser, double-click on the index.htm file
on the CD-ROM.

2 Select and click on the manual that you
wish to read.
This opens the PDF file.

The files may not be displayed properly, depending on
the version of Adobe Reader. In such a case, install the
latest version you can download from the URL
mentioned in “Preparations” above.

If you have lost or damaged the CD-ROM, you can
purchase a new one to replace it. Contact a Sony service
representative.

Camera adaptor connector (see page 13)

El LIGHT switch

Determines how a video light connected to the

LIGHT connector (see page 14) is turned on and

off.

AUTO: When the POWER switch of the video
light is in the on position, the video light is
turned on automatically while the camcorder
is recording.

MANUAL: You can turn the video light on or off
manually, using its own switch.

‘When the camcorder is set for recording in Picture Cache
mode, it is not possible to turn on the light before
operation to start recording is carried out (or while data
is being stored in memory).

POWER switch
Turns the main power supply on and off.

Reading the CD-ROM Manuals / Locations and Functions of Parts and Controls




DC IN (DC power input) connector
(XLR type, 4-pin, male)

To operate the camcorder from an AC power

supply, connect an optional DC power cord to this

terminal and then connect the cord to the DC

output terminal of the BC-L70, BC-L160, or

another battery charger.

1 DC OUT 12V (DC power output)
connector (4-pin, female)

Supplies power for an optional WRR-860C/861/

862 UHF Synthesized Diversity Tuner

(maximum 0.5 A).

Do not connect any equipment other than the UHF
synthesized diversity tuner.

Battery attachment shoe

Attach a BP-GL95/GL65/L80S/L60S Battery
Pack. Alternatively, you can attach an AC-
DN2B/DN10 AC Adaptor to operate the
camcorder on AC power supply.

For details, see “Preparing a Power Supply”
(page 31).

For details, see “Attaching a UHF Portable Tuner
(for a UHF Wireless Microphone System)”

(page 41).

For your safety, and to ensure proper operation of the
camcorder, Sony recommends the use of the following
battery packs: BP-GL95, BP-GL65, BP-L60S, and
BP-L80S.

Camera adaptor connector

Enables connection of a camera adaptor. To
connect a camera adaptor, remove the cover from
the connector and install the optional CBK-HD02
SDI/COMPOSITE Input and 50 Pin Interface.

Accessory Attachments

Shoulder strap fitting
Attach the supplied shoulder strap (see page 45).

Accessory fitting shoe
Attach an optional accessory such as a video light
(see page 44).

Viewfinder front-to-back positioning
lever

To adjust the viewfinder position in the front-to-

back direction, loosen this lever and the LOCK

knob. After adjustment, retighten this lever and

the LOCK knob.

B Viewfinder left-to-right positioning ring
Loosen this ring to adjust the left-to-right position
of the viewfinder (see page 33).

Viewfinder fitting shoe
Attach the viewfinder.

E VF (viewfinder) connectors (26-pin,
rectangular and 20-pin, round)

The analog interface connector (20-pin) is for

connection of a HD viewfinder, and the digital

interface connector (26-pin) is for connection of a

PMW viewfinder.

Use a connection cable to connect your

viewfinder to the corresponding connector.

1) The CBK-VF01 PMW Viewfinder will be available

from March 2011.

Locations and Functions of Parts and Controls

MaInIen | Jeydeyn
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Do not connect viewfinders to both connectors at the
same time.

Lens mount securing rubber

After locking the lens in position using the lens
locking lever, fit this rubber over the lower of the
two projections. This fixes the lens mount,
preventing it from coming loose.

Bl Viewfinder front-to-back positioning
knob (LOCK knob)

Loosen this knob to adjust the front-to-back
position of the viewfinder (see page 33).

E Fitting for optional microphone holder
Fit an optional CAC-12 Microphone Holder (see
page 40).

Shoulder pad

Raise the shoulder pad fixing lever to adjust the
position in the front-to-rear direction. Adjust the
position for maximum convenience when
operating the camcorder on your shoulder (see
page 46).

LIGHT (video light) connector (2-pin,
female)

A video light with a maximum power

consumption of 50 W, such as the Anton Bauer

Ultralight 2 or equivalent can be connected (see

page 44).

Lens cable clamp
Clamp a lens cable.

MIC IN (microphone input) (+48 V)
connector (XLR type, 5-pin, female)

Connect a stereo microphone to this connector.

The power (+48 V) is supplied via this connector.

LENS connector (12-pin)
Connect a lens cable to this connector.

‘When connecting or disconnecting the lens cable to this
connector, power off the camcorder first.

Tripod mount
When using the camcorder on a tripod, attach the
tripod adaptor (optional).

Locations and Functions of Parts and Controls

@ Lens mount (special bayonet mount)
Attach the lens.

Consult a Sony service representative for
information about available lenses.

Lens locking lever

After inserting the lens in the lens mount, rotate
the lens mount ring with this lever to lock the lens
in position.

After locking the lens, be sure to use the lens
mount securing rubber to prevent the lens from
becoming detached.

B Lens mount cap

Remove by pushing up the lens locking lever.
When no lens is mounted, keep this cap fitted for
protection from dust.

Operating and Connectors Section

Front

Kl REC START (recording start) button
Press to start recording. Press it again to stop
recording. The effect is the same as that of the
REC button on the lens.

SHUTTER selector

Set to ON to use the electronic shutter. Push to
SELECT to switch the shutter speed or shutter
mode setting. When this switch is operated, the
new setting appears on the viewfinder screen for
about three seconds.



For details, see “Setting the Electronic Shutter”
(page 53).

FILTER selector

Switches between four ND filters built into this
camcorder.

When this selector is used, the new setting
appears on the viewfinder screen for about three
seconds.

FILTER selector ND filter

setting

1 CLEAR

2 T/, ND (attenuates light to
approximately ]/4)

3 Iy 16 ND (attenuates light to
approximately 1/]6)

4 1/64 ND (attenuates light to

approximately 1/64)

You can change a MAINTENANCE menu
setting so that different white balance settings can
be stored for different FILTER selector positions.
This allows you to automatically obtain optimum
white balance for the current shooting conditions
in linkage with the filter selection.

For details, see “Adjusting the White Balance”
(page 51).

1 MENU knob
Changes the item selection or a setting within the
menu (see page 97).

AUTO W/B BAL (automatic white/
black balance adjustment) switch

Activates the automatic white/black balance

adjustment functions.

WHITE: Adjust the white balance automatically.
If the WHITE BAL switch (see page 16) is
set to A or B, the white balance setting is
stored in the corresponding memory. If the
WHITE BAL switch is set to PRST, the
automatic white balance adjustment function
does not operate.

BLACK: Adjust the black set and black balance
automatically.

You can use the AUTO W/B BAL switch even

when the ATW (Auto Tracing White Balance)

function is operating.

If you push the switch to the WHITE side once

more during the automatic white balance

adjustment, the adjustment is cancelled and the

white balance setting returns to the original
setting.

If you push the switch to the BLACK side once
more during the automatic black balance
adjustment, the adjustment is cancelled and the
black balance setting returns to the original
setting.

[ mic (microphone) LEVEL control
Adjusts the input level of audio channels 1, 2, 3
and 4 (see page 56).

Right side (near the front)

N
&

A\

=2
({

L |\

O o
e
orr

ASSIGN. (assignable) 1/2/3 switches
You can assign the desired functions to these
switches on OPERATION >Assignable SW in
the setup menu (see page 135).

Off is assigned to the ASSIGN 1/2/3 switches as
the factory default setting.

The ASSIGN.1/3 switches are provided with an
indicator to show whether a function is assigned
to the switch (ON) or not (OFF).

Locations and Functions of Parts and Controls
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COLOR TEMP. (color temperature)
button

Press to light the button and change the color

temperature for shooting (factory default setting).

You can use this as an assignable switch (see

page 135).

ALARM (alarm tone volume
adjustment) knob
Controls the volume of the warning tone that is
output via the built-in speaker or optional
earphones. When the knob is turned to the
minimum position, no sound can be heard.
However, if MAINTENANCE >Audio >Min
Alarm Volume in the setup menu is set to [Set],
the alarm tone is audible even when this volume
control is at the minimum position.

1 MONITOR (monitor volume
adjustment) knob

Controls the volume of the sound other than the

warning tone that is output via the built-in speaker

or earphones. When the knob is turned to the

minimum position, no sound can be heard.

MONITOR (audio monitor selection)
switches

By means of combinations of the two switches,
you can select audio that you want to hear through
the built-in speaker or earphones.

Position of down-side switch: CH-1/2

Position of up-side Audio output

switch

CH-1/CH-3 Channel 1 audio

MIX Channels 1 and 2 mixed
audio (stereo) ¥

CH-2/CH-4 Channel 2 audio

Position of down-side switch: CH-3/4

Position of up-side Audio output

switch

CH-1/CH-3 Channel 3 audio

MIX Channels 3 and 4 mixed
audio (stereo) ¥

CH-2/CH-4 Channel 4 audio

Locations and Functions of Parts and Controls

a) By connecting stereo headphones to the EARPHONE
jack, you can hear the audio in stereo. (Under
MAINTENANCE >Audio in the setup menu,
Headphone Out must be set to STEREO.)

A ASSIGN. (assignable) 0 switch

You can assign the desired function to this switch
on OPERATION >Assignable SW in the setup
menu (see page 136).

Off is assigned to this switch when the camcorder
is shipped from the factory.

This is a momentary type switch. Each press of
the switch turns the function assigned to this
switch on or off.

GAIN selector

Switches the gain of the video amplifier to match
the lighting conditions during shooting. The gains
corresponding to the L, M, and H settings can be
selected on OPERATION >Gain Switch in the
setup menu (see page 106). (The factory settings
are L=0 dB, M=6 dB, and H=12 dB.)

When this switch is adjusted, the new setting
appears on the viewfinder screen for about three
seconds.

El OUTPUT/DCC (output signal/dynamic
contrast control) switch

Switches the video signal output from the camera

module, between the following two.

BARS: Output the color bar signal.

CAM: Output the video signal being shot. When
this is selected, you can switch DCC D onand
off.

1) DCC (Dynamic Contrast Control): Against a very
bright background with the iris opening adjusted to the
subject, objects in the background will be lost in the
glare. The DCC function will suppress the high
intensity and restore much of the lost detail and is
particularly effective in the following cases.

* Shooting people in the shade on a sunny day

« Shooting a subject indoors, against a background
through a window

« Any high contrast scene

E WHITE BAL (white balance memory)
switch

Controls adjustment of the white balance.

PRST: Adjust the color temperature to the preset
value (the factory default setting: 3200K).
Use this setting when you have no time to
adjust the white balance.

A or B: Recall the white balance adjustment
settings already stored in A or B. Push the



AUTO W/B BAL switch (see page 15) on
the WHITE side, to automatically adjust the
white balance, and save the adjustment
settings in memory A or memory B.

B (ATW 1)): When this switch is set to B and
OPERATION >White Setting >White
Switch<B> is set to [ATW] in the setup
menu, ATW is activated.

You can use the AUTO W/B BAL switch
even when ATW is in use.

When this switch is adjusted, the new setting

appears on the viewfinder screen for about three

seconds.

1) ATW (Auto Tracing White Balance): The white

balance of the picture being shot is adjusted
automatically for varying lighting conditions.

MENU ON/OFF switch

To use this switch, open the cover.

This switch is used to display the menu on the
viewfinder screen or the test signal screen. Each
time the switch is pushed down, the menu screen
is turned on and off.

The function of this switch is the same as that of
the MENU button in the thumbnail screen
operations section.

This switch has different functions depending on
whether or not a menu is displayed.

MENU CANCEL/PRST (preset) /
ESCAPE switch

To use the MENU CANCEL/PRST/ESCAPE

switch, open the cover.

It is not possible to turn off the menu screen by closing
the cover.

Use the switch in the following way when the

menu is not displayed.

CANCEL/PRST: Each time this switch is
pushed upward, a window to confirm the
menu settings and status of the camcorder
appears on the viewfinder screen (see
page 61). The window consists of five pages,
which are switched each time the switch is
pushed upward. Each page is displayed for
about 10 seconds.

ESCAPE: To clear the page immediately after
display, push this switch down to the OFF
position.

Use the switch in the following way when the

menu is displayed.

CANCEL/PRST: Pushing this switch up to this
position after a setting is changed in the setup
menu displays the message to confirm
whether the previous settings are cancelled.
Pushing this switch up to this position again
cancels the previous settings.

Pushing this switch up to this position before
a setting is changed in the setup menu or after
a setting change is cancelled in the setup
menu displays the message to confirm
whether the setting is reset to the initial
value.

Pushing this switch up to this position again
resets the settings to the initial value.

ESCAPE: Use this switch when the menu page,
which has a hierarchical structure, is opened.
Each time the switch is pushed to this
position, the page returns to one stage higher
in the hierarchy.

Cover

Open this cover to use the MENU ON/OFF
switch or the MENU CANCEL/PRST/ESCAPE
switch.

Locations and Functions of Parts and Controls
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Right side (near the rear)

5% 0

() { ) { )
FREV PLAY/PAUSE | F FWD
o o1l O »p

STOP

DIS(ETiSELHéT;’ FE;T E% BAES}HT

EXPAND RETURN COUNTER TC U-BIT

Built-in speaker

The speaker can be used to monitor E-E D sound

during recording, and playback sound during

playback. The speaker also sounds alarms to

reinforce visual warnings (see page 153).

If you connect earphones to the EARPHONE

jack, the speaker output is suppressed

automatically.

1) E-E: Abbreviation of “Electric-to-Electric”. In E-E
mode, video and audio signals input to the camcorder
are output after passing through internal electric
circuits only. This can be used to check input signals.

LCD monitor

Displays remaining battery capacity, remaining
media capacity, audio levels, time data, and so on
(see page 24).

Also allows you to check camera and playback
pictures.

Locations and Functions of Parts and Controls

You can adjust the position and angle of the LCD
monitor.

WARNING indicator
Lights up or flashes when an abnormality occurs
(see page 153).

B} ACCESS lamp
Lights up in blue when data is written to or read
from the recording media.

Protection cover of the audio control
section

Open to access the audio control section (see

page 20).

E Protection cover of the thumbnail
screen operations section

Open to access the thumbnail screen operations

section (see page 20).

F REYV (fast reverse) button and
indicator

This plays back at high speed in the reverse

direction. The playback speed changes in the

order x4 — x15 — x24 with each press of the

button. The indicator lights during high-speed

playback in the reverse direction.

El PLAY/PAUSE button and indicator
Press this button to view play back video images
using the viewfinder screen or the LCD monitor.
The indicator lights during playback.

Press this button again during playback to pause,
outputting a still image. At this time the indicator
flashes at a rate of once per second.

Pressing the F REV or F FWD button during
playback or pause starts high speed playback in
the forward or reverse direction.



El F FWD (fast forward) button and
indicator

This plays back at high speed in the forward

direction. The playback speed changes in the

order x4 — x15 — x24 with each press of the

button. The indicator lights during high-speed

playback in the forward direction.

PREYV button

This jumps to the first frame of the current clip.
If you press this together with the F REV button,
the jump is to the first frame of the first recorded
clip on the recording media.

If you press this button twice in rapid succession,
the jump is to the first frame of the last preceding
clip (or the first frame of the current clip when no
preceding clips exist).

STOP button
Press this button to stop playback.

NEXT button

This jumps to the first frame of the next clip.

If you press this together with the F FWD button,
the jump is to the first frame of the last recorded
clip on the recording media.

DISP SEL (display selection)/EXPAND
(expand function) button

With each press of this button, the display in the

LCD monitor changes as follows.

Display indication = Meaning
Video with The LCD monitor displays
superimposed the same text information as

information (CHAR) the viewfinder.

Status display
(STATUS)

Counter indications,
warnings, audio levels, and
similar information appear.
No video image appears.

If you press this button when the thumbnail
screen is displayed, the duration of the selected
clip is divided into fractions, and the first frame of
each of the divisions is shown in a further
thumbnail display (expand function). For an HD
recorded MP4 clip, its duration is divided into 12.
If an SD recorded AVI clip comprises multiple
files, the divisions are displayed for the individual
files.

For MP4 clips, each time you press this button the
division is repeated. Hold down the SHIFT button
and press this button to step back through the
division process.

HOLD (display hold) button

Pressing this button instantly freezes the time data
displayed in the LCD monitor. (The timecode
generator continues running.) Pressing this button
again releases the hold.

For details of the counter display, see page 24.

RESET/RETURN button

Resets the value shown in the time counter
display in the LCD monitor. According to the
settings of the PRESET/REGEN/CLOCK switch
(see page 21) and the F-RUN/SET/R-RUN
switch (see page 20), this button resets the
display as follows.

Settings of switches To reset

DISPLAY switch: COUNTER Counter to

0:00:00:00
DISPLAY switch: TC Timecode to
PRESET/REGEN/CLOCK  00:00:00:00
switch: PRESET
F-RUN/SET/R-RUN switch:
SET
DISPLAY switch: U-BIT User bits data® to
PRESET/REGEN/CLOCK 0000 00 00

switch: PRESET
F-RUN/SET/R-RUN switch:
SET

a) Of the timecode bits for every frame recorded on the
media, those bits which can be used to record useful
information for the user such as scene number,
shooting place, etc.

For details, see “Setting the Time Data” (page 58).

This button returns to the previous screen when
pressed during thumbnail screen display, expand
thumbnail screen display, or essence mark
thumbnail screen display.

@ DISPLAY switch

This cycles the data displayed in the time counter

display in the LCD monitor through the sequence

COUNTER, TC, and U-BIT (see page 24).

COUNTER: Display the elapsed recording/
playback time (hours, minutes, seconds,
frames).

TC: Display timecode.

U-BIT: Display user bits data.

Locations and Functions of Parts and Controls
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BRIGHT (brightness) button

Switches the brightness of the LCD monitor
backlight.

Each press of the button selects the next setting in
the order shown in the following table.

If you press the button with the LCD monitor off,
the LCD backlight comes on in the H state.

Setting LCD monitor backlight

H High (select this to view the LCD
monitor outdoors in the daytime)

M Brightness between H and L

L Low (select this to view the LCD monitor

indoors or outdoors at night)
Off (the display is also off)

OFF

Thumbnail screen operations section and audio
control section

THUMBNAIL indicator
This lights when thumbnail screen is displayed.

THUMBNAIL button

Press this button to display the thumbnail screen
(see page 79) and to carry out a thumbnail
operation.

Press once more to return to the original display.

SET (set) button and arrow buttons
Use these buttons to make timecode and user bit
settings, and for thumbnail screen operations (see
page 86).

When the menu is displayed, press this button to
select an item or to confirm the setting change.

1 MENU button

Each press of this button turns the setup menu
display on and off.

The function of this button is the same as that of
the MENU ON/OFF switch.

Locations and Functions of Parts and Controls

F-RUN/SET/R-RUN (free run/set/
recording run) switch

Selects the operating mode of the internal

timecode generator. The operating mode is set as

explained below, depending on the position of the
switch.

F-RUN: Timecode keeps advancing, regardless
of whether the camcorder is recording. Use
this setting when synchronizing the timecode
with external timecode.

SET: Sets the timecode or user bits.

R-RUN: Timecode advances only during
recording. Use this setting to have a
consecutive timecode on the recording
media.

For details, see “Setting the Timecode” (page 58)
and “Setting the User Bits” (page 59).

@ LEVEL CH1/CH2/CH3/CH4 (audio

channel 1/2/3/4 recording level) knobs
Adjust the audio levels to be recorded on channels
1, 2, 3, and 4 when the AUDIO SELECT CH1/
CH2 and AUDIO SELECT CH 3-4 switches are
set to MANUAL.

AUDIO SELECT CH 3-4 (audio
channel 3/4 adjustment method
selection) switch

Select the audio level adjustment method for each

of audio channels 3 and 4.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

Bl ESSENCE MARK button

By pressing this button when a thumbnail display

is on the screen, you can view the following

thumbnail displays of the essence-marked frames

of the selected clip, depending on the item

selected in a list displayed on the screen.

Shot Mark1: Thumbnail display of the frames
marked with Shot Mark 1

Shot Mark2: Thumbnail display of the frames
marked with Shot Mark 2

Shot Mark: Thumbnail display of the frames
marked with either Shot Mark 1 or Shot
Mark 2

Rec Start (UDF mode): Thumbnail display of
frames marked with Rec Start marks and of
the first frames of clips (when the first frames
are not marked with Rec Start marks).

All (UDF mode): Thumbnail display of all
frames marked with essence marks.



El SHIFT button
Use this in combination with other buttons.

PRESET/REGEN (regeneration)/
CLOCK switch

Selects the type of timecode to record.

PRESET: Record new timecode on the media.

REGEN: Record timecode continuous with the
existing timecode recorded on the media.
Regardless of the setting of the F-RUN/SET/
R-RUN switch, the camcorder operates in R-
RUN mode.

CLOCK: Record timecode synchronized to the
internal clock. Regardless of the setting of
the F-RUN/SET/R-RUN switch, the
camcorder operates in F-RUN mode.

AUDIO SELECT CH1/CH2 (audio
channel 1/2 adjustment method
selection) switches

Select the audio level adjustment method for each

of audio channels 1 and 2.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

AUDIO IN CH1/CH2/CH3/CH4 (audio
channel 1/2/3/4 input selection) switches

Select the audio input signals to be recorded on

audio channels 1, 2, 3 and 4.

FRONT: Audio input signals from the
microphone connected to the MIC IN
connector

REAR: Audio input signals from an audio device
connected to the AUDIO IN CH-1/CH-2
connectors

WIRELESS: Audio input signals from the UHF
portable tuner if it is installed

Left side and upper section

ASSIGNABLE 4/5 switches

You can assign the desired functions to these
switches on OPERATION >Assignable SW in
the setup menu (see page 136).

Off is assigned to these switches when the
camcorder is shipped from the factory.

Locations and Functions of Parts and Controls
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PC connector

Used to put this camcorder into USB connection
mode and use it as an external storage device for
a computer. When a computer without
ExpressCard slot is connected to this connector,
every memory card inserted in the camcorder is
recognized as a drive for that computer.

Wi-Fi adaptor connector
Connect a Wi-Fi adaptor. D

1) The CBK-WAO1 Wi-Fi Adaptor will be available
from March 2011.

A sxs memory card slots

These two slots (A and B) can receive SxS
memory cards or other recording media (see
page 64).

ACCESS lamps

Indicate the state of slots A and B (see page 64).
You can check whether the lamps are lit even
when the slot cover is closed.

A EJECT buttons

To remove the recording media from the slot,
press the EJECT button to release the lock, then
press the button once more. This makes the media
come out of the slot partially (see page 65).

Slot cover
Slide to the left and right to open and close.

El SLOT SELECT (SxS memory card
select) button

When SxS memory cards are loaded in both card

slots A and B, press this button to select the card

you want to use (see page 65).

El SDI IN (OPTION) (SDI input
(optional)) connector (BNC type)
When the optional CBK-HDO02 SDI/
COMPOSITE Input and 50 Pin Interface is
installed, the camcorder can record HDSDI or
SDSDI signals input to this connector.

GENLOCK IN (genlock signal input)
connector (BNC type)
This connector inputs a reference signal when the
camcorder is to be genlocked or when timecode is
to be synchronized with external equipment.
Available reference signals vary depending on the
current system frequency as shown in the
following table.

Locations and Functions of Parts and Controls

System frequency

Available reference signals

1080/59.94i 1080/59.94i, 480/59.94i

1080/29.97P 1080/59.94i, 480/59.94i

1080/23.98P (PsF 1080/23.98PsF, 480/59.94i

output)

1080/23.98P 1080/59.94i, 480/59.94i

(Pulldown output)

720/59.94P 1080/59.94i, 720/59.94P,
480/59.94i

720/29.97P 1080/59.94i, 720/59.94P,
480/59.94i

720/23.98P 1080/59.94i, 720/59.94P,
480/59.941

480/59.941 1080/59.94i, 480/59.94i

480/29.97P 1080/59.94i, 480/59.94i

1080/501 1080/50i, 576/501

1080/25P 1080/50i, 576/501

720/50P 10807501, 720/50P, 576/50i

720/25P 10807501, 720/50P, 576/50i

576/50i 1080/50i, 576/501

576/25P 1080/50i, 576/501

(Genlock for the camera module supports
horizontal sync signals only.) Use
MAINTENANCE >GENLOCK in the setup
menu to adjust the genlock H-phase (phase of
horizontal sync signal).

When the optional CBK-HDO02 SDI/
COMPOSITE Input and 50 Pin Interface is
installed, the camcorder can record analog
composite video signals input to this connector.

TC IN (timecode input) connector
(BNC type)

To apply an external lock to the timecode of the

camcorder, input the reference timecode.

For details, see “Setting the Timecode” (page 58).

VIDEO OUT connector (BNC type)
Outputs video signals for monitoring. The output
signals can be selected either composite video or
HD-Y depending on the setting of OPERATION
>Input/Output >Output&i.LINK in the setup
menu.

TC OUT (timecode output) connector
(BNC type)

To lock the timecode of an external VTR to the

timecode of this camcorder, connect this

connector to the external VTR’s timecode input

connector.



LT

clelepy

; 5 I

TEEET

TALLY (back tally) indicators (red)
Light up during recording. They will not light if
the TALLY switch is set to OFF. These indicators
also flash to indicate warnings (see page 18). The
tally indicator on the front of the viewfinder and
the REC indication on the viewfinder screen light
or flash in the same manner.

For details, see “Operation Warnings” (page 153).

TALLY switch
Set to ON to activate the TALLY indicator
function.

EARPHONE jack (stereo, minijack)
You can monitor the E-E sound during recording
and playback sound during playback. When an
alarm is indicated, you can hear the alarm sound
through the earphone. Plugging an earphone into
the jack automatically cuts off the built-in
speaker.

You can select monaural or stereo on
MAINTENANCE >Audio in the setup menu.

I AUDIO IN selectors

Select the audio source you connect to the

AUDIO IN CH1/CH2 connectors.

LINE: When connecting a stereo amplifier or
other external audio signal source

MIC: When connecting a microphone that does
not require 48 V power supply

+48V: When connecting a microphone that
requires 48 V power supply

HD/SD SDI OUT connector (BNC type)
Outputs an HDSDI or SDSDI signal (with
embedded audio). The output from this connector
can be turned on or off by OPERATION >Input/
Output >SDI Output in the setup menu.

@ AUDIO IN CH-1/CH-2 (audio channel
1 and channel 2 input) connectors (XLR
type, 3-pin, female)

These are audio input connectors for channels 1

and 2 to which you can connect audio equipment

or a microphone.

Bottom cover

This is provided for protecting the cables
connected to the connectors on the rear panel.
By loosening the screws which retain the cover to
the bottom of the camcorder, you can adjust the
position of the cover depending on the size and
shape of the microphone or audio cable plugs.
After adjusting the position, tighten the screws to
secure the cover.

E] AUDIO OUT connector (XLR type, 5-
pin, male)

Outputs the audio signals recorded on audio

channels 1 and 2 or audio channels 3 and 4. The

audio signals are selected by the MONITOR

switch.

E REMOTE connector (8-pin)
Connect a remote control unit, which makes it
possible to control the camcorder remotely.

Before connecting/disconnecting the Remote Control
Unit to/from the camcorder, be sure to turn off the
camcorder POWER switch.

Locations and Functions of Parts and Controls
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i.LINK (HDV/DV) connector (6-pin,
IEEE1394 compliant, S400)

FAT

When the recording mode is FAT, to input and
output HDV/DV streams, connect to an HDV/DV
device.

LCD Monitor

=i

01:23:45:67

H MIN SEC FR
Media Near Full
edia
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100%
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Resolution
Indicates the resolution of HD output video.

Indication Resolution (horizontal x vertical)
1080 1080 lines (1920 x 1080)
720 720 lines (1280 x 720)

Recording format
Indicates the current recording format or the
recording format of clip being currently played
back.
* UDF mode

HD422 50

HD420 HQ

IMX50

DVCAM

¢ FAT mode
HQ1920
HQ1440
HQ1280
SP1440
DVCAM

Recording mode
UDF: UDF mode
FAT: FAT mode

Locations and Functions of Parts and Controls

A File format

MXF: When the recording mode is UDF

MP4: When the recording mode is FAT-HD
mode

DV-AVI: When the recording mode is FAT-SD
mode

System frequency

Indicates the system frequency of video being
currently played back or recorded.

59.94i

29.97p

23.98P

50i

25P

59.94P

50P

A Status display

PB: Appears during playback.

NDF: Appears when non-drop-frame timecode is
selected.

EXT-LK: Appears when the internal timecode
generator is locked to an external signal input
to the TC IN (timecode input) connector.

HOLD: Appears when the internal timecode
generator is stopped.

Audio format
Indicates the audio recording format or the audio
format of clip being currently played back.

Indication Status

Recording Recording format

mode
16bit FAT Any format
UDF « HD420 HQ
« DVCAM
e IMX (Audio Length is
set to16 bit)
24bit UDF * HD422 50
e IMX (Audio Length is
set to24 bit)

Bl Audio level indicators
Indicate the audio recording or playback levels of
channels 1 to 4.

El Time counter display

Switches displays of time counter values,
timecode, and user bits data, depending on the
position of the DISPLAY switch.



Displays the type of data currently shown in the

time counter, as follows.

TCG: Recorded timecode

TCR: Playback timecode

UBG: Recorded user bits

UBR: Playback user bits

CNT: Counter

CLK: Time display (when the PRESET/REGEN/
CLOCK switch is set to CLOCK)

‘When the HOLD button is pressed to hold the
timecode value, the timecode is displayed in the
format shown below. When the HOLD button is
pressed again to release the hold, the timecode is
displayed in the normal format.

00(/00L/00L/00

The three dots indicates that timecode is
displayed in the hold mode.

Warning indicator area
Displays warnings when trouble with recording
or moisture condensation occurs.

For details, see “Operation Warnings” on page 153.

Remaining media capacity indicator
Shows bar segments indicating the remaining
capacity of recording media in the slots.

Remaining battery capacity indicator
Shows bar segments indicating the remaining
battery capacity.

HDVF-20A Viewfinder (Optional)

MaInIen | Jeydeyn
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Plug

Connect to the VF connector (20-pin) on the
camcorder.

Stopper

Prevents the viewfinder from coming off the
camcorder when it is slid from side to side.

Camera operator tally indicator

Lights up while camcorder is recording. This
indicator can be covered when not in use.

This indicator also flashes to indicate warnings, in
the same manner as the tally indicator and the
REC indicator in the viewfinder.

4] Eyecup

Indicators and status display

For details, see “Status Display on the Viewfinder
Screen” on page 26.

I Diopter adjustment ring
Allows for optimal focus adjustment.

Tally indicator

Lights up while camcorder is recording. Set the
TALLY switch to OFF when not in use. The
brightness can also be adjusted with the TALLY
switch.
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This indicator also flashes to indicate warnings, in
the same manner as the camera operator tally
indicator and the REC indicator in the viewfinder.

E PEAKING control

Turning this control clockwise adjusts the picture
sharpness, and makes focusing easier. This
control has no effect on the output signals of the
camcorder.

El CONTRAST control

Adjusts the contrast of the screen. This control
has no effect on the output signals of the
camcorder.

BRIGHT control

Adjusts the brightness of the screen. This control
has no effect on the output signals of the
camcorder.

TALLY switch

Controls the tally indicator located on the front of

the viewfinder.

HIGH: The tally indicator brightness is set to
high.

OFF: The tally indicator is disabled.

LOW: The tally indicator brightness is set to low.

ZEBRA (zebra pattern) switch

Controls the zebra pattern display on the

viewfinder screen as follows.

ON: A zebra pattern appears and stays.

OFF: The zebra pattern disappears.

MOMENT: A zebra pattern appears and stays for
about five seconds.

DISPLAY/ASPECT switch

Turns the marker indication on and off, and

switches between 4:3 and 16:9 aspect ratios for

viewfinder screen display.

DISPLAY: When the marker indication is
enabled with the camcorder, the marker
indication on the viewfinder screen turns on
and off every time you push the switch up to
this position.

ASPECT: Each push of the switch down to this
position toggles the mask display on and off.
(Make mask display settings using
OPERATION >Marker >Aspect Mask in the
setup menu (see page 105).)

Locations and Functions of Parts and Controls

Viewfinder cable

Microphone holder

Status Display on the Viewfinder
Screen

Indicators

The following indicators are arranged above and
below the viewfinder screen to show the current
state and adjustments of the camcorder.

TALLY/REC

o O mme——=H
——H

—1a

Cf 1 c—8A
VTR
SAVE a

Kl TALLY (green tally) indicator

Lights when the camcorder is the following

states.

* Picture Cache mode enabled

* Green tally signal received (when a camera
adaptor installed on this camcorder is connected
to a camera extension unit)

* Recording with MAINTENANCE >Camera
Config >HD/SDI Remote I/F in the setup menu
set to [G-Tally]

Flashes when the camcorder is the following

states.

* Set to Interval Rec mode or the consecutive
mode of Frame Rec mode (1 flash per second)

* Recording in Interval Rec mode or recording in
the consecutive mode of Frame Rec mode (4
flashes per second)

* Set to the single-shot mode of Frame Rec mode,
or recording in that mode (2 flashes per second)



BATT (battery) indicator

This indicator starts flashing when the battery
connected to the camcorder is nearly exhausted,
and stays lit when the battery is completely
exhausted.

To prevent interruption during operation, replace

the battery as soon as this indicator starts flashing.

The battery power level at which the indicator starts
flashing can be set by MAINTENANCE >Battery in
the setup menu. For details, see page 118.

REC (recording, red tally) indicator

Lights when the camcorder is the following

states.

¢ Recording with the MAINTENANCE >Camera
Config >HD/SDI Remote I/F menu item set to
[R-Tally]

 Green tally signal or call signal received (when
a camera adaptor installed on this camcorder is
connected to a camera extension unit)

This indicator also flashes to indicate warnings, in
the same manner as the tally indicator and the
camera operator tally indicator.

ﬂ Viewfinder screen

See “Viewfinder screen display” (page 27).

VTR SAVE indicator
Do not function on this camcorder.

IA ! (warning) indicator

This indicator lights when any of the following

conditions occurs with the corresponding item set

to [On] by OPERATION >“!” LED in the setup

menu.

* The gain is set to other than 0 dB.

* The SHUTTER selector is not set to the
standard setting. D

* The WHITE BAL switch is set to PRST.

¢ ATW is enabled.

* The lens extender is used.

 The reference value of auto iris adjustment is
not the standard value.

1) The standard SHUTTER setting differs as follows,
depending on the recording format.
1080/50i, 1080/59.94i, 720/50P, 720/59.94P (SCAN
MODE: 59.9P): The SHUTTER selector is set to
OFF.
1080/23.98P, 720/59.94P (SCAN MODE: 23.9P):
l/48 shutter is ON.
1080/25P: /5, shutter is ON.
1080/29.97P: !/, shutter is ON.

Viewfinder screen display

The viewfinder screen displays not only the video
picture but also characters and messages
indicating the camcorder settings and operating
status, a center marker, a safety zone marker, etc.
When the menu screen is not displayed and the
DISPLAY switch is set to ON, the items for
which an ON setting was made with
OPERATION >Super Impose in the setup menu
or with related switches are displayed at the top
and bottom of the screen.

Caution messages are indicated for three seconds
when you carry out operations to change
camcorder settings. Adjustment execution
messages are indicated while adjustments
proceed. When adjustments are finished,
messages showing the results of adjustments
appear for three seconds.

Not only these indications are displayed on the
viewfinder screen, but a menu setting enables
them to be output as video signals.

All items that can be displayed on the viewfinder
screen are shown below.

Top of viewfinder screen

pREnn 9

EX £ ﬁﬁi [®Al®550 REC

o]

TOG 00:00:00:00
High Light ND2 A:

D000 &2 ittt B:

B

Extender settings

Indicates the setting of the digital extender

function (by digital extender option) of this

camcorder and the setting of the lens extender.

EX: The lens extender is on.

08: The lens shrinker is on.

x2D: The optional digital extender function of
this camcorder is on.

Ex2D: The lens extender and the optional digital
extender function of this camcorder are both
on.

Locations and Functions of Parts and Controls
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Zoom position (when the lens is
mounted)

Indicates the zoom position of the zoom lens in

the range from 0 to 99.

Focus position (when the serial lens is
mounted)

Indicates the focus position as distance to the

subject (in units of m).

B Green tally

Lights when the camcorder is the following

states.

* MAINTENANCE >Camera Config >HD-SDI
Remote I/F is set to [G-Tally] in the setup menu
and arecording control signal is output from the
HD/SD SDI OUT connector.

* When the Picture Cache mode is enabled

* Green tally signal received (when a camera
adaptor installed on this camcorder is connected
to a camera extension unit)

Media status
Displays the name of the currently active media
slot (A or B).

A Special recording mode/operation
status

Indicates the current special recording mode/

operation status as follows.

Indication = Meaning

OREC Recording in progress

STBY When recording is on a break in
Clip Continuous Rec mode or
standby in other modes

CONT Standby for next recording in Clip
Continuous Rec mode

@CACHE Standby in Picture Cache mode

@INT REC  Recording in progress in Interval
Recording mode

@INT STBY Standby for next recording in
Interval Recording mode

INTSTBY  Standby in Interval Recording
mode

@FRM REC Recording in progress in Frame
Recording mode

OFRM Standby for next recording in

STBY Frame Recording mode

FRM STBY  Standby in Frame Recording mode

@S&Q REC  Recording in progress in Slow &

Quick Motion mode

Locations and Functions of Parts and Controls

Indication = Meaning

S&Q STBY  Standby in Slow & Quick Motion
mode

OCALL Being called from a connected
device

»REVIEW  During recording review

Wireless receiver reception level

When a wireless receiver is installed in the

camcorder, “W” appears together with four

segment reception level indicators for each of the
channels (1 to 4) that can be used by the receiver.

The indications are as follows.

In normal situation: The number of white
segments indicates the strength of the signal
level.

Muting (for an analog receiver) or error rate
aggravation (for a digital receiver): The
number of gray segments indicates the
strength of the signal level.

Reception level over peak: “P” is displayed
instead of the indicators. !

Tuner battery is low: The channel number and
indicator of the corresponding channel
flash. D

1) When an optional DWR-S01D is used

A Battery remaining/voltage capacity
The following is displayed depending on the type
of power source.

Type of power What is displayed

source

InfoLithium Remaining battery capacity icon
battery and remaining recording time
Anton Bauer Remaining battery capacity (%
battery indication)

Other type than Input voltage

above

El External power input
Appears when power is supplied from an external
power source connected to the DC IN connector.

M Color temperature

Displays a color temperature calculated from the

gain of R and B, in the range 1.5 K to 50.0 K (in

steps of 0.1 K). The +/- signs may be displayed

depending on the Offset White setting (see

page 95).

No display: Offset White is OFF

+: The value of Offset White is greater than
3200K.



—: The value of Offset White is less than 3200K.

Number of system lines
Indicates the number of system lines (1080/720/
576/480/486 D) of video currently being recorded
or played back.
1) In SD mode, when OPERATION >Format >Country
is set to other than [PAL Area] in the setup menu.
In UDF mode: 486
In FAT mode: 480

Video format

Indicates the video format for recording (59.94i/
29.97P/23.98P/50i/25P/59.94P/50P) or the video
format of clip being currently played back (see
page 47).

The video aspect ratio (16:9 or 4:3) can also be
displayed when the recording format is set to
IMX50 or DVCAM.

Special recording mode indication

The following is displayed when the camcorder is
in a special recording mode.

* Frame Rec (Frame Recording mode)

« Interval Rec (Interval Recording mode)

¢ S&Q Motion (Slow & Quick Motion mode)

Special recording mode settings
indication

Appears when the camcorder is in a special

recording mode.

Bottom of viewfinder screen

H G

© [AT|@5a0 REC Wik aidss

HOV

Bt e
DT 8 (2000 BT i 5:_t20min

TLCS iris control mode

The following icons are displayed to indicate the
video level control modes based on the Total
Level Control System (TLCS).

Icon TLCS control mode

Backlight mode
Standard mode

@ Spotlight mode

MaInIen | Jeydeyn

Focus adjustment mode (when the auto
focus lens is mounted)

Indicates the current focus adjustment mode of

the camcorder.

* AF (Auto Focus mode)

¢ MF (Manual Focus mode)

* MF* (Manual Focus mode when the MF Assist
function is on)

¢ Full MF (Full Manual Focus mode)

External device control

“REC2” is displayed when MAINTENANCE
>Camera Config >HD-SDI Remote I/F is set to
[Chara] in the setup menu and a recording control
signal is output from the HD/SD SDI OUT
connector.

4] Operation status of connected i. LINK
device

The operating format (HDV or DV) and operation

status of that device are indicated as follows.

Indication = Meaning

OREC [l HDV recording in progress

STBY i[[] Standby for HDV recording

OREC;IIM DV recording in progress

STBY il Standby for DV recording

Video level indication

An indication is displayed together with an
appropriate ND filter position number when the
light level of the subject is too high or too low.

A Timecode

Caution message
Indicates the elapsed recording/playback time,
timecode, user bits data or other information
selected by the DISPLAY switch (see page 19).
Also indicates a caution message when caution is
required such as when you try to change settings.

External input source
Indicates the type of external input signal (HDV)
to be recorded.

Locations and Functions of Parts and Controls | 29
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Bl Recording of external input
Indicates “EXT” when an external input is
recorded.

El Electric color temperature filter
Appears when the CC 5600K function is set to on.

Filter position

Indicates the currently selected ND filter position
number. (see page 15).

When ELECTRICAL CC is assigned to an
assignable switch, the electrical filter position (A/
B/C/D) appears to the right of the ND filter
position (1 to 4), as shown on the previous page.

White balance memory

Indicates the currently selected white balance

automatic adjustment memory.

ATW: ATW (Auto Tracing White Balance) mode

W:A: Memory A mode

W:B: Memory B mode

W:P: Preset mode

3200: When the assignable switch to which Color
Temp SW 3200K has been assigned is on

4300: When the assignable switch to which Color
Temp SW 4300K has been assigned is on

5600: When the assignable switch to which Color
Temp SW 5600K has been assigned is on

6300: When the assignable switch to which Color
Temp SW 6300K has been assigned is on

Gain value
Indicates the gain value (in dB) of the video
amplifier, as set by the GAIN selector.

Shutter
Indicates the shutter speed or the shutter mode.

For details, see “Setting the Electronic Shutter”
(page 53).

Audio level meters
Indicate the audio levels of channel 1 and
channel 2.

Remaining media capacity

The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space of each media
and indicated in time units of minutes. A lock
icon appears if the media is write-protected.

Locations and Functions of Parts and Controls

M Iris position (when the lens is mounted)
Indicates the iris position and the setting for iris
override (reference value for the lens iris) (see
page 55).

The iris override setting is indicated by four
segments indicator as follows.

Reference Indicator

value

+0.25 - Lower left segment is lit in grey.

+0.5 = Left two segments are lit in grey.

+0.75 | Left two segments and lower
un right segment are lit in grey.

+1 HE  All segments are lit in grey.
| |

-0.25 Lower left segment is lit in
U white.

-0.5 O  Left two segments are lit in
o white.

-0.75 O Left two segments and lower
oo right segment are lit in white.

-1 OO  All segments are lit in white.
0o




Preparing a Power
Supply

For safety, use only the Sony battery packs and

AC adaptors listed below.

* BP-GL95/GL65/L60S/L80S Lithium-ion
Battery Pack

* AC power using the AC-DN2B/DN10 AC
Adaptor

Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type
recommended by the manufacturer.

When you dispose of the battery, you must obey the law
in the relative area or country.

Using a Battery Pack

When a BP-GL95/GL65/L60S/L80S Battery
Pack is used, the camcorder will operate
continuously for the time shown below.

Model name Operating time

BP-GL95 Approx. 170 minutes
BP-GL65 Approx. 115 minutes
BP-L60S Approx. 105 minutes
BP-L80S Approx. 140 minutes

Batteries shall not be exposed to excessive heat such as
sunshine, fire or the like.

The battery pack operating time depends on the
frequency of use of the battery pack, and the ambient
temperature when used.

Before use, charge the battery pack with a charger
suitable for each battery.

For details on the battery charging procedure, refer
to the battery charger operation manual.

Note on using the battery pack
A warm battery pack may not be able to be fully
recharged.

To attach the battery pack

1 Press the battery pack against the back
of the camcorder, aligning the line on
the side of the battery pack with the
matching line on the camcorder.

© BP-GL95/GL65/L60S/L80S
@ Align these lines.

2 Slide the battery pack down until its
“LOCK” arrow points at the matching
line on the camcorder.

© “LOCK” arrow
@ Matching line on the camcorder
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If the battery pack is not attached correctly, the terminal
may be damaged.

To detach the battery pack

Holding the release button in, pull the battery
pack up.

Release button

¢ During recording and playback (while the ACCESS
lamp on the right-side panel is lit in blue and the
ACCESS lamp in the card slot section is lit in orange),
be careful never to remove the battery pack.

* Make sure to power the camcorder off before replacing
the battery pack.

Using AC Power

Mount an AC-DN2B/DN10 on the camcorder in
the same way as a battery pack, then connect to
the AC power supply.

The AC-DN2B/DN10 can supply up to 100 W of
power.

) L i
To an AC outlet j

Attaching the Viewfinder

Attaching the Viewfinder

When the viewfinder is attached, do not leave the
camcorder with the eyepiece facing the sun. Direct
sunlight can enter through the eyepiece, be focused in the
viewfinder and cause fire.

The viewfinder is supplied separately.

Attaching the Viewfinder
[ Note |

When attaching the viewfinder, make notes of the
following points.

Be sure to the power off the camcorder before coupling
the viewfinder connector to the camcorder’s VF
connector (20-pin). If you make this connection when
the camcorder power is on, the viewfinder may not
function properly.

Couple the viewfinder connector firmly to the
camcorder’s VF connector. If the coupling is loose,
noise may appear on the video or the tally light may not
operate properly.

For more information about the connection of the
viewfinder and camcorder, contact a Sony service
representative.

1 @ Loosen the viewfinder left-to-right
positioning ring, @ attach the
viewfinder to the viewfinder fitting
shoe, and @ tighten the viewfinder left-
to-right positioning ring.



Viewfinder left-to-right positioning ring

Stopper

2 Couple the viewfinder connector to the
VF connector (20-pin).

VF connector (20-pin)

Detaching the viewfinder

You can carry out this by following the attaching
procedure in reverse order, but there is an
additional action to take: when detaching the
viewfinder from the fitting shoe, pull up the
stopper.

Adjusting the Viewfinder Position

To adjust the viewfinder left-right position,
loosen the left-right positioning ring, and to adjust
the front-back position, loosen the front-to-back
positioning knob.

Viewfinder left-to-right positioning ring

Viewfinder front-to-back positioning knob

Using the BKW-401 Viewfinder
Rotation Bracket

By fitting an optional BKW-401 Viewfinder
Rotation Bracket, you can rotate the viewfinder
out of the way so that your right leg does not hit
the viewfinder while you are carrying the

camcorder.

1 Loosen the front-to-back viewfinder

positioning levers and the front-to-back
viewfinder positioning knobs, and then

pull the viewfinder slide assembly

forward.

2 Using a 2.5 mm diameter hexagonal
wrench, detach the viewfinder slide

assembly.

Attaching the Viewfinder
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4 Adjust the front-to-back position so
that the arm of the BKW-401 does not
touch the handle when it is raised.

Adjust position so that arm
does not touch handle

Bolts with
hexagonal
hole

Viewfinder slide assembly

3 Attach the BKW-401 with the supplied
bolts.

Detaching the Eyepiece

Removing the eyepiece gives a clearer view of the
screen from further away. It is also easy to
remove dust from the viewfinder screen and
mirror when the eyepiece is detached.

1 Turn the eyepiece locking ring fully
counterclockwise, to align the red
marks on the locking ring and the
viewfinder barrel.

Bolts supplied with the BKW-401

© Locking ring
@ Locking ring match mark
© Match mark on the viewfinder barrel

2 Detach the eyepiece.

Match mark on end of eyepiece

34 | Attaching the Viewfinder



To reattaching the eyepiece

1

Align the red marks on the eyepiece
locking ring and the viewfinder barrel.

Align the red mark on the end of the
eyepiece end with the red marks on the
eyepiece locking ring and the
viewfinder barrel. Then insert the
eyepiece into the viewfinder barrel.

Turn the eyepiece locking ring
clockwise until its “LOCK” arrow
points at the red mark on the viewfinder
barrel.

When the eyecup is worn out, replace it with a
new one.

For details of a replacement eyecup, contact a Sony
service representative.

Adjusting the Viewfinder Focus

and Screen

PEAKING CONTRAST| BRIGHT
DISPLAY ZEBRA TALLY

\

ASPECT

L. oN- HioH
OFF sl orF
— MOMENT o Low J

© PEAKING control
© CONTRAST control
© BRIGHT control

To adjust the viewfinder focus

Turn the diopter adjustment ring until the
viewfinder image is sharpest.

Diopter adjustment ring

To adjust the viewfinder screen

Adjust the brightness, contrast, and peaking of the

viewfinder screen with the controls shown below.

Attaching the Viewfinder
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Setting the Area of Use

When using the camcorder for the first
time

The area of use is not factory preset. Before using

the camcorder, you need to set this item. (You
cannot use the camcorder without setting this
item.)

To set the area of use

POWER switch
MENU knob

1 Set the POWER switch to the ON
position.

The screen for setting the area of use appears

in the viewfinder.

INITIAL SETTING

Setting the Area of Use

2 Press the MENU knob.

The settings for selectable areas of use are
displayed.

INITIAL SETTING
[CETITTAMRINTSC Area Il

NTSC(J) Area
PAL Area

Turn the MENU knob to select the
desired area of use.

Setting Area of use

NTSC Area NTSC area (for areas other
than Japan) ®

NTSC(J) Area  NTSC area (Japan)

PAL Area PAL area ©

a) The composite signal output from this camcorder
is an NTSC signal with a black setup (7.5 IRE).
The system frequency is 59.94i.

b) The composite signal output from this camcorder
is an NTSC signal with no black setup. The
system frequency is 59.94i.

c) The composite signal output from this camcorder
is a PAL signal. The system frequency is 50i.

Set the following items.
* Time Zone
* Date/Time

See “Basic Setup Menu Operations” (page 97).
Turn the MENU knob to select

“Finish”, then press the MENU knob.
The camcorder is now ready for use.



You can set or change the date and time of the m Q
internal clock. The date and time set are reflected . o
. . Always power the camcorder off before mounting or o
in the timecode. removing a lens @
. “p i o

For meTm operations, see “Basic Setup Menu For information about using the lens, refer to the ]
Operations™ (page 97). operation manual for the lens. é
<}

1 Select MAINTENANCE >Clock Set [m S
.. o
>Date/Time in the setup menu. The lens is supplied separately. 2

MAINTENANCE
Op|ND Comp
Pal Lens
Thi| Auto Shading

2 Press the MENU knob.
The Date/Time setting window appears.

Date/Time
PIRN)/12/01  11:57:24 AM SET

3 Turn the MENU knob to display the
desired value, and press the knob.
The selection shifts to the next item on the
right.

4 T ) L. ) 1 Push the lens locking lever up and

0 continue the remaining settings, remove the lens mount cap from the
repeat step 3. lens mount.

5 Making sure that “SET” is selected, 2
press the MENU knob.
The internal clock is set with the date and
time set in steps 3 and 4.

Align the center pin on the lens with the
center slot in the lens mount, and insert
the lens into the mount.

To cancel the setting 3 Holding the lens in place, push the lens
Before executing step 5, push the MENU locking lever down to lock the lens.
CANCEL/PRST/ESCAPE switch up to the

CANCEL/PRST side.

Setting the Date/Time of the Internal Clock / Mounting and Adjusting the Lens | 37
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If the lens is not firmly locked, it may come off
while the camcorder is being used. This could cause
a serious accident. Make sure the lens is firmly
locked. It is recommended that the lens mount
securing rubber be put on the lens locking lever as
illustrated above.

=

Connect the lens cable to the LENS
connector.

9  Secure the lens cable with the cable
clamps.

If you have attached an aberration correction
lens

The aberration correction function is activated
automatically. Starting the camcorder with an
aberration correction lens may require more time

than normally because of data loading at start-up.

Contact a Sony service representative for
information about aberration correction lenses.

Adjusting the Flange Focal Length

If the lens does not stay in focus properly as you
zoom from telephoto to wide angle, adjust the
flange focal length (the distance from the plane of
the lens mounting flange to the imaging plane).
Make this adjustment just one time after
mounting or changing the lens.

When carrying out the adjustment, use a flange
focal length adjustment chart as the subject.

« If you use a subject with insufficient contrast, or move
the camcorder or subject during adjustment, this will
cause an adjustment error.

« Place the subject (the flange focal length adjustment
chart) so that it appears at the center of the screen at the
telephoto end. Arrange so that no nearby object (no
object closer to the camera than the chart) enters the
screen at the wide-angle end.

Mounting and Adjusting the Lens

Carrying out the adjustment

1 Set the iris to manual.

2 Open the iris, position the supplied
flange focal length adjustment chart
approximately 3 meters (10 ft) away
from the camcorder, and arrange the
lighting to obtain a satisfactory video
output.

3 Loosen the fixing screws on the F.f or
F.B ring (flange focal length adjustment
ring).

4 Use manual or power zoom to set the
lens to telephoto.

5 Point the camcorder at the chart by
turning the focus ring and focus on it.

6 Set the zoom ring to wide angle.

Turn the F.f or F.B ring until the chart
is in focus, being careful not to disturb
the focus ring.

8 Repeat steps 4 to 7 until the chart stays
in focus all the way from wide angle to
telephoto.

9 Tighten the F.f or F.B ring fixing
SCrews.



Preparing the Audio
Input System

Connecting a Microphone to the
MIC IN Connector

You can attach the optional ECM-680S stereo
microphone to the microphone holder of the
optional HDVF-20A viewfinder.

1

2

Loosen the screw and open the
microphone holder clamp.

Microphone holder clamp

Place the microphone in the
microphone holder.

® Wind the microphone spacer around
the microphone, while peeling off the
protective sheets on both sides of the
microphone spacer.

@ Place the microphone in the holder so
that “UP” is at the top.

® Close the microphone holder.

@ Tighten the screw.

suoneledald g Ja1deyn

On how to perform this operation, refer to the
operation manual for the microphone.

3 Plug the microphone cable into the MIC

IN connector, then set the AUDIO IN
switch for the channel on which you
want to record the audio from this
microphone to FRONT.

4 Secure the microphone cable with the
cable clamp.

Preparing the Audio Input System | 39
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Connecting Microphones to the
AUDIO IN Connectors

You can connect up to two monaural
microphones to the AUDIO IN CH-1/CH-2
connectors, using an optional CAC-12
Microphone Holder.

The following is the procedure for attaching an
electret condenser microphone such as the ECM-
674/678.

On how to attach the CAC-12, refer to the operation
manual for the CAC-12.

1 Attach the electret condenser
microphone.

@ Loosen the ball joint lock lever.

(® Wind the microphone spacer (sheet
type, supplied with the microphone)
around the microphone, while peeling
off the protective sheets on both sides
of the microphone spacer.

® Place the microphone in the holder so
that “UP” is at the top.

@® Close the microphone holder.

® Tighten the screw.

(® Position so that the microphone does
not interfere with the viewfinder and

tighten the ball joint lock lever.

Microphone

Preparing the Audio Input System

2

.

Connect the microphone cable to the
AUDIO IN CH-1 or CH-2 connector.

Set the switches as follows.

« Set the AUDIO IN selectors indicated
below, depending on the power supply type
of the microphone.

Internal power supply: MIC
External power supply: +48V

« Setthe AUDIO IN CH1/CH2 switch for the
channel to which the microphone is
connected to REAR.

© AUDIO IN selectors

@ Monaural microphone

© AUDIO IN CH1/CH2 switches

O To AUDIO IN CH-1 or CH-2 connector

4 Switch the input level to match the

sensitivity of the microphone used.
Switch the input level by changing the setting of
MAINTENANCE >Audio >Rear MIC CH1/
CH2 Ref in the setup menu (factory default
setting is —60 dB). For details, see page 120.



« If the input level on the camcorder is not at an
appropriate setting for the microphone sensitivity, loud
sounds may be distorted, and the signal-to-noise ratio
may be affected.

* Inorder for the AUDIO IN CH-1 and CH-2 connectors
on the camcorder to be able to provide a phantom 48 V
power supply, female XLR connectors (3-pin) are
fitted. If the microphone cable has a female connector,
use an adaptor.

* When you detach a CAC-12 Microphone Holder once
you have attached to the camcorder, be careful not to
lose the two screws fixing the CAC-12 (in step 1).
After detaching the CAC-12, be sure to put the two
screws back into their original places.

Attaching a UHF Portable Tuner
(for a UHF Wireless Microphone
System)

To use a Sony UHF wireless microphone system,

power the camcorder off and then fit one of the

following UHF portable tuners.

* DWR-S01D Digital Wireless Receiver

* WRR-855S UHF Synthesized Tuner Unit

* WRR-860A/861/862 UHF Synthesized
Diversity Tuner

For details of these units, refer to the operation
manuals for them.

The optional WRR Mount Bracket (service part number:
A-8278-057-B) is required to fit the WRR-862.

For details, contact your vendor or a Sony service
representative

To fit the DWR-S01D or WRR-8558

1 Remove the four fixing screws holding
the cover of the portable tuner/receiver
housing slot located in the rear of the
camcorder, to remove the cover.

2 Insert the DWR-SO1D or WRR-855S

into the housing slot, and fasten the four
fixing screws.

DWR-S01D or WRR-855S

3 Set the AUDIO IN selector for the
channel to which you want to input
audio signal to WIRELESS (see
page 21).

To fit the WRR-862 (when using a BP-
GL65/GL95/L60S/L80S Battery Pack)

1 Attach the WRR tuner fitting (not
supplied; service part number: A-8278-
057-B) to the back of the camcorder.

@ Use a Phillips type screwdriver to
tighten the four screws placed in the
tuner fitting. For three of these screws,
insert the screwdriver through the
corresponding hole and tighten the
SCrew.

Make sure that all four screws are fully tightened.

® Loosen the adjustment screws on the
tuner fitting.

(® Adjust the tuner fitting position for a
BP-GL65/GL95/L60S/L80S Battery
Pack to be attached, and tighten the
adjustment screws to fix its position.

@® Attach the mount plate supplied with
the WRR-862.

About the WRR tuner fitting (service part

number: A-8278-057-B), contact a Sony service

or sales representative.

Preparing the Audio Input System
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BP-GL65/GL95/L60S/L80S

Adjustment

screws
Mount plate
(supplied with
26 WRR-862)

Phillips type
screwdriver

2  Attach the battery pack.
On how to attach the battery pack, see “To
attach the battery pack” on page 31.

3 Mount the tuner on the WRR tuner
fitting.

WRR-862

4 Connect the tuner power cord to the DC
OUT connector of the camcorder, and
the audio output cable to the AUDIO IN
CH-1 or CH-2 connector.

O Set the switches as follows.

 Set the AUDIO IN selector for the channel
to which the audio output cable is attached
to MIC.

« Set the AUDIO IN CH1/CH2/CH3/CH4
switch for the channel to which the audio
output cable is connected to REAR.

If the XLR connection automatic detection
function is on, the input signal for audio
recording is selected automatically, and
therefore this setting is not required.

Preparing the Audio Input System

© AUDIO IN CH1/CH2 switches

@ To DC OUT connector

©® To AUDIO IN CH-1 or CH-2 connector
O AUDIO IN selectors

Connecting Line Input Audio
Equipment

Connect the audio output connector of the audio
equipment that supplies the line input signal to the
AUDIO IN CH-1 or CH-2 connector.

Switch settings

Set the AUDIO IN selector for the channel to
which the audio signal source is connected to
LINE.

Selecting the audio inputs to be recorded

* With the XLR connection automatic detection
function being off (the factory default setting):
A signal must be selected for audio recording by
setting the AUDIO IN CH1 or CH2 switch to
REAR depending on which of the AUDIO IN
CH-1 and CH-2 connectors is used for
connecting the external audio equipment.

With the XLR connection automatic detection
function being on: When a cable is connected to
the AUDIO IN CH-1 or CH-2 connector, the
input from that connector is automatically
selected for audio recording, regardless of the
setting of the AUDIO IN CH1 or CH2 switch.
The XLR connection automatic detection
function can be switched on or off by
MAINTENANCE >Audio >Rear XLR Auto in
the setup menu.



@ AUDIO IN CH1/CH2 switches

@ To AUDIO IN CH-1 or CH-2 connector
© Audio equipment

O AUDIO IN selectors

Tripod Mounting

1 Attach the optional VCT-14/U14
Tripod Adaptor to the tripod.

Tripod adaptor

Camera mount

2 Mount the camcorder on the tripod

adaptor.

Slide the camcorder forward along the
groove in the adaptor until it clicks.

To remove the camcorder from the tripod

adaptor

Hold down the red button and pull the lever in the

direction of the arrow.

Tripod Mounting
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Red button

Lever

The tripod adaptor pin may remain in the engaged
position even after the camcorder is removed. If this
happens, press the red button and move the lever as

shown above until the pin returns to the stowed position.

If the pin remains in the engaged position, you will not
be able to mount the camcorder on the tripod adaptor.

Connecting a Video Light

Connecting a Video
Light

With this camcorder, you can use the Anton
Bauer Ultralight 2 or equivalent video light
(powered by 12 V with maximum power
consumption of 50 W).

» If you connect the video light to the LIGHT
connector on the camcorder and set the LIGHT
switch to AUTO, you can turn the light on and
off automatically as you start and stop recording
on this camcorder.

The output of the LIGHT connector on the
camcorder is controlled to 12 V even when the
camcorder is supplied with over 12 V power
(through the DC IN connector or battery pack).
The brightness or color temperature of the light
will not change according to voltage increase.

* Do not use a video light with power consumption of
over 50 W.

* The brightness or color temperature of the light will
change when the voltage (supplied through the DC IN
connector or from the battery pack) is under 12 V.

To attach the video light

Fit the video light to the accessory fitting shoe on
the camcorder grip, and connect the video light
cable to the LIGHT connector.

The accessory fitting shoe on the camcorder is of the
l/4—1'm:h tapped hole type. If you want to replace this with
a slide-type shoe, use the supplied cold shoe kit. On how
to fit the cold shoe kit, refer to “Using a External Hard
Disk” in the Supplement supplied in the CD-ROM
(labeled “Manuals for Solid-State Memory
Camcorder”™).



To remove the shoulder strap

Using the Shoulder
Strap Shown by the attow o reloase.

To attach the shoulder strap

1 Fit one of the clips to a shoulder strap
fitting.
Pull up the strap to lock the fitting.

suoneledald g Ja1deyn

2 Fit the other clip to the shoulder strap
fitting on the other side of the grip in the
same way as in step 1.

Using the Shoulder Strap | 45



suoneledaid g Jeideyn

Adjusting the Shoulder
Pad Position

You can slide the shoulder pad back and forth
within a 40 mm range. This adjustment helps you
get the best balance for shooting with the
camcorder on your shoulder.

Shoulder pad

1 Raise the lever in the center of the
shoulder pad to unlock the shoulder
pad.

2 Slide the shoulder pad backward or
forward until it is in the most
convenient position.

3 Bring down the lever to lock the
shoulder pad in the selected position.

46 | Adjusting the Shoulder Pad Position



] Adjustments and Settings

For menu operations, see “Basic Setup Menu Operations” (page 97).

Setting the Video Format

The following recording formats can be selected for different combinations of video resolution and system

frequency.

In UDF mode

OPERATION >Format menu settings Video format (recording Frame size
HD/SD HD System  Rec Format  gystem Frequency ® format/system frequency)
Line
HD 1080 HD422 59.94i HD422 1920/59.94i 1920x1080
50 50i HD422 1920/50i
29.97P HD422 1920/29.97P
25P HD422 1920/25P
23.98P HD422 1920/23.98P
HD420 59.94i HQ 1440/59.94i 1440x1080
HQ 50 HQ 1440/50i
29.97P HQ 1440/29.97P
25P HQ 1440/25P
23.98P HQ 1440/23.98P
720 HD422 59.94P HD422 1280/59.94P 1280x720
50 50P HD422 1280/50P
29.97P HD422 1280/29.97P
25P HD422 1280/25P
23.98P HD422 1280/23.98P
HD420 59.94P HQ 1280/59.94P
HQ 50P HQ 1280/50P
23.98P HQ 1280/23.98P
SD — IMX50© 59.94i IMX50/59.94i 720%x486
50 IMX50/50i 720x576
29.97P9 IMX50/29.97P 720x486
25p 9D IMX50/25P 720576
DVCAM®  59.94i DVCAMY/59.94i 720%x480
50 DVCAM/50i 720x576
29.97P 9 DVCAM/29.97P 720x480
25p D DVCAM/25P 720%x576

Setting the Video Format
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a) 59.94i/29.97P/59.94P/23.98P: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or
[NTSC(J) Area]
50i/25P/50P: When OPERATION >Format >Country in the setup menu is set to [PAL Area]

b) 59.94i after 2-3 pulldown is recorded

¢) When the optional CBK-MDO1 is installed

d) Converted to PsF and recorded

In FAT mode

FAT

OPERATION >Format menu settings Video format (recording Frame size

HD/SD HD System  Rec Format gystem Frequency® [ormat/system frequency)

Line

HD 1080 HQ 1920 59.94i HQ 1920/59.94i 1920x1080
50i HQ 1920/50i
29.97P HQ 1920/29.97P
25P HQ 1920/25P
23.98P HQ 1920/23.98P

HQ 1440 59.94i HQ 1440/59.94i 1440x1080
50i HQ 1440/501
29.97P HQ 1440/29.97P
25P HQ 1440/25P
23.98P HQ 1440/23.98P
SP 1440 59.94i SP 1440/59.94i
50i SP 1440/50i
23.98P® SP 1440/23.98P
720 HQ 1280 59.94P HQ 1280/59.94P 1280720

50P HQ 1280/50P
29.97P HQ 1280/29.97P
25P HQ 1280/25P
23.98P HQ 1280/23.98P

SD — DVCAM © 59.94i DVCAM/59.94i 720%x480
50i DVCAM/50i 720%576
29.97p 9 DVCAM/29.97P 720%480
25p 9 DVCAM/25P 720x576

a) 59.94i/29.97P/59.94P/23.98P: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or
[NTSC(J) Area]
50i/25P/50P: When OPERATION >Format >Country in the setup menu is set to [PAL Area]

b) 59.94i after 2-3 pulldown is recorded

¢) When the optional CBK-MDO1 is installed

d) Converted to PsF and recorded

Setting the Video Format



Selecting the Recording Mode

Select the recording mode between UDF and
FAT.

1 Select OPERATION >Format >File
System in the setup menu (see page 99).

OPERATION

HD/SD : FAT
HD System Line : 1080

Thi Format Media
Mal| Input/Output

LCD Rec Format HQ 1920
Rec Function

»
»
Fil Superimpose  » |System Frequency : 59.94i
»
»

2 Turn the MENU knob to select [UDF]
or [FAT], and press the knob.
A confirmation message appears.

3 Select [Execute] to execute, or select
[Cancel] to cancel, and then press the
MENU knob.

4 Power the camcorder off and on again.

Changing the Video Format

Refer to the above table and change the settings of
the relevant items.

1 Select OPERATION >Format in the
setup menu (see page 99).

OPERATION
Op| =] 3 =
Pa File System
Th| Format Media HD/SD
Mal Input/Output HD System Line

Rec Format HQ 1920

>
>
F il Super impose » | System Frequency 59.94i
>
>

LCD
Rec Function

2 Turn the MENU knob to select the item
to change, and press the knob.

3 Turn the MENU knob to change the
setting, and press the knob.
A confirmation message appears.

4 Select [Execute] to execute, or select

[Cancel] to cancel, and then press the
MENU knob.

When the setting of HD/SD or Country
was changed, power the camcorder off
and on again.

Setting the Video Format
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Adjusting the Black
Balance and the White
Balance

To ensure excellent image quality when using this
camcorder, conditions may require that both the
black balance and the white balance be adjusted.
Black balance and white balance adjustment
values that are automatically set by the camcorder
and the various settings are stored in the
camcorder memory and retained even when the
power is turned off.

Black balance adjustment

The black balance will require adjustment in the

following cases.

¢ When the camcorder is used for the first time

¢ When the camcorder has not been used for a
long time

* When the camcorder is used under conditions in
which the surrounding temperature has changed
greatly

* When the GAIN selector (L/M/H/Turbo) values
have been changed by using OPERATION
>Gain Switch in the setup menu.

It is not usually necessary to adjust the black

balance when using the camcorder after it has

been off.

White balance adjustment

Always readjust the white balance when the
lighting conditions change.

Adjusting the Black Balance

In automatic black balance mode, adjustments are
performed in the following order: black set and
black balance. Manual black balance adjustment
can be selected from the setup menu.

Automatic black balance adjustment is disabled

in the following case.

¢ During recording

« In a special recording modes (Picture Cache
Rec, Interval Rec, Frame Rec, Slow & Quick)

* When the shutter mode is SLS

1 Set the OUTPUT/DCC switch to CAM.

Adjusting the Black Balance and the White Balance

2 Push the AUTO W/B BAL switch to
BLACK and release the switch.
The message “Executing...” appears during
execution, and changes to “Done” when the
adjustment finishes. Adjustment values are
saved to memory automatically.

During the black balance adjustment, the iris is
automatically closed.

During the black balance adjustment, the gain
selection circuit is automatically activated so you may
see flickering on the viewfinder screen, but this is not
a fault.

Output from the i.LINK connector stops temporarily if
you execute black balance adjustment during i. LINK
output. Output from the connector resumes when black
balance adjustment finishes.

If automatic black balance adjustment
cannot be made

If the black balance adjustment cannot be
completed normally, an error message will appear
for about three seconds on the viewfinder screen.
Possible messages are listed below.

Error message Meaning

NG: Iris Not The lens iris did not close;

Closed adjustment was impossible.

NG: Timeout  Adjustment could not be
completed within the standard
number of attempts.

NG: Out of The difference between the

Range reference value and the current

value is so great that it exceeds
the range. Adjustment was
impossible.

If any of the above error messages is displayed,
retry the black balance adjustment.

If the error message occurs again, an internal
check is necessary.

For information about this internal check, refer to
the Maintenance Manual.

If the lens cable is not firmly connected to the LENS
connector, it may not be possible to adjust the lens iris. If
this happens, the black balance will be incorrect.



Adjusting the White Balance

1

Set the switches and selectors as shown

below.

¢ GAIN switch: L (set to a gain value that is
as small as possible)

¢ OUTPUT/DCC switch: CAM

« WHITE BAL switch: A or BV

1) Adjustment values are saved to memory B only
when OPERATION >White Setting >White
Switch<B> in the setup menu, is set to
[Memory].

Set the FILTER selector to suit the
lighting conditions as follows.

Place a white test card under the same
lighting conditions as for the subject to
be shot and zoom up to it.

Alternatively, any white object such as a
cloth or a wall can be used.

The absolute minimum white area is as
follows.

Rectangle centered on the screen. The
lengths of the sides are 70% of the length
and width of the screen.

|
v

Make sure there are not bright spots in the
rectangle.

Adjust the lens iris.

Manually adjusted lens: set the iris to an
appropriate setting.

Lens with automatic iris: set the automatic/
manual switch on the lens to automatic.

Push the AUTO W/B BAL switch to
WHITE and then release the switch.
The message “Executing...” appears during
execution, and changes to “OK: (color
temperature of subject)” when the
adjustment finishes.

The adjustment values are saved
automatically in the memory selected in
step 1 (A or B).

If the camcorder has a zoom lens with an automatic

iris, the iris may hunt ) during the adjustment. To

prevent this, adjust the iris gain knob (indicated as

IG, IS, or S) on the lens.

For details, refer to the lens operation manual.

1) Hunting: Repeated brightening and darkening of

the image, resulting from repeated response to
automatic iris control.

If the automatic white balance adjustment
cannot be made
If the white balance adjustment cannot be

completed normally, an error message will appear
for about three seconds on the viewfinder screen.

Possible messages are listed below.

Error message Meaning

The white video level is too low.
Either open the lens iris or
increase the gain.

NG: Low Light

NG: Timeout Adjustment could not be
completed within the standard

number of attempts.

The white video level is too
high. Either stop down the lens
iris or change the ND filter.

NG: High Light

If any of the above error messages is displayed,
retry the white balance adjustment. If the error
message occurs again, an internal check is
necessary.

For information about this internal check, refer to
the Maintenance Manual.

If you have no time to adjust the white
balance

Set the WHITE BAL switch to PRST.
This makes it possible to automatically set the

white balance to 5600K (factory default value) by

pressing the COLOR TEMP. button.

The color temperature to which the white balance
is set when the COLOR TEMP. button is pressed

can be selected from among 3200K, 4300K,
5600K, and 6300K on OPERATION

>Assignable SW in the setup menu. You can also

assign color temperatures to the ASSIGN. 1/3
switches or ASSIGNABLE 4/5 switches.

Adjusting the Black Balance and the White Balance
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To change the color temperature when
the ND filter is switched

You can assign electrical CC (color correction)
filters to ND filters (see page 15). This allows you
to change the color temperature automatically
when the ND filter is switched.

1 Set MAINTENANCE >White Filter
>ND Filter C.Temp in the setup menu
(see page 126) to On.

2 To assign an electrical CC filter to
FILTER selector position number 1,
select [ND FLT C.Temp<1>]. To assign
it to positions 2 to 4, select [ND FLT
C.Temp<2-4>].

3 Turn the MENU knob to select the
desired color temperature.
As you turn the MENU knob, the color
temperature changes as follows: 3200K «—
4300K «— 5600K «— 6300K.

4 Repeat steps 2 and 3 as required.

To switch between electrical CC filters
with an assignable switch

You can assign the function that switches
between electrical CC filters to an assignable
switch. This allows you to switch between color
temperatures (3200K/4300K/5600K/6300K) that
have been assigned to up to four positions (A to
D) with each press of the assignable switch.
Regardless of assignments to assignable
switches, you can also switch between the color
temperatures assigned to each position from a
RM-B150/B750 Remote Control Unit.

1 Select MAINTENANCE >White Filter
in the setup menu (see page 126).

2 Select the position to which to assign a
CC filter by selecting one of [Electrical
CC<A>] to [Electrical CC <D>], and
then turn the MENU knob to select the
desired color temperature.

As you turn the MENU knob, the color
temperature changes as follows: 3200K «—
4300K «— 5600K «— 6300K.

Adjusting the Black Balance and the White Balance

To set no color temperature

Select “-----" with Electrical CC<C> or <D>
selected.

When the assignable switch is pressed, the
setting for that position is not displayed. For
example, if “----- " is set for one position, then
switching between the remaining three
positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching
function (ELECTRICAL CC) to an
assignable switch (see page 137).

White balance memory

Values stored in memory are held until the white
balance is next adjusted even when the camcorder
power is turned off.

The camcorder has two white balance memories,

A and B. You can automatically save adjustment

values for each ND filter in the memory that

corresponds to the WHITE BAL switch setting

(A or B). The camcorder has four built-in ND

filters, allowing you to save a total of eight

adjustment values (4 x 2). However, the contents
of the memories are not linked to ND filter
settings in the following cases.

* When the number of memories allocated to
each of A and B is limited to one by setting
OPERATION >White Setting >Filter White
Memory in the setup menu to Off.

* When the electrical CC filter switching function
has been assigned to an assignable switch, or
when a remote control unit has been connected.
(In these cases, the contents of white balance
memory are linked to electrical CC filter
positions (A to D).)

Also, when OPERATION >White Setting
>White Switch<B> in the setup menu is set to
[ATW (Auto Tracing White Balance)], and the
WHITE BAL switch is set to B, the ATW
function is activated to automatically adjust the
white balance of the picture being shot for
varying lighting conditions.



Setting the Electronic
Shutter

Shutter Modes

The shutter modes that can be used with the
electronic shutter and the shutter speeds that can
be selected are listed below.

Standard mode

Select this mode for shooting fast-moving
subjects with little blurring.

You can set the shutter speed in one of two shutter
modes: Speed mode, in which the speed is set in
seconds, and Angle mode, in which the speed is
set in degrees.

System lines: 1080

System Shutter speed (unit: Hz)
frequency S&Q: Off S&Q: On
59.94i 60.00 to 3800 —

50i 50.00 to 3500 —

29.97P 29.99 to 4100 32.01 to 4100
23.98P 23.99 to 3700 32.02 to 3700
25P 25.00 to 3900  32.03 to 3900

System lines: 720

System Shutter speed (unit: Hz)
frequency S&Q: Off S&Q: On
59.94P 60.07 to 4100  32.01 to 4100
50P 50.03 to 3900  32.03 to 3900
29.97P 29.99 t0 4100  32.01 to 4100
23.98P 23.99 to 3700  32.02 to 3700
25P 25.00 to 3900  32.03 to 3900

SLS (slow speed shutter) mode

Select this mode for shooting subjects in low level

Speed mode lighting conditions.

System Shutter speed (unit: seconds) OPERATION >Format Number of
frequency >HD System Line setting accumulated frames
59.94i Yso. 100, 1120 Y125+ as0s V500 in the setup menu

59.94P 10000 Y2000 1080 2,3,4,5,6,7,8,16
50 720 2,4,6,8,16

50P

29.97p 40, Vs0® Meor 100, 11200 1256  Notes

I
/250, /500- /1000> 2000

VIREYIS VIR VIR VISR VI
25P ]/33 )sl 150™, Vg0, 1100, V120, V1255
1250- /500> /1000- /2000

23.98p 32, Mag @, 150 ™. Mo, oes 100-

IR T
/120, 1125: /250: /500> /1000- /2000

a) This speed cannot be selected when the camcorder is
in Slow & Quick Motion mode and OPERATION
>Rec Function >Frame Rate in the setup menu is set
to a value that is greater than the system frequency.

Angle mode
180°, 90°, 45°,22.5°, and 11.25°

ECS (Extended Clear Scan) mode

Select this mode for obtaining images with no
horizontal bands of noise when shooting subjects
such as monitor screens.

As shown in the following tables, the range of
shutter speeds that can be set varies depending on
whether the Slow & Quick Motion (S&Q)
function is on or off.

* SLS mode cannot be used when the video format is SP
1440/23.98P or when the camcorder is in Slow &
Quick Motion mode.

« It is not possible to output the color bar signal, turn the
SLS mode on or off, or change the number of
accumulated frames when the number of accumulated
frames is set to 16.

Selecting the Shutter Mode and
Shutter Speed

* When the automatic iris is used, the iris opens wider as
the shutter speed increases, thus reducing the depth of
field.

« The selectable shutter speeds vary depending on the
current system frequency.

Setting the Electronic Shutter
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To switch between Speed mode and
Angle mode

1 Select OPEARTION >Shutter Select
>Shutter Select in the setup menu (see
page 110).

2 Turn the MENU knob to select Second
or Degree, and then press the knob.

To set the shutter mode and standard-
mode shutter speed

Once the shutter speed is selected, it is retained
even when the camcorder power is turned off.

1 Push the SHUTTER selector from ON
to SELECT.
The current shutter setting indication appears
for about three seconds.

2 Before the shutter setting indication
disappears, push the SHUTTER
selector down to SELECT again and
repeat this until the desired mode or
speed appears.

When all modes and speeds are displayed,
the display changes in the following order.

Speed Mode (with system frequency 59.94i)
1

tueo-»moo-» ->1/1000->1/2000j
ECS Mode

Depending on the frame rate setting (see page 76), some
shutter speeds cannot be selected in Slow & Quick
Motion mode. These speeds are replaced by the slowest
selectable shutter speed.

Example: If you perform Slow & Quick Motion
shooting when setting the frame rate to 60 and the video
format to HQ1280/29.97P

The shutter speed is indicated as follows.

When Slow & Quick Motion mode is off
1/40—1/50—1/60—1/100—-...

When Slow & Quick Motion mode is on
1/60—1/60—1/60—1/100—>-...

Setting the Electronic Shutter

To set the shutter speed in ECS mode

1 Set the shutter mode to ECS (see the
previous item).

2 Turn the MENU knob to select the
desired frequency or number of frames.

To set the shutter speed in SLS mode

1 Set OPERATION >Shutter >Slow
Shutter in the setup menu to [On] (see
page 110).

2 Select the desired number of
accumulated frames with
OPERATION >Shutter >SLS Frames
in the setup menu.



Changing the Reference
Value for Automatic Iris
Adjustment

The reference value for automatic iris adjustment

can be changed to aid the shooting of clear

pictures of back-lit subjects, or to prevent blown-

out highlights. The reference value for the lens

iris can be set within the following range with

respect to the standard value.

¢ 0.25 to 1 (increasing by increments of 0.25):
About 0.25 to 1 stop further open

¢ —0.25 to —1 (decreasing by increments of 0.25):
About 0.25 to 1 stop further close

Also you can set the area where light detection

occurs.

To change the reference value

1 Set OPERATION >Auto Iris >Iris
Override in the setup menu to On (see
page 108).

Set the MENU ON/OFF switch to OFF.

Turn the MENU knob to change the
reference value.

Be sure to confirm that the current shutter mode is
not ECS.

An indicator of the current reference value is
shown at the iris position indication (see
page 30) on the viewfinder screen.

To make the iris more open

Turn the MENU knob counterclockwise as
seen from the front of the camcorder.
Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris

Turn the MENU knob clockwise as seen
from the front of the camcorder.

Select one of —0.25, 0.5, -0.75, or —1.

The changed reference value is retained until
the power of the camcorder is turned off.
Even if the reference value is changed, it
reverts to the standard value every time the
power is turned on.

To set the automatic iris window

1 Set OPERATION >Auto Iris >Iris
Window Indication in the setup menu to
On.

The current automatic iris window appears
on the viewfinder screen.

If it is not necessary to display the auto iris
window on the screen, set to Off.

2 Turn the MENU knob to select Iris
Window, and then press the knob.

3 Turn the MENU knob until the desired
auto iris window appears, and then
press the knob.

1 2 3 4 5 6
[ = [ | O e ==
The shaded parts indicate the
area where light detection

If you select “Var”, the following items
become effective and you can set the window
of the desired size. Set the following items
with MAINTENANCE >Auto Iris2.

Item Setting

Iris Var Width ~ The width of the window

Iris Var Height  The height of the window

Iris Var H Pos  The position of the window
in the horizontal direction

Iris Var V Pos.  The position of the window

in the vertical direction.

When you exit the menu, the auto iris window
selected in step 3 appears.

Unless you need to keep this window displayed,
set OPERATION >Auto Iris >Iris Window
Indication in the setup menu to Off.

To counter problems with very bright
highlights

If the subject is too bright, the iris may close too
much, leaving the overall image dark, or the
highlights may be blown out. In such cases,
setting the highlight clip function on reduces the
luminance range, avoiding problems from the
automatic iris correction.

Set OPERATION >Auto Iris >Clip High Light in
the setup menu to On.

Changing the Reference Value for Automatic Iris Adjustment
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Adjusting the Audio
Level

When you set the AUDIO SELECT switch to
AUTO, the input levels of analog audio signals
recorded on each channel are adjusted
automatically. You can also make manual
adjustments.

Even if you set the AUDIO SELECT switch to AUTO,
the input levels of digital audio signals are not adjusted
automatically.

Target audio level for manual audio level
adjustment

Make adjustment using —20 dB as the target level.

If the audio level meter shows a maximum level
of 0 dB, then it indicates that the input audio level
is excessive.

Excessive input level

IR
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1

Target input level

Manually Adjusting the Audio
Levels of the Audio Inputs from
the AUDIO IN CH-1/CH-2
Connectors

1 To adjust the signal input to the AUDIO
IN CH-1 or CH-2 connector, set the
AUDIO IN CH1 or CH2 switch to
REAR.

To adjust both input signals, set both
switches to REAR.

Adjusting the Audio Level

Set the AUDIO SELECT switch(es)
corresponding to the channel(s) selected
in step 1 to MANUAL.

3 With the LEVEL knob(s) for the
channel(s) selected in step 1, adjust so
that the audio level meter shows up to
—20 dB for a normal input volume.

Correspondence between recording level
adjustments and audio level controls

On MAINTENANCE >Audio in the setup menu,
you can select which audio level control controls
the audio recording level of the input to each of
the AUDIO IN CH-1/CH-2 connectors. The
correspondences between the settings of the menu
items and the controls are as follows.

Rearl/WRR Level: Channel 1 recording level

Setting Knob

Sidel LEVEL (CH1) knob

Front MIC LEVEL control

Front+Sidel LEVEL (CH1) knob and MIC
LEVEL control (linked
operation)

Rear2/WRR Level: Channel 2 recording level

Setting Knob

Side2 LEVEL (CH2) knob

Front MIC LEVEL control

Front+Side2 LEVEL (CH2) knob and MIC
LEVEL control (linked
operation)

‘When you have operation of the LEVEL (CH1/CH2)
knobs and MIC LEVEL control linked together, if the
MIC LEVEL control is set to 0, the audio signals on
channels 1 and 2 cannot be recorded. Check the position
of the MIC LEVEL control before adjusting the LEVEL
(CH1/CH2) knobs.

Manually Adjusting the Audio
Level of the MIC IN Connector

1 Set either or both of the AUDIO IN
switch(es) to FRONT.



2 Set the AUDIO SELECT switch(es) for
the desired channel(s) selected in step 1
to MANUAL.

3 Turn the MIC LEVEL control, and
adjust so that the audio level meter
shows up to —20 dB for a normal input
volume.

Correspondence between recording level
adjustments and audio level controls

On MAINTENANCE >Audio in the setup menu,
you can select which audio level control controls
the audio recording level of the front microphone
input. The correspondences between the settings

of the menu items and the controls are as follows.

MIC CH1 Level: Channel 1 recording level

Setting Knob

Sidel LEVEL (CH1) knob

Front MIC LEVEL control

Front+Sidel LEVEL (CH1) knob and MIC
LEVEL control (linked
operation)

MIC CH2 Level: Channel 2 recording level

Setting Knob

Side2 LEVEL (CH2) knob

Front MIC LEVEL control

Front+Side2 LEVEL (CH2) knob and MIC
LEVEL control (linked
operation)

When you have operation of the MIC LEVEL control
and LEVEL (CH1/CH2) knobs linked together, if the
LEVEL (CH1/CH2) knobs are set to 0, the audio signals
on channels 1 and 2 cannot be recorded. Check the
position of the LEVEL (CH1/CH2) knobs before
adjusting the MIC LEVEL control.

Recording Audio on Channels 3
and 4

Selecting the recorded audio

You can select the audio recorded on audio
channels 3 and 4 with the AUDIO IN CH3/CH4
switches.

CH3 switch Channel 3 recording target

FRONT Front microphone audio

REAR Audio signal input to AUDIO IN
CHI1 connector

WIRELESS Wireless microphone audio

CH4 switch Channel 4 recording target

FRONT Front microphone audio

REAR Audio signal input to AUDIO IN
CH2 connector

WIRELESS Wireless microphone audio

You can have the selection made automatically,
as follows.

To automatically select the same audio as on
channels 1 and 2

Set MAINTENANCE >Audio >Audio CH3/4
Mode of the setup menu to [Ch1/2].

Adjusting the audio recording levels

To adjust automatically
Set the AUDIO SELECT CH 3-4 switch to
AUTO.

To adjust manually

1 Set the AUDIO SELECT CH 3-4 switch
to MANUAL.

2 Select the knobs that adjust the audio
levels with the Audio CH3 Level and
Audio CH4 Level items under
MAINTENANCE >Audio in the setup
menu.

Audio CH3 Level: Channel 3 recording

level
Setting Knob
Side3 LEVEL (CH3) knob
Front MIC LEVEL control
Front+Side3 LEVEL (CH3) knob and
MIC LEVEL control (linked
operation)

Audio CH4 Level: Channel 4 recording

level
Setting Knob
Side4 LEVEL (CH4) knob
Front MIC LEVEL control

Adjusting the Audio Level
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Setting Knob

Front+Side4 LEVEL (CH4) knob and
MIC LEVEL control (linked
operation)

You can now adjust the levels of audio
channels 3 and 4 with the knobs selected
here.

Setting the Time Data

Setting the Time Data

When picture cache mode is enabled, it is not possible to
set time data, even if you set the F-RUN/SET/R-RUN
switch to SET. If you want to set time data, first exit
picture cache mode.

Setting the Timecode

The timecode setting range is from 00 : 00 : 00 :
00 to 23 : 59 : 59 : 29 (hours : minutes : seconds :
frames).

1 Press the DISP SEL/EXPAND button to
switch the display in the LCD monitor
to status display.

2 Set the DISPLAY switch to TC.

3 Set the PRESET/REGEN/CLOCK
switch to PRESET.

4 Set the F-RUN/SET/R-RUN switch to
SET.
The first (leftmost) digit of timecode flashes.

5 Usethe up and down arrow buttons to
change values, and use the left and right
arrow buttons to move the flashing
digit. Repeat until all digits are set.

To reset the timecode value to 00:00:00:00
Press the RESET/RETURN button.

6 Set the F-RUN/SET/R-RUN switch to
F-RUN or R-RUN.
F-RUN: Free run. The timecode generator
keeps running.
R-RUN: Recording run. The timecode
generator runs only while recording.

To set the drop frame mode/non-drop frame
mode

You can select the drop frame (DF) mode or non-
drop frame (NDF) mode on MAINTENANCE
>Timecode in the setup menu.



To make the timecode consecutive

When the F-RUN/SET/R-RUN switch is set to
R-RUN, recording a number of scenes on the
media normally produces consecutive timecode.
However, once you remove the media and record
on another media, the timecode will no longer be
consecutive when you use the original media
again for recording. In this case, to make the
timecode consecutive, set the PRESET/REGEN/
CLOCK switch to REGEN.

Saving the real Time in the Timecode

Setting the PRESET/REGEN/CLOCK switch to
CLOCK saves the real time in the timecode.
When it is necessary to set the actual time, use
MAINTENANCE >Clock Set >Date/Time in the
setup menu.

For details, see “Setting the Date/Time of the
Internal Clock” (page 37).

Setting the User Bits

By setting the user bits (up to 8 hexadecimal
digits), you can record user information such as
the date, time, or scene number on the timecode
track.

1 Press the DISP SEL/EXPAND button to
switch the display in the LCD monitor
to status display.

Set the DISPLAY switch to U-BIT.

3 Set the F-RUN/SET/R-RUN switch to
SET.
The first (leftmost) digit flashes.

4 Use the up and down arrow buttons to
change values, and use the left and right
arrow buttons to move the flashing
digit. Repeat until all digits are set.

To reset the user bit data to 00 00 00 00
Press the RESET/RETURN button.

5  Set the F-RUN/SET/R-RUN switch to
F-RUN or R-RUN, corresponding to the
desired operating mode for the
timecode generator.

To store the user hit setting in memory

The user bit setting (apart from the real time) is
automatically retained in memory even when the
power is turned off.

Synchronizing the Timecode

You can synchronize the internal timecode
generator of this camcorder with an external
generator for the regeneration of an external
timecode. You can also synchronize the timecode
generators of other camcorders/VTRs with the
internal generator of this camcorder.

Connections for timecode
synchronization

Connect both the reference video signal and the
external timecode as illustrated below.

Example 1: Synchronizing with an external
timecode

External timecode

Reference video signal

© GENLOCK IN connector
@ TC IN connector

Setting the Time Data
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Example 2: Interconnecting a number of
camcorders (including one reference
camcorder)

To another camcorder to be synchronized

@ VIDEO OUT connector
@ TC OUT connector

© TC IN connector

O GENLOCK IN connector

To lock the timecode to an external
source

1 Turn on the POWER switch.

2  Set the PRESET/REGEN/CLOCK
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to
F-RUN.

4 Set the DISPLAY switch to TC.

5 Supply a timecode signal and a
reference video signal complying with
the SMPTE standard and in proper
phase relationship, to the TC IN
connector and to the GENLOCK IN
connector, respectively.

Setting the Time Data

This operation synchronizes the internal
timecode generator with the external
timecode. After about 10 seconds, you can
disconnect the external timecode without
losing the synchronization.

When you finish the above procedure, the internal
timecode is immediately synchronized with the
external timecode and the counter display will show
the value of the external timecode. However, wait for
afew seconds until the sync generator stabilizes before
recording.

If the frequency of the reference video signal is not the
same as the system frequency of the camcorder, the
camcorder cannot be correctly genlocked. In such a
case, the internal timecode is not correctly
synchronized with the external timecode.

User bit settings during timecode
synchronization

When the timecode is synchronized, only the time
data is synchronized with the external timecode
value.

To release the timecode synchronization
First disconnect the external timecode, then set
the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery
pack to an external power supply during
timecode synchronization

To maintain a continuous power supply, connect
the external power supply to the DC IN connector
before removing the battery pack. You may lose
timecode synchronization if you remove the
battery pack first.

Camcorder synchronization during timecode
synchronization

During timecode synchronization, the camcorder
is genlocked to the reference video signal input
from the GENLOCK IN connector.



Checking Camcorder
Settings and Status
Information (Status
Screens)

The status screens allow you to check camcorder
settings and various types of status information.
There are five status screens, listed below.

Status screen Information displayed

CAMERA status  Settings and status information

related to shooting

AUDIO status Settings and status information
related to audio input and

output

VIDEO status Settings and status information
related to recording and

playback

ASSIGN Names of functions assigned
SWITCH status to assignable switches
BATTERY/ Status of the battery mounted
MEDIA status on the camcorder and the

media status

To display status screens

With no menu is displayed, press the MENU
CANCEL/PRST/ESCAPE switch up to the
CANCEL/PRST side. Each push selects the next
status screen, in the order given in the table
above.

CAMERA status screen

This screen displays settings and status
information related to shooting.

CAMERA
White Bal ~ B: 12000K Gain L: 0dB
A: 4700K M: 9dB
PRST: 3200K H: 18dB
Zebra 1: On 70%

Zoom Speed : 70
Skin Tone Detail : OFF 2: Off

White Bal: White balance status

Gain: GAIN switch status

Zoom Speed: Zoom speed set with the lens
ZOOM button

Zebra: Zebra status

Skin Tone Detail: Skin details status

AUDIO status screen

This screen displays settings and status
information related to audio input and output.

AUDIO
Front MIC : Stereo

CH-1
CH-2
CH-3
CH-4

CH-1/CH-2/CH-3/CH-4: Audio level meters
and input sources
Wind Filter: Wind filter settings

VIDEO status screen

This screen displays settings and status
information related to recording and playback.

VIDEO
Video Format
Rec Mode
Output&i.LINK

: HD 1080/59.94i
: HD 422 50
: HD/Disable

SDI Output : Off

Down Converter : Squeeze

Video Format: Video format

Rec Mode: Recording bit rate (HD mode only)

Output&i.LINK: Output&i.LINK setting and
i.LINK usage status

SDI Output: HD/SD SDI OUT connector output
setting

Down Converter: SD output down converter
setting (HD mode only)

ASSIGN SWITCH status screen

This screen displays the names of the functions
assigned to assignable switches

ASSIGN SWITCH 4/5
0: Off RET : Return Video
: Freeze Mix C. Temp: Color Temp SW5600K
: Off

: Color Temp SW3200K
. Rec Review
: Off

Checking Camcorder Settings and Status Information (Status Screens)
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BATTERY/MEDIA status screen

This screen displays the status of the battery
mounted on the camcorder and the media status.

BATTERY/MEDIA
Battery NN M EEEEODODO Charge Count 55
oo

HDDA HH

HODE NEEEEEEROOO

0 50 100%
MediaA REBOOOOOOO 120min Life 10
MediaB MEMMODOOOOOO 50min filife 3
0 50 100%

Battery: The remaining battery capacity
Charge Count: The number of times the battery
has been charged
HDD A/HDD B: Remaining battery capacity of
PHU-60K/120K/120R (in FAT mode)
Media A/Media B:
* Remaining capacity of media
* Recordable time
* Approximate writable lifetime (Life)
“Life 100%” is shown for unused media.

Checking Camcorder Settings and Status Information (Status Screens)
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Handling SxS Memory
Cards

This camcorder records video and audio on SxS
memory cards (not supplied) loaded into one or
both of its memory card slots.

The PHU-60K/120K/120R Professional
Harddisk Unit or MEAD-MS01/SD0O1 Media
Adaptor can also be used for recording (when the
recording mode is FAT). For details, refer to the
Supplement supplied in the CD-ROM (labeled
“Manuals for Solid-State Memory Camcorder”).

About SxS Memory Cards

SxS memory cards that can be used with
this camcorder

Use the following Sony SxS memory cards (SxS
PRO or SxS-1) with this camcorder.

SxS PRO
* SBP-16 (16 GB)
* SBP-32 (32 GB)

SxS-1
* SBS-32G1A (32 GB)
¢ SBS-64G1A (64 GB)

Proper operation cannot be guaranteed when
memory cards other than SxS PRO and SxS-1 are
used.

The memory cards listed above comply with the

ExpressCard memory card standard.

¢ SxS, SxS PRO and SxS-1 are trademarks of
Sony Corporation.

¢ The ExpressCard label and logo are property of
the Personal Computer Memory Card
International Association (PCMCIA) and are
licensed to Sony Corporation. Other trademarks
and trade names are the property of their
respective owners.

Notes on the use of SxS memory cards

* Recorded data may be lost or corrupted in the

following cases.

- When the camcorder is subjected to shock or
vibrations during reading, writing, or
formatting of an SxS memory card, and when
the camcorder is powered off or an SxS
memory card is removed during reading,
writing, or formatting

- When the camcorder is used in an
environment subject to static electricity or
electric noise

Do not use or store SxS memory cards in

locations that are:

- Outside the specified environmental ranges

- Very hot, such in as vehicles parked in the sun
during summer, or exposed to direct sunlight,
or near heaters

- Subject to high humidity and corrosion

When inserting a memory card, insert with the

label side facing the correct direction.

Carry and store SxS memory cards in their

cases, and lock the cases securely.

To use SxS-1 memory card “SBS-32G1” in

UDF mode, the software may need to be

updated. For details, access the Sony website

closest to your area. (Refer to the top page of the

CD-ROM Manual on the supplied CD-ROM.)

Guard against accidents and inadvertent data
loss by backing up the data stored on SxS
memory cards. Sony cannot be responsible for
any consequences of damage to or loss of data
stored on SxS memory cards.

Do not attach anything other than the supplied
labels in the designated label space. When
attaching a label, make sure it does not protrude
beyond the label space.

Handling SxS Memory Cards
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1

Label space

¢ Use this camcorder to format SxS memory
cards that will be used with this camcorder.
When memory cards are formatted on another
unit, the format is regarded as an invalid format,
making it necessary to format the memory cards
again.

However, note that the format and delete
functions of this camcorder do not completely
remove data from memory cards. Before
discarding or disposing of a memory card, erase
it using commercial data erasure software, or
physically destroy it. Sony cannot be
responsible for any failure to erase data
completely.

Clip operations may not be possible when the
remaining capacity of the media is low. In this
case, use a computer to delete unneeded files
and try again.

Open the memory card case completely before
storing a card in the case or removing a card
from the case.

Preventing accidental erasure

You can prevent accidental recording, editing,
and deletion of data on an SxS memory card by
setting the write protect switch to the WP side.

Write protect switch

Do not touch the write protect switch while an SxS
memory card is loaded in a card slot. Eject the card
before setting the write protect switch.

Handling SxS Memory Cards

Loading and Ejecting SxS
Memory Cards

To load SxS memory cards

1 Slide the cover to the left to open.

2 Insertan SxS memory card into a card
slot.

Insert with the label
side facing right.

The ACCESS lamp lights in orange, and then
lights in green to indicate that the memory
card is usable.

3 Close the cover.

ACCESS lamp status indications
Card slots A and B each have an ACCESS lamp
to indicate the slot status.

Lamp Slot status

Accessing the SxS memory card
(lights during data reading and
writing)

Lights in orange

Standby (the loaded SxS
memory card is ready for
recording or playback)

Lights in green

Not lit * No SxS memory card is
loaded.

* An unusable card is loaded.

* An SxS memory card is
loaded, but the other slot is

selected.




To eject SxS memory cards

1 Open the cover, and then press the
EJECT button to release the lock and
pull the button out.

Press the button once
to release the lock.

2 Press the EJECT button again to eject
the card.

Data integrity cannot be guaranteed if you power the
camcorder off or remove a memory card while the card
is being accessed. Doing so may corrupt all data recorded
on the card. Always make sure that the ACCESS lamp is
lit green or not lit before you power the camcorder off or
remove a memory card.

Selecting the SxS Memory Card to
Use

When SxS memory cards are loaded in both slot
A and slot B, you can press the SLOT SELECT
button to select the SxS memory card to use.

The camcorder switches automatically to the
other card if the selected card becomes full during
recording.

The SLOT SELECT button is disabled during playback.
Even when pressed, it does not change the selected slot.
Button operations are enabled when a thumbnail screen
(see page 79) is displayed.

Formatting (Initializing) SxS
Memory Cards

When you load an unformatted memory card,
load a memory card that has been formatted to
other specifications, or load a memory card that
has been formatted in UDF mode into the
camcorder set to FAT mode, a message to
confirm if formatting is to be executed appears in
the viewfinder (see page 66). In this case, format
the memory card in the following way.

SxS memory cards are formatted in FAT mode as
factory default.

SxS memory cards must be formatted on an
XDCAM EX device or on this camcorder. Cards
in other formats cannot be used.

To format (initialize) a memory card

If the message for formatting is displayed, turn
the MENU knob to select “Execute”, and then
press the knob.

Execution of the format starts.

During execution of the format, a progress
indication appears (%), and the ACCESS lamp
lights in orange.

When formatting is completed, the completion
message is displayed for three seconds.

Recording and playback during format execution
Even during execution of a format, recording and
playback are possible using an SxS memory card
loaded into the other card slot.

If the format operation fails

A format operation may fail because the SxS
memory card is write protected, or because it is
not the type of card specified for use with this
camcorder.

Handling SxS Memory Cards
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In this case, an error message appears. Following
the instructions in the error message and
exchange the card for an SxS memory card that
can be used with this camcorder.

To format by menu operation

When no formatting message is displayed, you
can execute formatting by menu operation.

1 Select OPERATION >Format Media in
the setup menu (see page 100).

2 Select [Media(A)] (slot A) or [Media(B)]
(slot B).

3 Turn the MENU knob to select
[Execute], and then press the knob.
The confirmation message for formatting is
displayed on the viewfinder screen.

4 Turn the MENU knob to select
“Execute”, and press the knob.
Execution of the format starts.

During execution of the format, a progress
indication appears (%), and the ACCESS lamp
lights in orange.

When formatting is completed, the completion
message is displayed for three seconds.

¢ All data is erased when you format a memory card,

including setup files and all of the recorded video data.

« Use the format function of this camcorder to format
SxS memory cards for use on this camcorder. The
formats of cards formatted on other devices are not
recognized as valid formats, making it necessary to
format them again on this camcorder.

If You Load a Memory Card
Formatted in the Different
Recording Mode from the Mode
Selected on the Camcorder

An error message or a message to confirm if
formatting is to be executed appears.

Cases in which an error message appears
The message “Cannot Use Media(A)/
Unsupported File System” appears in the
viewfinder in the following cases.

Handling SxS Memory Cards

* An SxS memory card which was used for
recording in UDF mode is loaded into the
camcorder set to FAT mode.

* An SxS memory card which was used for
recording in FAT mode is loaded into the
camcorder set to UDF mode.

* An SxS memory card which was formatted in
FAT mode is loaded into the camcorder set to
UDF mode.

Cases in which a message to confirm if
formatting is to be executed appears

When an SxS memory card which was formatted
in UDF mode is loaded into the camcorder set to
FAT mode. a message to confirm if formatting is
to be executed in FAT mode appears in the
viewfinder (see page 65).

Checking the Remaining
Recording Time

You can check the remaining capacity of the SxS
memory cards loaded in the two slots by checking
the recording media remaining capacity display
in the viewfinder.

:00:00
t ND2 A:

HIIIIIIIIIII-I B

60min

120min 88F1.6

The camcorder calculates the remaining
recording time for the media in each slot on the
basis of the current video format (recording bit
rate), and displays it in units of minutes.

You can also check the remaining time in the
BATTERY/MEDIA status screen (see page 62).

The "@ mark appears when a memory card is write
protected.

When to exchange SxS memory cards

* The warning message “Media Near Full”
appears, the WARNING indicator and the REC
indication on the viewfinder screen flash, and
the buzzer sounds when the total remaining
recording time of the two memory cards falls to
five minutes during recording.

Exchange one of the cards for media with
available recording capacity.



« If you continue recording, the message “Media
Full” appears and recording stops when the total
remaining recording time falls to 0.

About up to 600 clips can be recorded on one SxS
memory card.

The display of remaining recording time changes to “0”
and the message “Media Full” appears when the clip
limit is reached.

Restoring SxS Memory Cards

If for any reason an error should occur in a
memory card, the card must be restored before
use.

When you load an SxS memory card that needs to
be restored, a message appears in the viewfinder
to ask whether you want to restore it.

To restore a card

Turn the MENU knob to select [Execute], and
then press the knob.

The restoration starts.

During the restoration, a execution message
appears, the progress is displayed (%), and the
ACCESS lamp lights in orange.

When the restoration finishes, a completion
message is displayed for three seconds.

If restoration fails

* Write protected SxS memory cards and cards
on which memory errors have occurred cannot
be restored. A warning message appears for
such cards. Follow the instructions in the
message and unprotect the card or replace it
with another card.

SxS memory cards on which memory errors
have occurred may become usable if they are
reformatted.

In some cases, some clips can be restored while
others cannot. The restored clips can be played
normally.

If the message “Could not Restore Some Clips”
keeps appearing after repeated attempts at
restoration, it may be possible to restore the SxS
memory card with the following procedure.

@ Use the camcorder’s copy function (see
page 90) or the supplied application
software (see page 147) to copy the

required clips to another SXS memory card.

(@ Format the unusable SxS memory card on
the camcorder.

® Copy the required clips back to the newly
formatted SxS memory card.

Recording and playback during restoration
Even while restoration is in progress, you can
record and play an SxS memory card in the other
card slot.

For restoration of media recorded with this camcorder,
be sure to use this camcorder. Media recorded with a
device other than this camcorder or with another
camcorder of different version (even of the same model)
may not be restored using this camcorder.

Handling SxS Memory Cards
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Basic Operations

This section explains the basic shooting and
recording procedures.

Before starting to shoot, inspect the camera

system to verify that it is operating properly.

1

Attach a fully charged battery pack (see
page 31).

Select the recording mode (see page 49).

Load one or two SxS memory cards (see
page 64).

If you load two cards, the camcorder
switches automatically to the second card
when the first card becomes full.

Set the camcorder’s POWER switch
(see page 12) to ON.

Make the following settings.

Marker display: On (see page 105)

Iris: Auto (see page 55)

Zoom: Auto

Camera output: Select the picture currently
being shot (camera picture), and turn the
DCC function on (see page 16).

Timecode advance mode: F-RUN (Free
Run) or R-RUN (Rec Run) (see page 58)

Audio input channel selection: Auto (see
page 23)

Push the AUTO W/B BAL switch to the
BLACK side to adjust the black balance
(see page 50).

Select a filter according to the lighting
conditions, and adjust the white balance
(see page 51).

Point the camcorder at the subject, and
adjust the focus and zoom.

If you are using the electronic shutter,
select an appropriate shutter mode and
speed (see page 53).

Basic Operations

10 Do one of the following to start

recording.

- Press the REC START button (see
page 14).

- Press the VTR button on the lens.

- Turn on the assignable switch to which the
Rec function has been assigned (see
page 136).

During recording, the TALLY indicators, the
tally indicator on the front panel of the
viewfinder, and the REC indication on the
viewfinder screen light. Adjust the zoom and
focus as required.

* Never remove the battery pack while the
camcorder is recording (while the ACCESS lamp
on the right-side panel is lit in blue and the
ACCESS lamp in the card slot section is lit in
orange). Doing so risks the loss of several
seconds of data before the recording was
interrupted, because internal processing will not
end normally.

The playback control buttons (EJECT, F REV, F
FWD, NEXT, PREV, PLAY/PAUSE, STOP) do
not function during recording.

1110 stop recording, perform one of the

operations listed in step 10.

The TALLY indicators, the tally indicator on
the front panel of the viewfinder, and the
REC indication on the viewfinder screen go
out, and camcorder enters recording standby
(STBY) mode.

A clip is created from the video and audio

data and the metadata recorded between steps
10 and 11.

When the recording mode is UDF, if you stop
recording within two seconds of starting, recording
continues and this results in a two-second clip.

To check the recording (recording review)
With the camcorder in recording standby
(STBY) mode, turn on the assignable switch
to which the Rec Review function or the
Freeze Mix function has been assigned (see
page 135).

The camcorder plays the entire last clip, or
the last few seconds of that clip (three
seconds or 10 seconds), and then returns to
standby mode.



You can use MAINTENANCE >Camera
Config >Rec Review in the setup menu (see
page 125) to change the playback time.
When the Rec Review function is assigned to
the RET button on the lens, you can also
conduct a review by using the RET button.

12 Repeat steps 10 and 11 to continue
recording.
With each repetition, another clip is created
on the memory card.

Clip 1 Clip 2 Clip 3
REC REC /REC REC /REC REC
START STOP/ START STOP/ START STOP

* You cannot resume recording for about one second
after stopping recording.

The maximum number of clips that can be recorded on
one memory card is 600. Even if the memory card has
enough free capacity to record more clips, when 600
clips have been recorded, no further recording is
possible.

Clip file sizes

Clip file sizes vary according to file formats.
File File size Clip size

format

MP4 Less than 4 GB Less than half an

hour

AVI Less than 2 GB Less than 9 minutes

and 30 seconds

MXF  Lessthan 43 GB  Less than 6 hours

If you continue recording for an extended period,
recorded materials may be segmented into
multiple files, depending on the file size (the
maximum number of partitions is 99).

The camcorder regards continuous recording as
one clip even if it has been segmented into
multiple files.

Clip names

Eight-character clips names (consisting of a four-
character prefix and a four-digit number) are
generated automatically for clips recorded by this
camcorder.

Example: ABCD0001

You can also use OPERATION >Clip >Title
Prefix (see page 111) in the setup menu to set the
clip name prefix to a user-specified string of
characters (four to 46 characters in length). (A

user-specified prefix cannot be changed after
recording.)

The four-digit number at the end of clip names is
generated automatically, counting up in order as
clips are recorded.

Playing Recorded Clips

When the camcorder is in standby (STBY) mode,
you can play all or part of the most recently
recorded clip (see page 68).

1 InserttheSxS memory card to play (see
page 64).

2 Press the PREV button (see page 19) or
the F REV button (see page 18) to cue
up the clip to play.

3 Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator lights, and the
playback picture appears in the viewfinder.

To pause the playback

Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator flashes during
pause.

Press the button again to return to playback mode.

To play at high speed

Press the F FWD button (see page 19) or the

F REV button (see page 18).

To return to normal playback, press the PLAY/
PAUSE button.

To switch between memory cards

When two memory cards are loaded, press the
SLOT SELECT button (see page 22) to select the
active slot.

Itis not possible to switch between memory cards
during playback.

To end playback

Press the STOP button: Playback stops, and the
camcorder enters E-E mode.

Press the THUMBNAIL button: Playback
stops, and a thumbnail screen (see page 79)
appears in the viewfinder.

Playback also stops and the timecode screen

appears in the viewfinder when you start

recording during playback, and when you eject an

SxS memory card.

Basic Operations
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Deleting Recorded Clips Advanced Operations

You can use the assignable switches to delete the
last recorded clips (Last Clip DEL function).
You can also use the THUMBNAIL menu to delete all
recorded clips (All Clips DEL function) or to delete
selected clips. For details, see “Deleting Clips”

(page 91). Recording Shot Marks

1 Turn on the assignable switch to which

the Last Clip DEL function has been /

assigned (see page 136). On this camcorder, two types of shot marks are
A confirmation message appears. available in HD mode. You can record them at
user-specified positions to make it easier for
2 Turn the MENU knob to select editors to cue up those positions.
[Execute], and then press the knob. The maximum numbers of shot marks per clip

vary according to file formats.

File format Maximum number
MP4 127
MXF 999

Shot marks cannot be recorded in SD mode.

You can also use the THUMBNAIL menu to add and
delete shot marks in clips. For details, see “Adding
and Deleting Shot Marks” (page 93).

To record shot marks

Do one of the following.

» Turn on an assignable switch to which Shot
Mark 1 or Shot Mark 2 has been assigned (see
page 135).

* If Lens RET has been assigned to the RET
button on the lens, operate as follows.

To record shot mark 1: Press the RET button
once.

To record shot mark 2: Press the RET button
twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1” or
“Shot Mark 2” indication appears in the
viewfinder for about three seconds near the
timecode indication.

Advanced Operations



Setting OK Marks
[uoF][FatHD)]

To make it easier for editors to select good clips,
you can set OK marks in clips recorded in HD
mode.

OK marks cannot be set or deleted during recording or
playback.

To set/delete OK marks

You can use the THUMBNAIL menu to add and
delete OK marks in previously recorded clips. For
details, see “Adding and Deleting OK, NG or KP
Marks” (page 89).

Starting to Record from Pre-
stored Video (Picture Cache
Function)

The camcorder is equipped with enough internal
memory to pre-store up to 15 seconds of video
and audio data in a picture cache. This allows you
to begin recording a specified number of seconds
in advance of the time when you press a recording
start button.

Selecting picture cache mode and setting
the picture cache time

Before recording in picture cache mode, you must
select picture cache mode and set the picture
cache time (the number of seconds of video and
audio data stored to memory) in the
OPERATION menu.

The picture cache time determines how far in
advance you can start recording, counting back in
seconds from the operation that starts recording.
Note that it may not be possible to start this far in
advance in the special cases explained in the
following notes.

Storage of picture data to memory begins when you
select picture cache mode. Therefore, if you start
recording immediately after selecting picture cache
mode, the picture data from before the selection is not
recorded.

No data is recorded to picture cache memory during
playback or recording review and display of
thumbnails. It is not possible to record picture data

from the time you were conducting playback or a
recording review.

To select picture cache mode and set the picture
cache time

Picture cache recording is not possible in Frame Rec,
Interval Rec, Slow & Quick Motion, and Clip
Continuous Rec mode. The camcorder exits Frame
Rec, Interval Rec, Slow & Quick Motion or Clip
Continuous Rec mode, whenever you select picture
cache mode. The camcorder exits picture cache mode
automatically whenever you select Frame Rec,
Interval Rec, Slow & Quick Motion, or Clip
Continuous Rec mode.

The data stored in picture cache memory is cleared
when you change the system settings, for example by
selecting a different video format. Picture data from
before the change is not recorded even if you start
recording immediately after the change. The
camcorder exits picture cache mode automatically.

It is not possible to set the picture cache time during
recording.

1 Inthe setup menu, select OPERATION
>Rec Function >Picture Cache Rec.

Bunooys ¥ Jeideyn

For menu operations, see “Basic Setup Menu
Operations” (page 97).

2 Turn the MENU knob to select [On],
and then press the knob.

3 Select [P. Cache Rec Time], turn the
MENU knob to select the desired
picture cache time, and then press the
knob.

You can select from 0-2sec, 2-4sec, 4-6sec,
6-8sec, 8-10sec, 10-12sec, 12-14sec, and
13-15sec.

Once made, picture cache mode settings remain
in effect until changed.

Instead of carrying out steps 1 and 2, you can also
select picture cache mode by using an assignable
switch to which the Picture Cache function has
been assigned (see page 135).

Camcorder data handling while recording in
picture cache mode

Recording procedures in picture cache mode are
basically the same as normal recording
procedures. However, note the following
differences with respect to how the camcorder
handles video, time, and output data.
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« If you start recording while the media is being
accessed, the start point of the video that is
actually recorded may be later than the
currently specified picture cache time. Because
the delay increases as the number of recorded
clips increases, you should avoid rapid start-
and-stop recording operations in picture cache
mode.

Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the

internal timecode generator is always F-RUN.

In picture cache mode, you cannot set time data

by setting the F-RUN/SET/R-RUN switch to

SET.

To set time data, exit picture cache mode.

If the remaining free capacity of the media in

the currently selected slot is less than the picture

cache time, and the media in the other slot has
enough remaining capacity, then data is
recorded to the media in the other slot.

However, no data is recorded when there is no

media in the other slot, and when the media in

the other slot does not have enough remaining

capacity. (A message appears in the viewfinder
to inform you that there is not enough remaining
capacity.)

» Shot marks are not recorded if they are set
before the recording start operation.

* When you select a video format that supports
i.LINK HDV output and play a clip that was
recorded in picture cache mode, two or more
frames with the same picture and timecode may
follow on each other.

 i.LINK output is possible during picture cache
recording. However, the picture cache time is
limited.

If power is lost during recording

« If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off
automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC cable was disconnected, or the
power was turned off on the AC adaptor side,
then the video and audio data stored in memory
is lost. The data stored in memory is not
recorded. Be careful to avoid this when
exchanging the battery.

Advanced Operations

Recording Time-lapse Video
(Interval Rec Function)

The camcorder’s Interval Rec function allows
you to capture time-lapse video to the
camcorder’s internal memory. This function is an
effective way to shoot slow-moving subjects.
When you start recording, the camcorder
automatically records a specified number of
frames at a specified interval time.

Interval time

I_l_l

Number of frames in one take

A pre-lighting function is available when Interval
Rec is enabled. This function automatically turns
on a video light before recording starts, which
allows you to record pictures under stable light
and color temperature conditions.

Interval Rec settings and shooting

* The Interval Rec function cannot be used at the same
time as the picture cache, Frame Rec, Slow & Quick
Motion, or Clip Continuous Rec function. When you
select Interval Rec mode, the picture cache, Frame
Rec, Slow & Quick Motion, and Clip Continuous Rec
functions are disabled. When you select picture cache,
Frame Rec, Slow & Quick Motion, or Clip Continuous
Rec mode, the Interval Rec function is disabled.

The data stored in picture cache memory is cleared
when you change the system settings, for example by
selecting a different video format. Picture data from
before the change is not recorded even if you start
recording immediately after the change. The
camcorder exits picture cache mode automatically.

Interval Rec settings cannot be changed during

recording.

Interval Rec is disabled when the following formats

are selected.

- In FAT mode, SP 1440/59.94i or SP 1440/50i, when
the output setting is HD and OPERATION >Input/



Output >1.LINK I/O in the setup menu is set to

[Enable]

In FAT mode, SP 1440/23.98P (pull-down

recording)

In UDF mode, HD420 HQ 1280x720/23.98P (pull-

down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P,
when the output setting is SD and OPERATION
>Input/Output >i.LINK I/O in the setup menu is set
to [Enable]

To make Interval Rec settings

1 Select OPERATION >Rec Function
>Interval Rec in the setup menu.

For menu operations, see “Basic Setup Menu
Operations” (page 97).

2 Turn the MENU knob to select [On],
and then press the knob.
The camcorder enters Interval Rec mode, the
“Interval” indication on the viewfinder
screen flashes.
(The green tally lamp in the viewfinder also
flashes.)

3 Select [Number of Frames], turn the
MENU knob to select the number of
frames to record in one take, and then
press the knob.

You can select from 1, 3, 6, 9 (or from 2, 6,
12 when the video format setting is 720/
59.94P or 720/50P).

4 Select [Interval Time], turn the MENU
knob to select the desired interval, and
then press the knob.

You can select 1 to 10/15/20/30/40/50 sec,
1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24
hour.

5 As required, select [Pre-Lighting], turn
the MENU knob to select the length of
lighting time before recording starts,
and then press the knob.

You can select 1 to 10/15/20/30/40/50 sec,
1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24
hour.

« If you want to turn the video light on before the start of
recording, set the camcorder’s LIGHT switch to
[AUTO]. The video light’s switch must also be turned
on. When this is done, the video light turns on and off

automatically. However, the video light remains lit
when the time that it is off is five seconds or less.

« If you set the LIGHT switch to [MANUAL] and turn
the video light’s switch on, the video light is always lit.
(It does not go on and off automatically.)

The camcorder exits Interval Rec mode when it is
powered off, but the number of frames, interval
time, and pre-lighting settings are maintained.
You do not need to set them again the next time
you shoot in Interval Rec mode.

To shoot in Interval Rec mode

Make the settings and preparations described in
“Basic Operations” (page 68), secure the
camcorder so that it does not move, and begin
shooting.

When recording starts, the “Interval” indication
in the viewfinder changes from flashing to lit, and
“INT REC” and “INT STBY” appear
alternatively at the position of the REC
indication. The TALLY indicators and the tally
indicator on the front panel of the viewfinder light
as they do during normal recording. (The green
tally lamp in the viewfinder flashes at high
frequencies.)

If you are using the pre-lighting function, the
video light comes on before recording starts.

To stop shooting
Stop the recording.

When shooting ends, the video data stored in
memory up to that point is written to the media.

To exit Interval Rec mode

Do one of the following.

* Set the POWER switch to OFF.

* With the camcorder in recording standby mode,
set OPERATION >Rec Function >Interval Rec
in the setup menu to “Off”.

Limitations during recording

* The i.LINK (HDV/DV) connector cannot be
used.

* Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always F-RUN.

* Audio cannot be recorded.

* Recording review is not possible.

» If you press the SLOT SELECT button, the
camcorder completes recording of the specified
number of frames, creates a clip, and switches

Advanced Operations
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to the other media. (when the recording mode is
UDF)
* Genlock is not possible.

If power is lost during recording

« If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off
automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC power cord was disconnected,
or the power was turned off on the AC adaptor
side, then the video and audio data shot up to
that point may be lost (maximum 10 seconds).
Be careful to avoid this when exchanging the
battery.

Shooting Stop Motion Animations
(Frame Rec Function)

The Frame Rec function is useful for shooting
stop motion animations, such as animations with
puppets or clay figures.

Each time that you press the recording start
button, the camcorder shoots a specified number
of frames and then stops.

Frame Rec settings and shooting

* The Frame Rec function cannot be used at the same
time as the picture cache, Interval Rec, Slow & Quick
Motion, or Clip Continuous Rec function. When you
select Frame Rec mode, the picture cache, Interval
Rec, Slow & Quick Motion, and Clip Continuous Rec
functions are disabled. When you select picture cache,
Interval Rec, Slow & Quick Motion, or Clip
Continuous Rec mode, the Frame Rec function is
disabled.
The data stored in memory is cleared when you change
the system settings, for example by selecting a
different video format. Picture data from before the
change is not recorded even if you start recording
immediately after the change. The camcorder exits
Frame Rec mode automatically.
Frame Rec settings cannot be changed during
recording.
Frame Rec is disabled when the following formats are
selected.
- In FAT mode, SP 1440/59.94i or SP 1440/50i, when
the output setting is HD and OPERATION >Input/

Advanced Operations

Output >1.LINK I/O in the setup menu is set to

Enable

In FAT mode, SP 1440/23.98P (pull-down

recording)

In UDF mode, HD420 HQ 1280x720/23.98P (pull-

down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P,
when the output setting is SD and OPERATION
>Input/Output >i.LINK I/O in the setup menu is set
to Enable

To make Frame Rec settings

1 Select OPERATION >Rec Function
>Frame Rec in the setup menu.

For menu operations, see “Basic Setup Menu
Operations” (page 97).

2 Turn the MENU knob to select [Onl,
and then press the knob.
The camcorder enters Frame Rec mode, the
“Frame Rec” indication on the viewfinder
screen flashes.
(The green tally lamp in the viewfinder also
flashes.)

3 Select [Number of Frames], turn the
MENU knob to select the number of
frames to record in one take, and then
press the knob.

You can select from 1, 3, 6, 9 (or from 2, 6,
12 when the video format setting is 720/
59.94P or 720/50P).

The camcorder exits Frame Rec mode when it is
powered off, but the setting for the number of
frames setting is maintained. You do not need to
set it again the next time you shoot in Frame Rec
mode.

To shoot in Frame Rec mode

Make the settings and preparations described in
“Basic Operations” (page 68), secure the
camcorder so that it does not move, and begin
shooting.

When recording starts, the “Frame Rec”
indication in the viewfinder changes from
flashing to lit, and “FRM REC” and “FRM
STBY” appear alternatively at the position of the
REC indication. The TALLY indicators and the
tally indicator on the front panel of the viewfinder
light as they do during normal recording.



To stop shooting
Stop the recording.

‘When shooting ends, the video data stored in
memory up to that point is written to the media.

To exit Interval Rec mode

Do one of the following.

* Set the POWER switch to OFF

¢ With the camcorder in recording standby mode,
set OPERATION >Rec Function >Interval Rec
in the setup menu to “Off”.

Limitations during recording

¢ The i.LINK (HDV/DV) connector cannot be
used.

* Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always R-RUN.

* Audio cannot be recorded.

* Recording review is not possible.

« If you press the SLOT SELECT button, the
camcorder completes recording of the specified
number of frames, creates a clip, and switches
to the other media.

* Genlock is not possible.

If power is lost during recording

« If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off
automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC power cord was disconnected,
or the power was turned off on the AC adaptor
side, then the video and audio data shot up to
that point may be lost (maximum 10 seconds).
Be careful to avoid this when exchanging the
battery.

Shooting with Slow & Quick
Motion
When the camcorder is in HD mode and the video

format (see page 47) is set to one of the formats
listed below, you can specify a recording frame

rate that is different from the playback frame rate.

OPERATION >Format menu Video format
settings

Country File HD System
System Line
NTSC UDF 1080 HD422 50/29.97P
Area or HD422 50/23.98P
NTSC(Q) 720 HD422 50/59.94P
Area HD422 50/29.97P
HD422 50/23.98P
FAT 1080 HQ 1920/29.97P

HQ 1920/23.98P

720 HQ 1280/59.94P
HQ 1280/29.97P
HQ 1280/23.98P

PAL UDF 1080 HD422 50/25P
Area 720 HD422 50/25P
HD422 50/50P

FAT 1080 HQ 1920/25P

720 HQ 1280/50P

HQ 1280/25P

By shooting with a frame rate that differs from the
playback frame rate, you can obtain slow and
quick motion effects that are smoother than low-
speed or high-speed playback of content recorded
at the normal frame rate.

Example

When the video format is HQ 1280/23.98P, you
can obtain quick-motion effects by setting the
frame rate to 1 to 23, and obtain slow-motion
effects by setting the frame rate to 25 to 60.

Slow & Quick Motion settings and
shooting

The Slow & Quick Motion function cannot be used at
the same time as the picture cache, Interval Rec, Frame
Rec, or Clip Continuous Rec function. When you
select Slow & Quick Motion mode, the picture cache,
Interval Rec, Frame Rec, and Clip Continuous Rec
functions are disabled. When you select picture cache,
Frame Rec, Interval Rec, or Clip Continuous Rec
mode, the Slow & Quick Motion function is disabled.
Slow & Quick Motion is disabled when the slow
shutter function (viewfinder display “SLS”) functionis
enabled. The slow shutter function is disabled when
the Slow & Quick Motion function is enabled.

Slow & Quick Motion is disabled when OPERATION
>Input/Output >1.LINK 1/O in the setup menu is set to
[Enable]. When Slow & Quick Motion is enabled,
1.LINK I/0O is fixed as [Disable].

Advanced Operations

Bunooys ¥ Jeideyn

75



Bunooys ¥ Jerdeyn

76

¢ Slow & Quick Motion settings cannot be changed
during recording.

To make Slow & Quick Motion settings

1 Select OPERATION >Rec Function >
Slow & Quick in the setup menu.

For menu operations, see “Basic Setup Menu
Operations” (page 97).

2 Turn the MENU knob to select [On],
and then press the knob.
The camcorder enters Slow & Quick Motion
mode, and the “S&Q STBY” indication in
the viewfinder lights.

3 Select [Frame Rate], turn the MENU
knob to select the recording frame rate,
and then press the knob.

The setting range for the frame rate is as
follows.

System Frame rate
lines

1080  When OPERATION >Format

>Country in the setup menu is set to
[PAL Area] in UDF mode:

1to25
In FAT mode or when OPERATION
>Format >Country in the setup menu
is set to other than [PAL Area] in
UDF mode:

1 to 30

720 When OPERATION >Format

>Country in the setup menu is set to
[PAL Area] in UDF mode:

1to 50
In FAT mode or when OPERATION
>Format >Country in the setup menu
is set to other than [PAL Area] in
UDF mode:

1to 60

When you finish making these settings, the
system frequency and the frame rate appear at the
top of the viewfinder screen. You can change the
frame rate while viewing the display in the
viewfinder by turning the MENU knob.

The Slow & Quick Motion mode setting and the
frame rate are retained even after the camcorder is
powered off.

To shoot in Slow & Quick Motion mode
Shoot as described in “Basic Operations”
(page 68).

Advanced Operations

When recording starts, the “S&Q STBY”
indication in the viewfinder changes to the
“@S&Q REC” indication. The TALLY
indicators and the tally indicator on the front
panel of the viewfinder light as they do during
normal recording.

To stop shooting
Stop the recording.

It takes longer than normal for recording to stop when
Frame Rate is set to a low value (for a slow frame rate).

To exit Slow & Quick Motion mode

With the camcorder in recording standby mode,
set OPERATION >Rec Function > Slow & Quick
in the setup menu to [Off].

Limitations during recording

¢ The i.LINK (HDV/DV) connector cannot be
used.

Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always R-RUN.
Audio cannot be recorded when the recording
and playback frame rates differ.

Recording review is not possible.

If you change the recording frame rate to a value
faster than the current shutter speed, the shutter
speed is changed to the slowest value for which
shooting is possible.

Example: If the frame rate is 32 and the shutter
speed is 1/40, and you change the frame rate to
55, then the shutter speed is changed to 1/60.

If is not possible to select a shutter speed that is
slower than the recording frame rate.

* Genlock is not possible.

Recording with the Clip
Continuous Rec Function

Normally, a clip is created as an independent file
each time that you start and stop recording. But
this function allows you to start and stop
recording while continuously recording to the
same clip, for as long as the function remains
enabled. This is convenient when you do not want
to generate a large number of short clips, and
when you want to record without worrying about
exceeding the clip limit. It is still easy to find
recording start points, because a Rec Start essence
mark is recorded at the recording start point each
time you start recording.



Clip Continuous Rec settings and
shooting

The Clip Continuous Rec function cannot be used at
the same time as the picture cache, Interval Rec, Frame
Rec, or Slow & Quick Motion function. When you
select Clip Continuous Rec mode, the picture cache,
Interval Rec, Frame Rec, and Slow & Quick Motion
functions are disabled. When you select picture cache,
Frame Rec, Interval Rec, or Slow & Quick Motion
mode, the Clip Continuous Rec function is disabled.
The Clip Continuous Rec function is disabled when the
recording mode is FAT.

To make Clip Continuous Rec settings

1 Select OPERATION >Rec Function
>Clip Continuous Rec in the setup
menu.

See “Basic Setup Menu Operations” (page 97)
for more information about menu operations.

2 Turn the MENU knob to select [On],
and then press the knob.
“CONT” appears in the viewfinder, and the
function is enabled.

You can assign the Clip Continuous Rec on/off
function to one of the ASSIGN 1/2/3 switches,
ASSIGNABLE 4/5 switches, and the COLOR
TEMP button.

For details, see “Assigning Functions to Assignable
Switches” (page 135).

To shoot in Clip Continuous Rec mode

Shoot as described in “Basic Operations”

(page 68).

When recording starts, the “Cont” indication in
the viewfinder goes off.

The TALLY indicators and the tally indicator on
the front panel of the viewfinder light as they do
during normal recording.

To stop shooting
Stop the recording.

Stop the recording after the recording continues for two
or more seconds.

To exit Clip Continuous Rec mode

With the camcorder in recording standby mode,
set OPERATION >Rec Function >Clip
Continuous Rec in the setup menu to [Off].

Limitations during recording

A single continuous clip cannot be created while
this camcorder is in the following states. (A new
clip will be created when you next start
recording.)

* Operate on a clip (lock, delete, or rename a clip)
* Eject the card

* Change the recording format

» Power the camcorder off

* Playback

* Switched to thumbnail mode

Framing Shots with the Freeze
Mix Function

The freeze mix function allows you to
temporarily overlap a still image (freeze picture)
from a clip shot in HD mode onto the current
camera picture. This makes it easier to frame the
shot.

The freeze mix function is not available in the following
cases.

When the recording format is SP 1080/23.98P (FAT
mode) or HQ 1280/23.98P (UDF mode)

When the video formats of the recorded picture and the
camera picture differ

When you are shooting in Slow & Quick Motion mode
or slow shutter mode

When there is i. LINK input

To display a freeze mix picture

1 Play a clip or conduct a recording
review of a clip with the same format as
the camera picture.

2 Display the picture that you want to use
as the frame, and then turn on the
assignable switch to which the Freeze
Mix function has been assigned.

The recording review picture is frozen and
overlaps the camera picture.
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The following functions are disabled at the freeze mix
times.

¢ Menu operations

* During Focus Mag display

* Marker display

¢ Zebra display

* Peaking display

« Skin tone details display

To cancel the freeze mix display

Do one of the following.
« Press an assignable switch again to which the
Freeze Mix function has been assigned.
The freeze mix display is canceled and the
display returns to the normal camera picture.
« Start recording (see page 68).
Normal recording starts.

Advanced Operations



A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail
screens display lists of the clips stored on SxS memory cards in the form of index pictures. (A message
appears if you insert a memory card that contains no clips.)

You can select any clip (see page 82) in a thumbnail screen and start playback of that clip (see page 82).

Thumbnail Screen

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An
OK, NG or KP mark also appears when a clip has been marked with an OK, NG or KP mark.)

Normal thumbnail screens display SD clips only or HD clips only, even if the SxS memory card contains clips in both
formats. You can select the format to display by selecting a mode with OPERATION >Format >HD/SD (see page 99) in
the setup menu.

If you want to display all recorded clips, regardless of the HD/SD mode, switch to the all clips thumbnail screen.
However, it is not possible to start playback from the all clips thumbnail screen (see page 87).

Clip Playback
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UDF mode/FAT-HD mode thumbnail screen

[vor) (Faro]

Cursor (yellow)

% 00:00:00:00

01:11:00:00 01:11:10:00

Alh

B 01:11:40:00 01:11:50:00

The icon of the currently selected SxS memory card is highlighted.
(If the card is write protected, a lock appears on the left.)

Clip number/Number of clips

01:10:40:00

© Index picture

When a clip is recorded, its first frame is set
automatically as the index picture. You can
change to index picture to any frame (see
page 94).

©® Lock mark
Indicates the selected clip is marked with an OK
mark or protected.

© Date and start time of recording
O Clip name

© Independent AV file icon

This appears only when a clip is an independent
AV file. SxS memory cards may contain
independent files that have been added directly
from a computer. Because independent files lack
the associated management files, some operations
and information displays may not be available.

Clip Playback

O Video format of recording

@ Special recording information

This displays the mode of clips that have been
recorded in a special mode (Slow & Quick
Motion, Interval Rec, Frame Rec).

For Slow & Quick Motion clips, the frame rates
are displayed to the right as [Recording frame
rate/Playback frame rate] fps.

© OK/NG/KP mark

When the recording mode is UDF, an OK, NG, or
KP mark appears if the clip has been marked with
an OK, NG or KP mark (see page 89).

When the recording mode is FAT, an OK mark
appears only if the clip has been marked with an
OK mark (see page 89).

© File format

Indicates the file format of the selected clip (MXF
or MP4).

(This item is not indicated when the recording
mode is UDF-HD mode.)



@ Clip duration

@ Timecode
This is the timecode of the index picture.

FAT-SD mode thumbnail screen

IR

01:11:00:00 01:11:10:00

-

The icon of the currently selected SxS memory card is highlighted.
Cursor (yellow) (If the card is write protected, a lock appears on the left.)

0 01:11:20:00 01:11:30:00

Clip number/Number of components

0011/0300

@ Take mark

Indicates that the file size is larger than 2 GB, and

that the clip has been split before being saved.
You can check the segment files on the expand
thumbnail screen (see page 92).

@ Index picture
When a clip is recorded, its first frame is set
automatically as the index picture.

© Date and start time of recording

O Clip name/Number of components

The number after the clip name (delimited by /) is
the number of components. This appears only for

clips larger than 2 GB in size, which have been
split into smaller files for storage.

suonesado dijp g Je1deyn

© Video format of recording

@ File format
Indicates the file format of the selected clip
(AVI).

© Clip duration

© Timecode
This is the timecode of the index picture.

To switch between SxS memory cards

When two SxS memory cards are loaded, you can
switch between them by pressing the SLOT
SELECT button.

While an expand thumbnail screen (see page 92) or an
essence mark thumbnail screen (see page 93) is
displayed, SxS memory cards cannot be switched.
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To hide the thumbnail screen

Press the THUMBNAIL button.

Playing Clips

To select clip thumbnails

Do one of the following to move the yellow
cursor to the clip that you want to select.

« Press an arrow button ({}, &, <=, =>).

¢ Turn the MENU knob.

« Press the PREV or NEXT button.

To select the first thumbnail
With the F REV button held down, press the
PREYV button.

To select the last thumbnail
With the F FWD button held down, press the
NEXT button.

To play clips sequentially starting from a
selected clip

1 Select the thumbnail of the clip that you
want to play first.

2 Press the PLAY/PAUSE button.

Play begins from the top of the selected clip.

Play continues through all clips after the selected
clip.

When the last clip has been played to the end, the
camcorder enters pause (still image) mode at the
last frame of the last clip.

Press the THUMBNAIL button to return to the
thumbnail screen.

* There may be momentary picture breakup or still
image display at the transition from one clip to another.
During this time, the playback controls and the
THUMBNALIL button cannot be operated.

When you select a clip in the thumbnail screen and
begin playback, there may be momentary picture
breakup at the top of the clip. To view the top of the
clip without breakup, put the camcorder into playback
mode, pause, use the PREV button to return to the top
of the clip, and start playback again.

On SxS memory cards that contain both HD-mode and
SD-mode clips, you cannot play all clips in sequence.
For example, while an HD mode thumbnail screen is

displayed, only HD mode clips are played in sequence.

Clip Playback

To pause playback

Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator flashes while
playback is paused.

Press the button again to return to playback mode.

To play at high speed

Press the F FWD button (see page 19) or the

F REV button (see page 18).

To return to normal playback, press the PLAY/
PAUSE button.

To stop playback

Press the STOP button: Playback stops and the
camcorder enters E-E mode.

Press the THUMBNALIL button: Playback stops
and the thumbnail screen (see page 79)
appears in the viewfinder.

Playback also stops if you eject the memory card.
In this case, the camera picture appears in the
viewfinder.

To cue up clips

To return to the top of the current clip

Press the PREV button.

* During playback or F FWD, this jumps to the
top of the current clip and starts playback.

* During F REV or pause, this jumps to the top of
the current clip and displays a still image.

 Each subsequent press of the button moves to
the previous clip.

To play from the top of the first clip
Simultaneously press the PREV and F REV
buttons. This jumps to the top of the first clip on
the SxS memory card.

To jump to the top of the next clip

Press the NEXT button.

* During playback or F FWD, this jumps to the
top of the next clip and starts playback.

* During F REV or pause, this jumps to the top of
the next clip and displays a still image.

* Each subsequent press of the button moves to
the next clip.

To play from the top of the last clip
Simultaneously press the NEXT and F FWD
buttons. This jumps to the top of the last clip on
the SxS memory card.



To add a shot mark during playback

You can add shot marks to clips during playback
by using the same method used during recording
(see page 70).

 Shot marks cannot be recorded when the SxS memory
card is write protected.

* Shot marks cannot be added at the first frame of the
first clip or last frame of the last clip.

Using Thumbnails to Search
Inside Clips

You can switch a thumbnail screen to the

following thumbnail search screens, which allow

you quickly find the clips you want.

* Expand thumbnail screen

¢ Essence mark thumbnail screen (HD mode
only)

Like the normal thumbnail screen and the OK clip
thumbnail screen, these screens allow you to
select clip thumbnails (see page 82) and to start
clip playback (see page 82).

To search for scenes in clips with the
expand thumbnail screen

The expand thumbnail screen is convenient when
you want to find and cue up a specific scene in a
long clip.

To display the expand thumbnail screen, select a

clip in the thumbnail screen and press the DISP

SEL/EXPAND button (see page 19) or select

THUMBNAIL >Thumbnail View >Forward

Expansion in the setup menu. The selected clip is

displayed as follows.

HD mode: The clip is divided into 12 equally-
sized blocks, and a thumbnail of the first
frame in each block is displayed.

SD mode: Only in the case of clips that have been
splitinto partial files because the file size was
larger than 2 GB, a thumbnail of the first
frame of each partial file is displayed.

This helps you to quickly cue up to a desired
scene in a clip of long duration.

See “Displaying the Expand Thumbnail Screen”
(page 92) for more information about the expand
thumbnail screen.

To search for essence marks in clips with
the essence mark thumbnail screen

When a clip contains one or more essence marks,
you can easily find them with the essence mark
thumbnail screen. The essence mark thumbnail
screen displays a thumbnail of each essence mark
frame in the clip.

To display the essence mark thumbnail screen,
press the ESSENCE MARK button (see page 20)
or select THUMBNAIL >Thumbnail View >
Essence Mark Thumbnail in the setup menu.

See “Displaying the Essence Mark Thumbnail
Screen” (page 93) for more information about the
essence mark thumbnail screen.

Clip Playback
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Thumbnail Operations

You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and
to change clip metadata.

THUMBNAIL Menu Configuration

Menu items

Sub-items

Description

Clip Properties

Displays detailed properties (see page 88).

Set Index Picture

[UDF ]/ [FaTHD]

Changes index pictures in the expand thumbnail screen or
the essence mark thumbnail screen (see page 94).

Thumbnail View

Forward Expansion

* Displays the expand thumbnail screen (see page 92).
¢ In the expand thumbnail screen, increases the number of
divisions (see page 93).

Back Expansion

In the expand thumbnail screen, decreases the number of
divisions.

Essence Mark Thumbnail ¥

Displays the essence mark thumbnail screen (see page 93).

Clip Thumbnail

Displays the normal thumbnail screen.

All Clip Thumbnail

Displays the all clips thumbnail screen (see page 87).

Set Shot Mark Add Shot Mark1 In the expand thumbnail screen or the essence mark
/ thumbnail screen, adds a Shot Mark1 mark (see page 93).
Delete Shot Mark1 In the expand thumbnail screen or the essence mark
thumbnail screen, deletes a Shot Mark1 mark (see
page 94).
Add Shot Mark2 In the expand thumbnail screen or the essence mark
thumbnail screen, adds a Shot Mark2 mark (see page 93).
Delete Shot Mark2 In the expand thumbnail screen or the essence mark
thumbnail screen, deletes a Shot Mark2 mark (see
page 94).
Set Clip Flag OK Adds an OK mark.
NG Adds an NG mark.
KP(Keep) Adds a KP mark.
None Deletes an OK, an NG or a KP mark.

Add OK Mark
FAT-HD

Adds an OK mark and protects a clip (see page 89).

Delete OK Mark
FAT-HD

Deletes an OK mark and unprotects a clip (see page 89).

Lock Clip

Protects a clip.

Unlock Clip

Cancels protection of a clip.

Copy Clip

Copies a clip (see page 90).

Thumbnail Operations



Menu items Sub-items Description
Delete Clip — Deletes a clip (see page 91).
Divide Clip — Divides a clip (see page 94).
FAT-HD
Filter Clips — Displays the OK clip thumbnail screen (see page 86).
FAT-HD
Filter Clips OK Displays the OK clip thumbnail screen.
NG Displays the NG clip thumbnail screen.
KP(Keep) Displays the KP clip thumbnail screen.
None Displays the None clip (clip which have been marked with
an OK, NG, or KP mark) thumbnail screen.
Lock All Clips — Protects all clips displayed.
Unlock All Clips — Cancels protection of all clips displayed.
Copy All Clips Execute/Cancel Copies all clips (see page 91).
Delete All Clips Execute/Cancel Deletes all unprotected clips (see page 91).

Thumbnail Operations
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Basic THUMBNAIL Menu
Operations

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

To display the THUMBNAIL menu

1 Set the MENU ON/OFF switch to ON,
or press the MENU button.

2 Turn the MENU knob to select “TH”,
and then press the knob. Or press the @
or & button to select “TH”, and then
press the SET button.

The THUMBNAIL menu appears.

FAT

THUMBNAIL
=]

Set Index Picture
\ia [l Thumbnail View
Set Shot Mark
Add OK Mark
Delete OK Mark

in FAT mode

THUMBNAIL
fm]

@ CLIP Properties
Set Index Picture

in UDF mode

To hide the THUMBNAIL menu, press the
MENU button again.

To select menu items and sub-items

Do one of the following.

¢ Turn the MENU knob to select an item or sub-
item, and then press the knob.

« Press the arrow buttons ({1, &, <=, =>) to
select an item or sub-item, and then press the
SET button.

According to the selected item or sub-item, a

selection list or a clip properties screen appears

(see page 88).

Thumbnail Operations

To return to the previous state, push the MENU
CANCEL/PRST/ESCAPE switch down to the
ESCAPE side.

* When an SxS memory card is write protected, it is not
possible to copy, delete, or divide clips, to change
index pictures, or to add and delete OK/NG/KP marks
and shot marks.

» Some items cannot be selected, depending on the state
of the camcorder when the menu was displayed.

To hide the clip properties screen

Do one of the following.

Press the RESET/RETURN button: This
returns to the THUMBNAIL menu.

Press the THUMBNAIL button: The
camcorder enters E-E mode, and the camera
picture appears.

Press the PLAY/PAUSE button: Playback from
the selected clip starts.

Changing the Thumbnail Screen
Type

To display OK/NG/KP/None clip
thumbnails

When the recording mode is UDF, from among
all clips stored on the currently selected SxS
memory card, only clips which have been marked
with a OK, NG or KP mark can be displayed, or
only clips with no marks (None clips) can be
displayed.

When the recording mode is FAT, from among all

clips stored on the currently selected SxS

memory card, only clips which have been marked
with an OK mark can be displayed.

When the normal thumbnail screen is displayed,

you can select THUMBNAIL >Filter Clips to

switch to the screen.

In FAT-HD mode: Switched to the OK clip
thumbnail screen.

In UDF mode: By selecting one of OK, NG, KP
(Keep) and None in the setting area, you can
display the thumbnail screen containing only
clips which have been marked with the
selected mark or only clips which have been
marked with no marks (None clips).



See “Adding and Deleting OK, NG or KP Marks”
(page 89) for information about how to add OK
marks.

To display the all clips thumbnail screen

The all clips thumbnail screen displays
thumbnails of all of the clips on the selected
memory card, including both HD-mode and
SD-mode clips. This is useful when you want to
check whether the memory card contains clips in
another mode.

You can switch to the all clips thumbnail screen
by selecting THUMBNAIL >All Clip Thumbnail
in the setup menu in the normal thumbnails
screen.

Pressing the RESET/RETURN button returns
you to the normal thumbnails screen, where you
can perform playback and other clip operations.

You cannot start playback from the all clips thumbnail
screen.

Thumbnail Operations
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Displaying Clip Properties

The clip properties screen appears when you select Clip Properties in the THUMBNAIL menu.

[vor ) Faro]

{Im120min

LT

PREV CLIP

PROPERTIES 0011/0300

{Im120min

PREV CLIP
(3]

PROPERTIES Gl A S 0011/0300

:

JPAN0011(1)/03
01/JAN/2009 10:53
DVCAM 29.9PsF SQJ[(A

TCR 00:00:00:00
TCR 00:00:00:00 S
TCR 00:25:05:00 E
DUR 00:25:05:00

CH1/CH2

LL% |

© Image of the current clip

@ Image of the previous clip

O Clip name
In SD mode, only for clips that have been divided
because the file size was greater than 2 GB, the

Press the PREV button to display the properties of number of component clips appears after the clip

the previous clip.

© Image of the next clip

name.
When clip names are 12 characters or longer, only
the first five characters and the last five characters

Press the NEXT button to display the properties are displayed. If you want to check the

of the next clip.

Thumbnail Operations

abbreviated characters, press the MENU knob to
switch to long display mode. In long display
mode, up to 53 characters are displayed in clip
names.



Press the MENU knob again to exit long display
mode. Pressing the PREV or NEXT button to
display the previous or next clip also exists long
display mode.

© Lock mark

This appears when the clip is marked with an OK
mark or protected.

O OK/NG/KP mark
This appears only when an OK/NG/KP mark has
been added.

@ Date and start time of recording

© File format
The file format of the clip (MXF, MP4 or AVI)
appears.

© Special recording information

This displays the mode of clips that have been
recorded in a special mode (Slow & Quick
Motion, Interval Rec, Frame Rec).

For Slow & Quick Motion clips, the frame rates
are displayed to the right as [Recording frame
rate/Playback frame rate].

@ Timecode of the displayed image
Timecode of the recording start point
Timecode of the recording end point
Duration

Recorded audio channels

® 6 6 @ 8

Video format of recording

Adding and Deleting OK, NG or
KP Marks

[vor) [Faro]

You can add OK, NG or KP marks to clips. This
makes it possible to display thumbnails of only
the clips that you need by pressing the
THUMBNAIL button.

When the recording mode is FAT, clips with OK
marks cannot be deleted or divided (protected). If
you want to delete or divide such a clip, delete the
OK mark.

To add an OK mark

1 In the thumbnail screen, select
THUMBNAIL >Add OK Mark.
The screen changes to the clip properties
screen, and a confirmation message appears
beneath the index picture.

2 Select [Execute], and press the MENU
knob.
An OK mark is added to the selected clip.

To add an OK, NG or KP mark

1 In the thumbnail screen, select
THUMBNAIL >Set Clip Flag.

2 Select one of OK, NG or KP in the
setting area.

3 Select [Execute], and press the MENU
knob.
The mark selected in step 2 is added to the
selected clip.

To delete an OK mark

A Delete OK Mark item appears in the
THUMBNAIL menu when you have selected a
clip that has an OK mark.

1T the thumbnail screen, select
THUMBNAIL >Delete OK Mark.
The screen changes to the clip properties
screen, and a confirmation message appears
beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The OK mark is deleted from the selected
clip.

Thumbnail Operations
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To delete an OK, NG or KP mark

To cancel protection of a clip

1 In the thumbnail screen, select the
thumbnail of the clip from which you
want to delete an OK, NG or KP mark,
and select THUMBNAIL >Set Clip Flag
>None.

The screen changes to the clip properties
screen, and a confirmation message appears
beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The mark selected in step 2 is added to the
selected clip.

Protecting Clips

When the recording mode is UDF, you can
protect a selected clip or all clips. Protected clips
cannot be deleted or divided.

To protect a clip

1 In the thumbnail screen, select the
thumbnail of the clip which you want to
protect, and select THUMBNAIL
>Lock Clip.

The screen changes to the clip properties
screen, and a confirmation message appears
beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The selected clip is protected.

To protect all clips

1 the thumbnail screen, select
THUMBNALIL >Lock All Clips.
A confirmation message appears beneath the
index picture.

2 Select [Execute], and press the MENU
knob.
All clips are protected.

Thumbnail Operations

1 In the thumbnail screen, select the
thumbnail of the clip which you want to
unprotect, and select THUMBNAIL
>Unlock Clip.

The screen changes to the clip properties
screen, and a confirmation message appears
beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The selected clip is unprotected.

To cancel protection of all clips

1 In the thumbnail screen, select
THUMBNAIL >Unlock All Clip.
A confirmation message appears beneath the
index picture.

2 Select [Execute], and press the MENU
knob.
All clips are unprotected.

Copying Clips

You can copy clips to other SXS memory cards.
Clips are copied to destination SxS memory cards
using the same names as the original clips.

« If a clip with the same name already exists at the copy
destination SxS memory card, a one-digit number in
parentheses is added to the original name.

The number in parentheses is the smallest number that
does not exist at the copy destination.

Examples:

ABCD0002—ABCDO0002(1)
ABCDO0002(1)—ABCD0002(2)
ABCDO0005(3)—ABCD0005(4)

If the parenthetical numbers (1) to (9) already exist at
the copy destination, it is not possible to copy any more
clips under that name. (A tenth clip cannot be copied.)
A message appears if there is not enough free capacity
at the copy destination SxS memory card. Exchange
the card for one with more free capacity.

‘When multiple clips are recorded in a source SxS

memory card, it may not be possible to copy all clips
to the end. Depending on memory characteristics and
usage of the memory cards, this can occur even when



the source and destination memory cards have the
same capacity.

1 In the thumbnail screen, select the
thumbnail of the clip to copy, and then
select THUMBNAIL >Copy Clip.

The screen changes to the properties screen
of that clip, and a confirmation message
appears beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The copy starts.

During the copy, an execution message and
progress bar are displayed.

When the copy finishes, the display returns to the
thumbnail screen.

To cancel a copy operation

Press the RESET/RETURN button.

The copy is cancelled, and the display returns to
the thumbnail screen.

To batch copy groups of clips

You can batch copy groups of clips from one SxS
memory card to another SXS memory card.
‘When both HD-mode and SD-mode clips exist on
the source SxS memory card, only clips in the
currently selected mode are copied. This is a
convenient way to extract clips in one of the
modes.

1 In the thumbnail screen, select the
thumbnails of the clips to copy and then
select THUMBNAIL >Copy All Clips.
The confirmation message “Copy All Clip?”
appears.

2 Select [Execute], and press the MENU
knob.
The copy starts.
During the copy, the progress of the copy is
displayed.
If you executed the copy in HD mode, only
HD-mode clips are copied.
If you executed the copy in SD mode, only
SD-mode clips are copied.

To cancel the copy operation
Press the RESET/RETURN button.

When the copy finishes
A completion message appears, and the
THUMBNAIL menu screen appears again.

Deleting Clips

You can delete clips from SxS memory cards.

HD clips with OK marks cannot be deleted.
If you want to delete such clips, first delete the OK marks
(see page 89).

1 In the thumbnail screen, select the
thumbnail of the clip to delete, and then
select THUMBNAIL >Delete Clip.

The screen changes to the properties screen
of that clip, and a confirmation message
appears beneath the index picture.

2 Select [Execute], and press the MENU
knob.
The clip is deleted.

In the thumbnail screen, the clips that followed
the deleted clip move up one position.

To batch delete groups of clips

You can batch delete groups of clips from an SxS
memory card.

¢ When both HD-mode and SD-mode clips exist on the
SxS memory card, only clips in the currently selected
mode are deleted.

* In HD mode, clips with OK marks are not deleted,
even when a deletion is executed for a group of clips
that includes them.

1 In the thumbnail screen, select the
thumbnails of the clips to delete and
then select THUMBNAIL >Delete All
Clips.

The confirmation message “Delete All
Clips?” appears.

2 Select [Execute], and press the MENU
knob.
The deletion starts.
During the deletion, the progress of the
deletion is displayed.

Thumbnail Operations
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If you executed the deletion in HD mode,
only HD-mode clips are deleted.
If you executed the deletion in SD mode,
only SD-mode clips are deleted.

To cancel the deletion
Press the RESET/RETURN button.

When the deletion finishes
A completion message appears, and the
THUMBNAIL menu screen appears again.

Displaying the Expand Thumbnail
Screen

The expand thumbnail screen allows you to
search inside clips by using thumbnails (see
page 83), to change index pictures (see page 94),
and to add and delete shot marks (see page 93).

To display the screen

In the thumbnail screen, select a thumbnail and
press the DISP SEL/EXPAND button (see

page 19) or select THUMBNAIL >Thumbnail
View >Forward Expansion.

An expand thumbnail screen for the selected clip
appears.

Expand thumbnail screen in UDF/FAT-HD
mode

[vor ) Faro]

In UDF mode or FAT-HD mode, the selected clip
is divided into 12 equally-sized blocks, and a
thumbnail of the first frame in each block is
displayed.

Number of the selected frame

EXPAND

|

“701:10:30:00

JPAN0011(1) @

HQ 1920/24p|

Clip properties are shown at the bottom of the
screen.

Thumbnail Operations

Except for the items listed below, the information
displayed here is the same as the information
displayed in the normal thumbnail screen.

@ Frame information
This displays frame information using icons.

&

8] Frame with Shot Mark1

Index picture

m Frame with Shot Mark2

The same icons are also displayed beneath the
thumbnails. However, when several icons could
be displayed for the same frame, one icon is
selected for display, in the order of priority Index
picture > Shot Mark1 > Shot Mark?2.

© Timecode
This displays the timecode of the selected frame
in the expand thumbnail screen.

Expand thumbnail screen in FAT-SD
mode

In FAT-SD mode, only in the case of clips that
have been split into partial files because the file
size was larger than 2 GB, a thumbnail of the first
frame of each partial file is displayed.

Number of the selected frame

{Em120min EXPAND

- I -
00:00:00:00 00:09:30:00

01/JAN/2009 10:53
JPAN0011_01 DVCAM30P SQ l- 00:09:30:00)

Clip properties are displayed at the bottom of the
screen.

Except for the items listed below, the information
displayed here is the same as the information
displayed in the normal thumbnail screen.



@ Timecode
This is the timecode of the selected partial file.

@ Duration
This is the duration of the selected partial file.

To increase the number of divisions

‘When you press the DISP SEL/EXPAND button,
or select THUMBNAIL >Thumbnail View
>Forward Expansion, the divided clip or file is
further divided into 12 equally-sized blocks (a
clip or file that has been divided into 12 is further
divided into 12, for 12 x 12 = 144 divisions). You
can repeat the same operation to increase the
number of division.

To return to the previous division level

Press the DISP SEL/EXPAND button with the
SHIFT button held down, or select
THUMBNAIL >Thumbnail View >Back
Expansion. The expand thumbnail screen returns
to the previous division level.

Displaying the Essence Mark
Thumbnail Screen

In the essence mark thumbnail screen (shown
only in HD mode), you can search for shot marks
in clips (see page 83), change index pictures (see
page 94), and add and delete shot marks (see
page 93).

1 In the thumbnail screen, select the
thumbnail of a clip, and press the
ESSENCE MARK button (see page 20)
or select THUMBNAIL >Thumbnail
View >Essence Mark Thumbnail.

2 The essence mark thumbnail screen

appears, and a selection list is displayed.

3 Select the type of the essence mark
thumbnail screen
Shot Mark1: Display only frames marked
with Shot Mark1 marks.
Shot Mark2: Display only frames marked
with Shot Mark2 marks.
Shot Mark: Display frames marked with

either Shot Mark1 or Shot Mark2 marks.

Rec Start: Display frames marked with Rec
Start marks and of the first frames of
clips when the first frames are not
marked with Rec Start marks.

All: Display all frames marked with essence
marks.

Example shot mark thumbnail screen
(with Shot Mark selected)

0K )

The properties of the clip appear at the bottom of
the screen.

Except for the following item, the information
displayed here is the same as the information
displayed in the expand thumbnail screen.

© Timecode
This is the timecode of the selected frame in the
shot mark thumbnail screen.

Adding and Deleting Shot Marks
[uF ] [Fa+o]

In the essence mark thumbnail screen (see

page 93) or the expand thumbnail screen (see
page 92), you can add thumbnails to any frame of
clips recorded in HD mode, and delete recorded
shot marks.

To add shot marks

1 Select the frame where you want to add
a shot mark, and then select
THUMBNAIL > Set Shot Mark > Add
Shot Mark1 (or Add Shot Mark?2).

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

Thumbnail Operations
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2 Select [Execute], and press the MENU
knob.

To delete shot marks

1 Select the frame where you want to
delete a shot mark, and then select
THUMBNALIL > Set Shot Mark >
Delete Shot Mark1 (or Delete Shot
Mark2).

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

2 Select [Execute], and press the MENU
knob.

Changing Clip Index Pictures
[uoF]/[Far-Ho]

In the essence mark thumbnail screen (see

page 93) or the expand thumbnail screen (see
page 92), you can set the selected frame of the
cliprecorded in UDF/FAT-HD mode as the index
picture.

1 Select the thumbnail of the frame that
you want to use as the index picture,
and then select THUMBNAIL >Set
Index Picture.

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

2 Select [Execute], and press the MENU
knob.

Evenif you set the index picture to a frame that is not the
first frame of a clip, playback of that clip from a
thumbnail screen always begins at the first frame.

Dividing Clips

In the expand thumbnail screen (see page 92) and
the essence mark thumbnail screen (see page 93),
clips recorded in FAT-HD mode can be divided

into two clips at the selected frame.

Thumbnail Operations

1 Select the thumbnail of the frame where
you want to divide the clip, and then
select THUMBNAIL >Divide Clip.

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

2 Select [Execute], and press the MENU
knob.
The clip is divided at the selected frame, and
two clips with different names are created.

The first four characters of the clip name are
taken from the name of the original clips, and the
last four characters are new serial numbers.

Example: When the name of a newly recorded
clip would be EFGHO0100, and a clip named
ABCDO0002 is divided, the names of the two
newly created clips are ABCD0100 and
ABCDO0101.

When there is not enough remaining capacity on the SxS
memory cards to store the divided clips, a message
appears to inform you that there is not enough capacity.



Menu and Detailed Settings

OPERATION Menu (see page 99)

Setup Menu

OPERATION

Organization and Levels

On this camcorder, settings for shooting and
playback are made in the setup menu, which

Format

Format Media

——— Input/Output

Super Impose

———LCD

Rec Function

appears in the viewfinder. ——— Assignable SW
The setup menu can also be displayed on an I—— VF Setting
external video monitor (see page 144). Marker
Gain Switch
Setup Menu Organization — TLCS
——— Zebra
The setup menu consists of the following menus. ——— Display On/Off
Op: OPERATION menu ——— “I"LED
Auto Iris

Settings related to shooting, except settings
related to picture quality (see page 99)

Pa: PAINT menu

——— White Setting
——— Offset White

Settings related to picture quality (see page 112) Shutter
Time Z
Th: THUMBNAIL menu 1me £one
L Clip

Settings related to clip thumbnails (see page 84)

The THUMBNAIL menu is used only when a thumbnail
screen (see page 79) is displayed. It is disabled when no
thumbnail screen is displayed.

Ma: MAINTENANCE menu
Settings related to audio and timecode (see
page 118)

Fi: FILE menu
Settings related to file operations (see page 131)

Setup Menu Levels

See “THUMBNAIL Menu Configuration” (page 84)
for the organization of the THUMBNAIL menu.

Setup Menu Organization and Levels
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PAINT Menu (see page 112)
PAINT

——— Switch Status
—— White

——— Black

|— Flare

—— Gamma

| — Black Gamma
I— Knee

——— White Clip
| Detail(HD Mode)
|— Detail(SD Mode)
|— Aperture

— Skin Detail
| Matrix

——— Multi Matrix
——— V Modulation

Low Key Saturation

L Noise Suppress

MAINTENANCE Menu (see page 118)

MAINTENANCE
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‘White Shading
Black Shading
Battery

Audio

WRR Setting
Timecode
Essence Mark
Camera Config
Preset White
White Filter
DCC Adjust
Auto Iris2
Genlock

ND Comp
Lens

Auto Shading
APR

Trigger Mode
Clock set
Language
Hours Meter

Version

96 | Setup Menu Organization and Levels

FILE Menu (see page 131)
FILE

All

Scene

Reference

Lens



Basic Setup Menu
Operations

To display the setup menu

Set the MENU ON/OFF switch to ON, or press
the MENU button.

The camcorder enters menu mode and the menu
list appears on the screen.

A cursor appears over the first two characters of the
most recently used menu, and the corresponding
menu item selection area appears to the right.

Example: When the cursor is positioned at the
OPERATION menu

Menu list

. OPERATION

g Format

n l{Format Media

va flInput/Output
Super impose
Rec Function

Menu item selection area

The setup menu cannot be used when the camcorder is in
focus magnification mode. Exit focus magnification
mode by pressing the assignable switch to which the
Focus Mag function has been assigned.

To make menu settings

1 Turn the MENU knob, or press the ﬁ} or
{ button, to move the cursor to the item
that you want to set.

A list of selectable menu items appears in the
menu item selection area to the right of the
icon.

2 Press the MENU knob or the SET
button.
The cursor moves to the menu item selection
area.
You can also move the cursor to the menu
item selection area by pressing the =>
button.

* The menu item selection area displays a
maximum of seven lines. You can scroll
through menus with more than seven lines
by moving the cursor up and down.
Triangles appear at the upper right and
lower right of the menu item selection area
to indicate that a menu is scrollable.

__ OPERATION

Appears when more menu items
are available below the last line.
(A appears when more menu items
are available above the first line.)

Menu item selection area

* P appears to the right when more detailed
sub-items are available.

¢ Settings appear to the right when a menu
item has no sub-items.

* You can select .= to return to the
previous level.

Turn the MENU knob, or press the tor
{ button, to move the cursor to the item
that you want to set, and then confirm
by pressing the MENU knob or the SET
button.

The sub-items area appears to the right of the
menu item selection area, and the cursor
moves to the first sub-item.

__ OPERATION
&l Format

HD System Line
System Frequency :
Rec Format

i JJAspect Rati
Sub-items area

* Displays sub-items and their current
settings

* To return to the previous level, select @J‘ s
press the <= button, or push the MENU
CANCEL/PRST/ESCAPE switch down to
the ESCAPE side.

Basic Setup Menu Operations
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4 Turnthe MENU knob, or press the for
{ button, to move the cursor to the sub-
item that you want to set, and then
confirm the selection by pressing the
MENU knob or the SET button.

The settings of the selected sub-item appear,
and the cursor moves to the currently
selected value.

OPERATION

d Format File System

n l{Format Media

Va @ Input/Output
Super impose

JAspect Ratio (SD) :
Settings area

 The settings area displays a maximum of
seven lines. You can scroll through menus
with more than seven sub-items by moving
the cursor up and down. Triangles appear at
the upper right and lower right of the
settings area to indicate that a sub-item
menu is scrollable.

For sub-items with a large settings range
(for example, —99 to +99), the settings area
is not displayed. Instead, the sub-item name
is highlighted to indicate that the sub-item
can be set.

a1

Turn the MENU knob, or press the for
{ button, to select the value to set, and
then confirm by pressing the MENU
knob or the SET button.

The setting is changed, and the display is
updated to show the new setting.

If you select [Execute] for an executable
item, the corresponding function is executed.

Items that require confirmation before execution
In step 3, the menu disappears and a confirmation
message appears if you select an item that
requires confirmation before execution. Follow
the instructions in the message to execute or
cancel the operation.

To enter text

Some items, such as time data or file names, must
be set by entering text. When you select one of
these items, the text entry area is highlighted, with
“SET” displayed to the right.

Basic Setup Menu Operations

1 Turnthe MENU knob, or press the tor
{ button, to select a character, and then
confirm by pressing the MENU knob or
the SET button.

The cursor moves to the next position.

To return to the previous position, push the
MENU CANCEL/PRST/ESCAPE switch
down to the ESCAPE side.

2 Select characters for all positions up to
the last.
The cursor moves to “SET”.

3 Press the MENU knob or the SET
button.
This confirms the setting.

To cancel the setting change

Push the MENU CANCEL/PRST/ESCAPE
switch down to the ESCAPE side.

To reset a setting to the initial value

1 Beforea setting is changed or after a
setting change is cancelled, push the
MENU CANCEL/PRST/ESCAPE
switch up to the CANCEL/PRST side.

2 When the message to confirm whether
the current setting is reset to the initial
value, push the MENU CANCEL/
PRST/ESCAPE switch up to the
CANCEL/PRST side again.

The current setting is reset to the initial value.

To exit the menu

Set the MENU ON/OFF switch to OFF or press
the MENU button.
The normal camera picture reappears.



Menu List

Settings in bold are the factory default values.

OPERATION Menu

OPERATION

Menu items Sub-item Settings Description

Format File System UDF/FAT Switches between UDF and FAT as the

Specifies the recording mode (execute by selecting

camcorder’s Execute).

recording mode, HD/SD HD/SD Switches between HD or SD as the

operating mode and - d by selecti

recording format. operating mode (execute by selecting
Execute).
‘When the optional CBK-MDO1 is not
installed, [SD] cannot be selected. (SD
recording is not allowed.)

HD System Line ~ 1080/720 ‘When the operating mode is HD, sets

the number of system lines to 1080 or
720 (execute by selecting Execute).

System Frequency

The available settings
vary depending on the
settings in HD/SD, HD
System Line, and
Country.

Selects the system frequency (execute
by selecting Execute).

59.94i/29.97P/23.98P

‘When the HD/SD setting is [HD], the

HD System Line setting is [1080], and
the Country setting is other than [PAL
Area].

50i/25P

* When the HD/SD setting is [HD], the
HD System Line setting is [1080], and
the Country setting is [PAL Area].

¢ When the HD/SD setting is [SD], and
the Country setting is [PAL Area].

59.94P/29.97P/23.98P

‘When the HD/SD setting is [HD], the
HD System Line setting is [720], and
the Country setting is other than [PAL
Area).

50P/25P

‘When the HD/SD setting is [HD], the
HD System Line setting is [720], and
the Country setting is [PAL Area].

59.94i/29.97P

When the HD/SD setting is [SD], and
the Country setting is other than [PAL
Area].

Menu List
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Menu items Sub-item

Settings

Description

Format Rec Format
Specifies the

camcorder’s

operating mode and

recording format.

The available settings
vary depending on the
settings in UDF/FAT, HD/
SD, HD System Line, and
System Frequency.

Selects the recording format (execute by
selecting Execute).

HD422 50/HD420 HQ

* When the UDF/FAT setting is [UDF],
the HD/SD setting is [HD], the HD
System Line setting is [1080].

When the UDF/FAT setting is [UDF],
the HD/SD setting is [HD], the HD
System Line setting is [720], and the
System Frequency setting is
[23.98P].(When the System
Frequency setting is [25P], [29.97P],
or [50P], this setting is fixed to
[HD422 50].)

HQ 1920/HQ 1440

‘When the UDF/FAT setting is FAT, the
HD/SD setting is [HD], the HD System
Line setting is [1080], and the System

Frequency setting is [29.97P] or [25P].

HQ 1920/HQ 1440/
SP 1440

‘When the UDF/FAT setting is FAT, the
HD/SD setting is [HD], the HD System
Line setting is [1080], and the System
Frequency setting is other than [29.97P]
and [25P].

HQ 1280 When the UDF/FAT setting is FAT, the
HD/SD setting is [HD], and the HD
System Line setting is [720].
IMX50/DVCAM When the UDF/FAT setting is [UDF]
~ and the HD/SD setting is [SD].
9:3' DVCAM When the UDF/FAT setting is [FAT] and
% the HD/SD setting is [HD].
> Aspect Ratio (SD) 16:9/4:3 Selects the aspect ratio when SD mode
= is selected (execute by selecting
] Execute).
g Audio 24bit/16bit Selects the audio bit rate for recording
3 Length(IMX) in IMX format.
] Country NTSC Area/NTSC(J) Selects the area of use (execute by
g'- Area/PAL Area selecting Execute).
§ Format Media Media(A) Execute/Cancel Initializes the SxS memory card in slot
7 Executes a media A (execute by selecting Execute).
g:_ format. Media(B) Execute/Cancel Initializes the SxS memory card in slot
é B (execute by selecting Execute).
100 | Menu List



Menu items Sub-item Settings Description
Input/Output In FAT mode HD&HDV/SD&HDV/  Selects the signals output from the
Makes settings Output& i.LINK ~ SD&DV video connectors and the i.LINK (HDV/
related to I/O signals. Tn UDF mode HD/SD DV) connector.
Output ‘When the HD/SD setting is SD,
“SD&DV” or “SD” is selected.
23.98P Output PsF/Pull Down ‘When the video format is HQ 1920/

23.98P or HQ 1440/23.98P, selects
whether to use progressive output (PsF)
or pulldown output (Pull Down).

Source Select

Camera/i. LINK

Selects whether to use the video camera
picture (Camera) or the signal input
from the i.LINK (HDV/DV) connector
(i.LINK) as the video input source.

i.LINK I/O

Enable/Disable

Selects whether to enable or disable
input and output of signals via the
i.LINK (HDV/DV) connector.

‘When Enable is selected, you can
execute auto black balance adjustment
during i.LINK output.

SDI Output

On/Off

Turns on or off the output of signals
from the HD/SD SDI OUT connector.

SDI Out Super

On/Off

Turns on or off the superimposition of
text information on the output of the
HD/SD SDI OUT connector

Video Out Super

On/Off

Turns on or off the superimposition of
text information on the output of the
VIDEO OUT connector.

Menu List
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Menu items Sub-item

Settings

Description

Input/Output Down Converter
Makes settings

related to I/O signals.

Crop/Letter/Squeeze

Selects the signal conversion mode for

output of SD signals.

Crop: Crop the edges of the 16:9
picture and output as a 4:3 picture.

Letter: Mask the top and bottom of the
4:3 picture and display in the center
of the screen as a 16:9 picture.

Squeeze: Squeeze the 16:9 picture
horizontally and output as a 4:3
picture.

Wide ID

Through/Auto

Selects whether to add wide picture

information to the SD output signal.

Through: Output without adding wide
picture information.

Auto: Add and output wide picture
information when the Down
Converter setting is Squeeze.

Wide Mode ¥

Auto/16:9

‘When the input signal is SD, select the
method that determines whether the
signal is treated as a wide signal.

Auto: When wide picture information is
detected in the input signal, treat
the signal as a wide signal and set
the up-converter operating mode to
squeeze mode. When wide picture
information is not detected, set the
upconverter operating mode to
edge crop mode and do not record
wide picture information.

16:9: Always treat the signal as a wide
signal and set the upconverter
operating mode to squeeze mode.

Setup Remove ¥

7.5%/0.0%

‘When the Country setting is other than
[PAL Area], selects whether to remove
the setup level of analog input video
signals.

7.5%: Remove the setup.

0.0%: Do not remove the setup.

Super Impose Super(VF Display)

On/Off

Makes settings Super(Menu)

On/Off

related to
superimposed text
and markers.

Super(Timecode)

On/Off

When the setting of Input/Output >SDI
Out Super or Video Out Super is On,
superimpose text information on the
output from the HD/SD SDI OUT
connector, and VIDEO OUT connector,
as specified (On or Off) for each item.

Super(Marker)

On/Off

When the setting of Input/Output
>Video Out Super is On, specifies
whether to superimpose markers on the
output from the VIDEO OUT
connector.

LCD LCD Color

—99 to +0 to +99

Adjusts the LCD color.

LCD
Marker&Zebra

On/Off

Turns the marker and zebra display in
the LCD monitor on or off.

Menu List



Menu items Sub-item

Settings

Description

Rec Function
Makes settings
related to special
recording modes.

Slow & Quick

On/Off

Turns the Slow & Quick Motion
function on or off. (When this is set to
On, the Picture Cache Rec, Interval Rec,
and Frame Rec sub-items are set to Off.)

Frame Rate

The available settings
vary depending on the
Format >HD System Line
setting.

When the Slow & Quick setting is On,
sets the frame rate for Slow & Quick
Motion shooting.

‘When Format >Country is
set to other than [PAL
Area] in UDF mode or in
FAT mode: 1 to 30
‘When Format >Country is
set to [PAL Area] in UDF
mode: 1 to 25

‘When the HD System Line setting is
1080.

‘When Format >Country is
set to other than [PAL
Area] in UDF mode or in
FAT mode: 1 to 30 to 60
‘When Format >Country is
set to [PAL Area] in UDF
mode: 1 to 25 to 50

When the HD System Line setting is
720.

Clip Continuous
Rec

On/Off

Turns the Clip Continuous Rec function
on or off. (When this is set to On, the
Slow & Quick, Picture Cache Rec,
Interval Rec, and Frame Rec sub-items
are set to Off.)

Picture Cache Rec

On/Off

Turns the picture cache function on or
off. (When this is set to On, the Slow &
Quick, Interval Rec, Frame Rec sub-
items are set to Off.)

P. Cache Rec Time

0-2sec/2-4sec/4-6sec/
6-8sec/8-10sec/10-12sec/
12-14sec/13-15sec

‘When the Picture Cache Rec setting is
On, set the picture cache time.

Interval Rec On/Off Turns the Interval Rec function on or
off. (When this is set to On, the Slow &
Quick, Picture Cache Rec, and Frame
Rec sub-items are set to Off.)

Frame Rec On/Off Turns the Frame Rec function on or off.

(When this is set to On, the Slow &
Quick, Picture Cache Rec, and Interval
Rec sub-items are set to Off.)

Number of Frames

The available settings
vary depending on the
settings in Format >HD
System Line and Format
>System Frequency.

‘When Interval Rec or Frame Rec is set
to On, specifies the number of frames to
shoot in one Interval Rec or Frame Rec
take.

2frame/6frame/12frame

‘When the HD System Line setting is
720, and the System Frequency setting
is 59.94P or 50P.

1frame/3frame/6frame/
9frame

‘When the HD System Line setting is
other than 720, or the System Frequency
setting is other than 59.94P or 50P.

Menu List
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Menu items Sub-item Settings Description
Rec Function Interval Time 1/2/3/4/5/6/7/8/9/10/15/  When the Interval Rec setting is On,
Makes settings 20/30/40/50 (sec) sets the interval for Interval Rec

related to special
recording modes.

1/2/3/4/5/6/7/8/9/10/15/
20/30/40/50 (min) 1/2/3/
4/6/12/24 (hour)

shooting.

Pre-Lighting

Off/2sec/5sec/10sec

If you want the video light to be turned
on before Interval Rec shooting, select a
number of seconds before the start of
shooting. If you do not want it to be
turned on, select Off.

Assignable SW <0> See page 135. Assigns function to ASSIGN. 0 switch.
Assigns functions to  <1> Assigns function to ASSIGN. 1 switch.
assignable switches. <7 Assigns function to ASSIGN. 2 switch.
See “Assigning <3> Assigns function to ASSIGN. 3 switch.
Functions to <4> Assigns function to ASSIGNABLE 4
Assignable Switches” .
(page 135) for more SWIt.Ch' _
information about <> Assigns function to ASSIGNABLE 5
assigning functions. switch.
RET Assigns function to RET button on the
lens.
C. Temp Assigns function to COLOR TEMP.
button.
Zoom Speed 0to 20 to 99 ‘When Zoom has been assigned to the
ASSIGNABLE 4 or 5 switch, specifies
the zoom speed.
VF Setting Color —99 to +0 to +99 Adjusts the density of the colors
Makes settings displayed in the viewfinder screen.
related to the Peaking Type Normal/Color/Both Selects the peaking type.
viewfinder screen. Normal: Normal peaking
o Color: Color peaking
3 Both: Both
% Peaking Frequency Normal/High Selects Normal or High as the peaking
> frequency.
= Peaking Color White/Red/Yellow/Blue ~ When the Peaking Type setting is Color,
] selects the peaking color from among
g White, Red, Yellow, and Blue.
2 VF Detail Level 99 to 0 to +99 Adjusts the detail level (set on the
g camcorder) of the viewfinder
oy Color Peaking Low/Mid/High ‘When the Peaking Type setting is Both,
cg Level selects the color peaking level from
® among Low, Mid, and High.
=
@

Menu List
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Menu items Sub-item Settings Description
Marker Setting On/Off Turns all markers on or off.
Makes settings Center Marker 1/2/3/4/0ff ‘When the center marker is displayed,
related to marker selects the type. Select Off if you do not
Sizl\igiluligszzreen want to display the marker.
' Center H Position —40 to 0 to 40 Specifies the horizontal position of the
center marker.
Center V Position —40 to 0 to 40 Specifies the vertical position of the
center marker.
Safety Zone On/Off Turns the safety zone display on or off.
Safety Area 80%/90%192.5%/95% Selects the safety zone range.
Aspect Marker Line/Mask/Off When an aspect marker is to be

displayed, selects the display method.

Select Oft if you do not want to display

the marker.

Line: Show as white lines.

Mask: Display by lowering the video
signal level of areas outside the
marker range.

Aspect Select

15:9/14:9/13:9/4:3/
1.66:1/1.85:1/2.35:1/2.4:1

Selects the aspect ratio of the marker.

Aspect Mask 0% to 30% to 90% (10% When the Aspect Marker setting is
step) Mask, specifies the video signal level of
areas outside the marker range as a
percentage value relative to the video
signal level of areas inside the marker
range.

User Box On/Off Turns the box cursor display on or off.

User Box Width 40 to 500 to 999 Specifies the box cursor width (distance
from the center to the left and right
edges).

User Box Height 70 to 500 to 999 Specifies the box cursor height
(distance from the center to the top and
bottom edges).

User Box H —479 to 0 to 479 Specifies the horizontal position of the

Position box cursor center.

User Box V —464 to 0 to 464 Specifies the vertical position of the box

Position cursor center.

Guide Frame On/Off Turns display of the guide frame on or

off.

Menu List
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Menu items Sub-item Settings Description

Gain Switch Gain Low —-6dB/-3dB/0dB/3dB/ Specifies the gain value for the

Makes settings 6dB/9dB/12dB/18dB/ L position of the GAIN switch.

related to the GAIN 24dB/30dB/36dB/42dB

switch. Gain Mid —6dB/-3dB/0dB/3dB/ Specifies the gain value for the
6dB/9dB/12dB/18dB/ M position of the GAIN switch.
24dB/30dB/36dB/42dB

Gain High —6dB/-3dB/0dB/3dB/ Specifies the gain value for the

6dB/9dB/12dB/18dB/ H position of the GAIN switch.
24dB/30dB/36dB/42dB

Gain Turbo —6dB/-3dB/0dB/3dB/ Specifies the gain value for the Turbo

6dB/9dB/12dB/18dB/ Gain function, which can be assigned to
24dB/30dB/36dB/42dB  an assignable switch.

Shockless Gain On/Off Turns shockless gain (a function that
switches smoothly when the gain is
switched) on or off.

TLCS Mode Backlight/Standard/ Selects the auto iris mode used when the
Makes settings Spotlight TLCS system is activated.
related to total level Backlight: Backlight mode (lessens the
control. blackout of the main subject that
occurs under backlit conditions)
Standard: Standard mode
Spotlight: Spotlight mode (lessens the
whiteout of the main subject that
occurs under a spotlight)

Speed -99 to +0 to +99 Specifies the control speed (speed of
reaction to changes in the video) used
when the TLCS system is activated.
(Larger values specify quicker reaction
times.)

AGC On/Off Turns the AGC (auto gain control)
function on or off.

AGC Limit 3dB/6dB/9dB/12dB/ Specifies the maximum gain used when

18dB AGC is on.

AGC Point F5.6/FA/F2.8 Specifies the F value where control by
auto iris switches to control by AGC,
used when AGC is on.

Auto Shutter On/Off Turns the auto shutter function on or off.

Auto Shutter Limit 1/100/ 1/150/ 1/200 / Selects the maximum shutter speed used

1/250 when auto shutter is on.

Auto Shutter Point F5.6/F8/F11/F16 Specifies the F value where control by
auto iris switches to control by auto
shutter, used when auto shutter is on.

Zebra Zebra Select 1/2/BOTH Selects the zebra pattern type (Zebral,

Makes settings

Zebra2, Both).

related to zebra Zebral Level

50% to 70% to 107%

Specifies the Zebral display level.

displays. Zebral Aperture 1 to 10% to 20% Specifies the Zebral aperture level.
Level
Zebra2 Level 52% to 100% to 109% Specifies the Zebra2 display level.
Menu List



OPERATION

Menu items Sub-item Settings Description

Display On/Off Video Level On/Off Turns the warnings that appear when the

Selects the items to ~ Warnings video level is too bright or too dark on

display in the or off.

viewfinder screen. Focus Position On/Off Turns the indication of the lens focus
position on or off.

Zoom Position On/Off Turns the indication of the lens zoom
position on or off.

Audio Level Meter On/Off Turns the display of the audio level
meters on or off.

Timecode On/Off Turns the display of time data
(timecode, user bits, counter, duration)
on or off.

Battery Remain On/Off Turns the indications of the remaining
battery time and input voltage on or off.

Media Remain On/Off Turns the indication of the remaining
media capacity on or off.

TLCS Mode On/Off Turns the indication of the TLCS
operating mode on or off.

Focus Mode On/Off Turns the indication of the focus
operating mode on or off.

‘White Balance On/Off Turns the indication of the white

Mode balance mode on or off.

Filter Position On/Off Turns the indication of the ND filter
setting on or off.

Iris Position On/Off Turns the indication of the iris position
on or off.

Gain Setting On/Off Turns the indication of the gain setting
on or off.

Shutter Setting On/Off Turns the indications of the shutter
mode and shutter speed on or off.

Color Temp On/Off Turns the indication of the color
temperature on or off.

Video Format On/Off Turns the indication of the video format
on or off.

System Line On/Off Turns the indication of the system lines
on or off.

Rec Mode On/Off Turns the indication of special recording
modes (S&Q, Interval, Frame Rec,
Picture Cache Rec) on or off.

Extender On/Off Turns the lens extender indication on or
off.

WRR RF Level On/Off Turns the indication of the digital
wireless receiver reception level on or
off.

Clip Number(PB)  On/Off Turns the indication of clip information

on or off.

Menu List
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Menu items

Sub-item

Settings

Description

“"LED

Gain<!>

On/Off

Turns on or off the function to light the !
indicator when the gain is set to other
than 0 dB.

Shutter <!>

On/Off

Turns on or off the function to light the !
indicator when the SHUTTER selector
is set to ON.

‘White Preset <!>

On/Off

Turns on or off the function to light the !
indicator when the WHITE BAL switch
is set to PRST.

ATW Run <!>

On/Off

Turns on or off the function to light the !
indicator when White Setting >White
Switch<B> is set to [ATW].

Extender <!>

On/Off

Turns on or off the function to light the !
indicator when the lens extender is used.

Iris Override <!>

On/Off

Turns on or off the function to light the !
indicator when the reference value of
auto iris adjustment is not the standard
value.

Auto Iris
Makes settings
related to auto iris.

Iris Override

On/Off

Turns iris override (a setting that opens
or closes the iris more than normal) on
or off.

Iris Speed

—99 to +0 to +99

Specifies the iris control speed (speed of
reaction to changes in the video).
(Larger values specify quicker reaction
times.)

Clip High light

On/Off

Turns on or off the function that
disregards highlights and forces a flatter
reaction to high luminance.

Iris Window

1/2/3/4/5/6/Var

Selects the auto iris detection window

type.
Var: Variable

Iris Window
Indication

On/Off

Turns the indication of the auto iris
detection window frame on or off.

Menu List



Menu items

Sub-item

Settings

Description

White Setting
Makes settings
related to auto white
balance adjustments.

White Switch<B>

Memory/ATW

Specifies the operating mode selected
by the B position of the WHITE BAL
switch.

Memory: Auto white balance

ATW: Auto tracing white balance

Shockless White

Off/1/2/3

Specifies the reaction speed when the
WHITE BAL switch setting is changed.
Off is an instant reaction, and 1 is faster
than 2 or 3.

ATW Speed

1/2/3/4/5

Specifies the reaction speed when the
White Switch<B> setting is [ATW]. 1 is
the fastest reaction.

AWRB Fixed Area

On/Off

Specifies whether auto white balance is

executed at the center of the screen.

On: Execute in an area corresponding
to 25% of the height and width of
the screen.

Off: Execute in an area corresponding
to 70% of the height and width of
the screen.

Filter White
Memory

On/Off

Specifies whether to allocate a white
balance memory area for each FILTER
knob position.

On: Allocation a white balance memory
area for each FILTER knob
position.

Off: Use A/B memory regardless of the
filter position.

Menu List
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Menu items

Sub-item

Settings

Description

Offset White
Makes settings
related to white
balance offset values.

Offset White <A>

On/Off

Specifies whether to add (On) or not to
add (Off) an offset value to the white
balance value in memory A.

‘Warm Cool <A>

Approximate color
temperature

When the setting of Offset White<A> is
[On], specifies (as a color temperature)
the offset to add to the white balance
value in memory A. (Note that the error
range becomes larger for higher offset
color temperatures. Adjust while
viewing the actual video.)

‘Warm Cool
Balance<A>

-99 to +0 to +99

Specifies a more precise color
temperature, for use when satisfactory
video cannot be obtained with the Warm
Cool <A> setting.

Offset White <B>

On/Off

‘When this is set to [On], the offset
adjusted set with this item is added to
the white balance of channel B.

‘Warm Cool <B>

Approximate color

When the setting of Offset White<B> is

temperature [On], specifies (as a color temperature)
the offset to add to the white balance
value in memory B. (Note that the error
range becomes larger for higher offset
color temperatures. Adjust while
viewing the actual video.)

‘Warm Cool -99 to 0 to +99 Specifies a more precise color

Balance<B> temperature, for use when satisfactory

video cannot be obtained with the Warm
Cool <B> setting.
Shutter Shutter Select Second/Degree Specifies the unit used to select shutter
Makes settings speeds.
related to the shutter Second: Select in units of seconds.
setting. Degree: Select in units of degrees.

Slow Shutter On/Off Turns the SLS mode on or off.

SLS Frames 2Frames/3Frames/ Selects the number of accumulated
4Frames/Frames/ frames in SLS mode.
6Frames/7Frames/
8Frames/16Frames

Time Zone Zone —12:00to +0:00 to +14:00 Specifies a difference from UTC

Specifies the time
zone.

(in steps of 30 minutes)

(Greenwich Mean Time) in units of
30 minutes.

Menu List



Menu items

Description

Clip

Make settings for clip
name or clip
management.

(F%5%:0001~4999)

In UDF mode, selects the clip naming

format.

C##xk; XDCAM standard name

Title: User-specified name or title
specified by Title Prefix

Do not assign clip
names that begin with
the “.” (period)
symbol.

Clips with names in
which the first
characteris “.” cannot
be viewed on the
application software
for computers.

Specifies the title part (4 to 46
alphanumeric characters) of clip titles.
‘When the currently specified title is
eight characters or fewer in length, the
entire title appears. When the title is
longer than eight characters, the first
seven characters appear and a *“---”
symbol appears in place of the eighth
character.

Displays the Character Set screen.

Character Set screen configuration

¢ Character selection area (three lines)

Select the character to insert at the title

prefix cursor position.

#$%()+.-.;=@[]"_~0123456789

abcdefghijklmnopgrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ

 Cursor operation area (one line)

Space: Changes the character at the
cursor position to a space

INS: Inserts a space at the cursor
position

DEL: Deletes the character at the cursor
position

<«—: Moves the cursor to the left

—: Moves the cursor to the right

ESC: Cancels the change and return to
the normal menu

END: Executes the change and return to
the normal menu

« Title prefix area (one line)

An area to enter the title

To set titles

1 Turn the MENU knob or press the
arrow buttons to select a character,
highlighting it, in the character
selection area, and then press the
MENU knob or the SET button to
insert it at the cursor position in the
title prefix area. (The cursor moves to
the right.)

2 Repeat step 1 to add more characters
to the title (using Space, INS, and
DEL as required).

3 When you have finished entering the
title, select END to close the
Character Set screen.

Menu List
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Menu items Sub-item Settings Description
Clip Number Set 0001 to 9999 Specifies the initial value of the numeric
Make settings for clip part (four digits) of clip names.
name or clip Update Media<A>/Media<B> Updates the management files on the
management. media in the selected slot (execute by
selecting Execute).
a) When the optional CBK-HDO2 is installed
PAINT Menu
Menu items Sub-item Settings Description
Switch Status Gamma On/Off Turns gamma correction on or off.
Turns various signal ~ Black Gamma On/Off Turns black gamma correction on or
correction functions off.
and a test signal on or - - - -
off. Matrix On/Off Turns linear matrix correction and
user matrix correction on or off.
Knee On/Off Turns knee correction on or off.
White Clip On/Off Turns white clip correction on or
off.
Detail On/Off Turns detail correction on or off.
Aperture On/Off Turns aperture correction on or off.
Flare On/Off Turns flare correction on or off.
Test Saw On/Off Turns the test saw signal on or off.
White Color Temp <A> 1500K to 3200K to Displays the white balance color
Sets the color 50000K temperature saved in memory A.
temperature, and "G50 Temp BAL -99 to +0 to +99 Specifies the white balance gain
Eeﬁorms n.]ar‘mal white <A> values saved in memory A (linked R
alance adjustment. X X
gain and B gain).
R Gain <A> -99 to 0 to +99 Specifies the white balance R gain
value saved in memory A.
B Gain <A> -99 to 0 to +99 Specifies the white balance B gain
value saved in memory A.
Color Temp <B> 1500K to 3200K to Displays the white balance color
50000K temperature saved in memory B.
Color Temp BAL -99 to 0 to +99 Specifies the white balance gain
<B> values saved in memory B (linked R
gain and B gain).
R Gain <B> -99 to 0 to +99 Specifies the white balance R gain
value saved in memory B.
B Gain <B> -99 to 0 to +99 Specifies the white balance B gain

value saved in memory B.

Menu List



PAINT

Menu items Sub-item Settings Description

Black Master Black —99 to 0 to +99 Specifies the master black level.

Specifies the black R Black -99 to 0 to +99 Specifies the R black level.

level (level of the B Black 299 t0 20 to +99 Specifies the B black level.

unilluminated parts of

the video).

You can achieve a

desired look by

adjusting the black

level for deeper or

shallower blacks.

Flare Flare On/Off Turns flare correction on or off.

Makes settings related  Master Flare -99 to 0 to +99 Sets the master flare correction

to flare. level.

Flare is light generated -

from a bright image R Flare -99 to 0 to +99 Sets the R flare correction level.

region that spreads G Flare -99 to 0 to +99 Sets the G flare correction level.

broadly across the B Flare -99 to 0 to +99 Sets the B flare correction level.

image, adding light to

dark regions and

reducing contrast. It is

caused by reflection

inside the lens system.

Gamma Gamma On/Off Turns gamma correction on or off.

Makes settings related ~ Step Gamma 0.35 to 0.45 to 0.90 (0.05 Specifies a gamma correction value

{o gamma. step) in steps of 0.05

Gamma correction - - - —— — - -

allows you to Master Gamma -99 to +0 to +99 Specifies the master gamma level.

significantly alter the R Gamma -99 to 0 to +99 Specifies the R gamma level.

iq:lpreisiondmaQe by}:he G Gamma -99 to £0 to +99 Specifies the G gamma level.
adjusting t —

viceo by adjusting ¢ B~ Gamma —99 to 0 to +99 Specifies the B gamma level.

contrast.

Gamma Select

The available settings
vary depending on the
setting in Gamma
Category (see
“Description”).

Select the gamma table to use in

gamma correction.

When Gamma Category is STD:

1 DVW: DVW camcorder
equivalent

2 x4.5: x4.5 gain

3 x3.5: x3.5 gain

4 240M: SMPTE-240M equivalent

5 R709: ITU-R709 equivalent
(default setting)

6 x5.0: x5.0 gain

When Gamma Category is HG:

13250: Condense 325% video input
to 100% video output

2 4600: Condense 460% video input
to 100% video output

3 3259: Condense 325% video input
to 109% video output

4 4609: Condense 460% video input
to 109% video output (default
setting)

Gamma Category

STD/HG

Selects use of standard gamma
(STD) or HyperGamma (HG).

Menu List
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PAINT

Menu items Sub-item Settings Description
Black Gamma Black Gamma On/Off Turns black gamma correction on or
Makes settings related off.
to blacl'( gamma Gamma Level -99 to 0 to +99 Specifies the master black gamma
correction.
Black gamma level.
correction allows you ~ Range Low/L.Mid/H.Mid/High Selects the black gamma correction
to reproduce gradations effective range.
and color nuances in LOW: 0 to 3.6%
black or near-black L.MID: 0 to 7.2%
(dark) parts of the
picture. H.MID: 0 to 14.4%
HIGH: 0 to 28.8%
Knee Knee On/Off Turns knee correction on or off.
Makes settings related  Knee Point 50.0% to 95.0% to Specifies the knee point.
to knee correction. 109.0%
Knee correction is =
processing that Knee Slope -99 to +0 to +99 Specifies the knee slope.
prevents washout by Knee Saturation On/Off Turns the knee saturation function
compressing the bright on or off.
parts O.f the video Knee Saturation -99 to 0 to +99 Specifies the knee saturation level.
according to an upper
limit for the dynamic ~ L€Vel
range of the recorded
and output picture. The
signal level where knee
processing begins is
called the “knee point”,
and the slope of knee
compression is called
the “knee slope”.
White Clip White Clip On/Off Turns white clipping adjustment on
Makes settings related or off.
to white clipping Level NTSC Area is selected  Specifies the white clip level.
adjustments. for Country
White clipping is

processing that limits
the maximum level of
video output signals.
The maximum video
signal output value is
called the “white clip
level”.

90.0% to 108.0% to
109.0%

PAL Area is selected for
Country

90.0% to 105.0% to
109.0%

Menu List



PAINT

Menu items Sub-item Settings Description
Detail(HD Mode)/ Detail On/Off Turns detail adjustment on or off.
Detail(SD Mode) Level -99 to +0 to +99 Specifies the detail level.
Makes settings related  "H/y Ratio -99 to 0 to +99 Specifies the mix ratio between the
Eg ffﬁalfoi?ﬁ?;g s H detail level and the V detail level.
mode. Crispening —99 to 0 to +99 Specifies the crispening level.
Detail adjustment is Level Depend On/Off Turns the level depend adjustment
processing ‘ha} . function on or off.
1&":,?;:3 g;? aL ;:?ntg of Level Depend Level —99 to +0 to +99 Specifies the level depend level.
detail signals to the Frequency -99 to 0 to +99 Specifies the central frequency for H
edges of the subject. detail signals. Larger values give
finer details.
Knee Aperture On/Off Turns the knee aperture function on
or off.
Knee Aperture Level —99 to 0 to +99 Specifies the knee aperture level.
Limit -99 to 0 to +99 Specifies the detail limiter values for
both the white-side and black-side
direction.
White Limit -99 to 0 to +99 Specifies the white-side detail
limiter value.
Black Limit —99 to 0 to +99 Specifies the black-side detail
limiter value.
V-BLK Limit —99 to 0 to +99 Specifies the black-side V detail
limiter value.
V Detail Creation NAM/G/R+G/Y Selects the source signal used to
generate the V detail signal.
NAM: AV detail signal created
from the R signal, or a V detail
signal created from the G
signal, or a V detail signal
created from the B signal,
whichever is the signal with the
highest level
G: G signal
G+R: Composite signal comprising
the G signal and R signal in a
1:1 ratio
Y: Y signal
Aperture Aperture On/Off Turns aperture correction on or off.
Makes settings related L evel -99 to +0 to +99 Sets the aperture level.

to aperture correction.
Aperture correction is
processing to improve
resolution by adding
high-frequency
aperture signals to the
video signal, which
corrects degeneration
due to high-frequency
characteristics.

Menu List
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PAINT

Menu items

Sub-item

Settings

Description

Skin Detail
Makes settings related

Skin Detail

On/Off

Turns skin detail correction on or
off.

to skin detail
correction.
Skin detail correction is

Area Detection

Color detection screen

Detects the color to be targeted by
skin detail correction.

processing that Area Indication On/Off Turns on or off the function that
increases or decreases displays a zebra pattern in the area
the detail level of a targeted by skin detail correction.
spegﬁed color Ange Y evel -99 to 0 to +99 Specifies the skin detail level.
(skin tone range), for
the purpose of Saturation -99 to 0 to +99 Specifies the saturation of the color
obtaining attractive targeted by skin detail correction.
:eproductlon of skin - Fye 0 to 359 Specifies the hue of the color
ones. targeted by skin detail correction.
Width 0 to 40 to 90 Specifies a range for the hue of the
color targeted by skin detail
correction.
Matrix Matrix On/Off Turns the matrix correction function
Makes settings related on or off.
{o matrix correction.  “preget Matrix On/Off Turns the preset matrix function on
Matrix correction
. or off.
allows you to adjust the
color and vividness of ~ Preset Select 1/2/3/4/5/6 Selects a preset matrix.
the video. Depending 1: SMPTE-240M equivalent
on the effect you want, 2: ITU-709 equivalent
you can select one from 3: SMPTE WIDE equivalent
among a number of 4: NTSC wval
preset matrixes, which : eq}llva ent
define different 5: EBU equivalent
parameter sets. Or you 6: PAL equivalent
can select a user matrix “{jser Matrix On/Off Turns the user matrix function on or
with your own
off.
parameters. - v "
User Matrix R-G —99 to 0 to +99 Specifies a freely defined R-G user
matrix.
User Matrix R-B -99 to +0 to +99 Specifies a freely defined R-B user
matrix.
User Matrix G-R —99 to 0 to +99 Specifies a freely defined G-R user
matrix.
User Matrix G-B -99 to 0 to +99 Specifies a freely defined G-B user
matrix.
User Matrix B-R -99 to 0 to +99 Specifies a freely defined B-R user
matrix.
User Matrix B-G —99 to 0 to +99 Specifies a freely defined B-G user
matrix.
Menu List



PAINT

Menu items Sub-item Settings Description

Multi Matrix Multi Matrix On/Off Turns the multi matrix correction
Makes settings related function on or off.

to multi matrix Area Indication On/Off Turns on or off the function that

correction.
Multi-matrix correction
allows specific colors
to be selected for
saturation correction in
a 16-axis hue space.

displays a zebra pattern in the color
area targeted by multi matrix
correction.

Color Detection

Color detection screen

Detects colors targeted by multi
matrix correction.

Axis B/B+/MG-/MG/MG+/ Specifies a color targeted by multi
R/R+/YL-/YL/YL+/G-/ matrix correction (16-axis mode)
G/G+/CY/CY+/B-
Hue —99 to 0 to +99 Specifies the hue of the color
targeted by multi matrix correction
for each 16-axis mode.
Saturation —99 to 0 to +99 Specifies the saturation of the color
targeted by multi matrix correction
for each 16-axis mode.
'V Modulation V Modulation On/Off Turns V modulation shading on or
Makes settings related off.
to V- modulation Master V -99 to =0 to +99 Specifies the master V modulation
shading. Modulation level
V modulation shading odulatio cvel.
corrects vertical R V Modulation -99 to +0 to +99 Specifies the V modulation level of
imbalances in R signals.
sensitivity arising from "GN Modulation —99 to +0 to +99 Specifies the V modulation level of
the relationship G sienals
between a lens and _ 51%“_‘{ s _
prism. B V Modulation -99 to £0 to +99 Specifies the V modulation level of

B signals.
Low Key Saturation Low Key Saturation On/Off Turns low key saturation correction
Makes settings related on or off.
to low key saturation Yoy —99 to +0 to +99 Specifies the saturation of colors in
correction. .

low luminance areas.
You can correct the
saturation of colors in ~ Range Low/L.Mid/H.Mid/High Specifies the luminance level for
dark parts of the video which low key saturation is enabled.
only.
Noise Suppress Noise Suppress On/Off Turns noise suppression on or off.

Makes settings related
to noise suppression
(noise compression).
You can effectively
suppress noise
components while
preserving fine edge
components in the
subject.
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MAINTENANCE Menu

MAINTENANCE

Menu items Sub-item Settings Description

White Shading Channel Select Red/Green/Blue Selects the target of white shading

Makes settings related correction.

to white shading. R/G/B White H Saw —99 to 20 to +99 Specifies a SAW white shading

White shading is . .

required for cach C(.>rrec't10n value for the horizontal

different lens to correct direction.

irregularities arising R/G/B White H Para —99 to +0 to +99 Specifies a parabola white shading

from lens correction value for the horizontal

characterlstl?s. It direction.

corrects luminance and

color irregularities in R/G/B White V Saw  —99 to +0 to +99 Specifies a SAW white shading

bright areas. correction value for the vertical
direction.

R/G/B White V Para —99 to +0 to +99 Specifies a parabola white shading
correction value for the vertical
direction.

White Saw/Para On/Off Turns the white shading SAW and
parabola correction functions on or
off.

Black Shading Channel Select Red/Green/Blue Selects the target of black shading

Makes settings related correction.

to black shading R/G/B Black H Saw —99 to 20 to +99 Specifies a SAW black shading

CB(i,rr\ethO,n'. . correction value for the horizontal
ack shading is o

required for each direction.

different lens to correct R/G/B Black H Para -99 to +0 to +99 Specifies a parabola black shading

irregularities arising correction value for the horizontal

from lens. . direction.

characteristics. It — -

corrects luminance and R/G/B Black V Saw 99 to 0 to +99 Specifies a SAW black shading

color irregularities in correction value for the vertical

dark areas. direction.

R/G/B Black V Para  —99 to +0 to +99 Specifies a parabola black shading
correction value for the vertical
direction.

Black Saw/Para On/Off Turns the black shading SAW and
parabola correction functions on or
off.

Master Black —99 to 0 to +99 Specifies the master black level.

Master Gain (TMP) —-6dB/-3dB/0dB/3dB/ Specifies a temporary master gain

6dB/9dB/12dB/18dB/ value. (The value is the same as the
24dB/30dB/36dB/42dB  value selected with the GAIN

switch.)

Battery
Makes settings related
to batteries.

Info Before End 5%110%/15%...95%/ Specifies a threshold value that
100% triggers a “Battery Near End”
warning when a BP-GL65/GL95
battery pack is used.
Info End 0%/1%/2%/3%/4%/5%  Specifies a threshold value that

triggers a “Battery End” warning
when a BP-GL65/GL95 battery
pack is used.

Menu List



MAINTENANCE

Menu items Sub-item

Settings

Description

Battery Sony Before End
Makes settings related

to batteries.

11.5V to 17V (0.1V step)

Specifies a threshold value that
triggers a “Battery Near End”
warning when a BP-L60S/L80S
battery pack is used.

Sony End

11.0V to 11.5V (0.1V
step)

Specifies a threshold value that
triggers a “Battery End” warning
when a BP-L60S/L80S battery pack
is used.

Other Before End

11.5V to 11.8V to 17.0V
(0.1V step)

Specifies a threshold value that
triggers a “Battery Near End”
warning when a non-Sony battery
pack is used.

Other End

11.0V to 14.0V (0.1V
step)

Specifies a threshold value that
triggers a “Battery End” warning
when a non-Sony battery pack is
used.

DC In Before End

11.5V to 11.8V to 17.0V
(0.1V step)

Specifies a threshold value that
triggers a “Battery Near End”
warning when an external power
source is connected to the DC IN
connector.

DC In End

11.0V to 14.0V (0.1V
step)

Specifies a threshold value that
triggers a “Battery End” warning
when an external power source is
connected to the DC IN connector.

Detected Battery Info/Sony/Other/DC IN  Displays the results of automatic
battery pack type detection.
Type Detection Auto/Other Auto: Detect the battery type

automatically.
Other: Fix battery type detection as
“Other”.

Segment No.10

11.0V to 17.0V (0.1V

step)

Segment No.9 11.0V to 16.0V to 17.0V
(0.1V step)

Segment No.8 11.0V to 15.0V to 17.0V
(0.1V step)

Segment No.7 11.0V to 14.0V to 17.0V
(0.1V step)

Segment No.6 11.0V to 13.5V to 17.0V
(0.1V step)

Segment No.5 11.0V to 13.0V to 17.0V
(0.1V step)

Segment No.4 11.0V to 12.5V to 17.0V
(0.1V step)

Segment No.3 11.0V to 12.0V to 17.0V
(0.1V step)

Segment No.2 11.0V to 11.5V to 17.0V
(0.1V step)

Segment No.1

11.0V to 17.0V (0.1V
step)

Specify voltage threshold values
that cause remaining capacity
segments to go off in the display of
remaining battery capacity (see
page 28). (The segments go off
below the specified value.)

These values are used when the
battery type has been found to be
“Other”.
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MAINTENANCE

Menu items

Sub-item

Settings

Description

Audio
Makes settings related
to audio.

Front MIC Select

Mono/Stereo

Selects whether the front
microphone is monaural (Mono) or
stereo (Stereo).

Audio CH3/4 Mode

Ch1/2 / Switch

Selects the input signals for the

AUDIO IN CH-3/CH-4 connectors.

Ch1/2: The same signals as the
AUDIO IN CH-1/ CH-2
connectors.

Switch: The signals selected with
the AUDIO IN CH3/CH4
switches.

Rear XLR Auto

On/Off

Turns on or off the XLR connection
automatic detection (for the AUDIO
IN CH-1/CH-2 connectors on the
rear panel).

Front MIC CH1 Ref

—70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Selects the reference level for
channel 1 of the front microphone.

Front MIC CH2 Ref

—~70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Selects the reference level for
channel 2 of the front microphone.

Rear MIC CHI1 Ref

—70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Selects the reference input level
when the setting of the AUDIO IN
CHI1 switch is MIC.

Rear MIC CH2 Ref —70dB/-60dB/-50dB/ Selects the reference input level
-40dB/-30dB/-20dB when the setting of the AUDIO IN
CH2 switch is MIC.
Line Input Ref +4dB/0dB/-3dB/EBUL  Selects the reference input level

when the AUDIO IN CH1 and
AUDIO IN CH2 switches are set to
LINE.

Min Alarm Volume

Off/Set

Selects the volume when the
ALARM knob is turned all the way
down.

Off: Almost inaudible

Set: Fairly audible

Speaker Attenuate

Off/3dB/6dB/9dB/12dB

Selects the volume from the monitor
speakers (does not affect earphone
volume).

Headphone Out

Mono/Stereo

Selects whether the earphones are
monaural (Mono) or stereo (Stereo).

Reference Level

—20dB/-18dB/-16dB/
—12dB/EBUL

Selects the output level of the 1 kHz
test signal.

Reference Out

0dB/+4dB/-3dB/EBUL

Specifies the output level with
respect to the reference input level.

CH1&2 AGC Mode

Mono/Stereo

For automatic adjustment of the
input level of analog audio signals
recorded on channels 1 and 2,
specifies whether to make the
adjustments separately for each
channel (Mono) or in stereo mode
(Stereo).

Menu List
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Menu items

Sub-item

Settings

Description

Audio
Makes settings related
to audio.

CH3&4 AGC Mode

Mono/Stereo

For automatic adjustment of the
input level of analog audio signals
recorded on channels 3 and 4,
specifies whether to make the
adjustments separately for each
channel (Mono) or in stereo mode
(Stereo).

AGC Spec —-6dB/-9dB/-12dB/ Selects the AGC saturation level.
—15dB/-17dB
Limiter Mode Off/-6dB/-9dB/-12dB/  For manual audio level adjustments,
—15dB/-17dB selects the saturation level for the
limiter applied to loud input signals.
Select Off if you do not wish to use
the limiter.
Output Limiter On/Off Turns the audio output limiter on or
off.
CH1 Wind Filter On/Off Turns the channel 1 wind filter on or
off.
CH2 Wind Filter On/Off Turns the channel 2 wind filter on or
off.
CH3 Wind Filter On/Off Turns the channel 3 wind filter on or
off.
CH4 Wind Filter On/Off Turns the channel 4 wind filter on or
off.
Audio SG (1KHz) On/Off/Auto Selects whether to output (On) or

not output (Off) a 1 kHz test signal

in color bar mode.

Auto: Output a test signal only
when the AUDIO SELECT
CHI1 switch is set to AUTO.

MIC CHI Level

Sidel/Front/Front+Sidel

For recording input audio from the

front microphone on channel 1,

selects the knob that adjusts the

audio level.

Sidel: The LEVEL knob (left) on
the side panel

Front: The MIC LEVEL control on
the front panel

Front+Sidel: Adjust with both the
LEVEL knob (left) and the
MIC LEVEL control.

MIC CH2 Level

Side2/Front/Front+Side2

For recording input audio from the

front microphone on channel 2,

selects the knob that adjusts the

audio level.

Side2: The LEVEL knob (right) on
the side panel

Front: The MIC LEVEL control on
the front panel

Front+Side2: Adjust with both the
LEVEL knob (right) and the
MIC LEVEL control.

Menu List
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MAINTENANCE

Menu items

Sub-item

Settings

Description

Audio
Makes settings related
to audio.

Rearl/WRR Level

Sidel/Front/Front+Sidel

Selects the knob that adjusts the

audio levels of a wireless

microphone and a device connected

to the AUDIO IN CH-1 connector

on the rear panel.

Sidel: The LEVEL knob (left) on
the side panel

Front: The MIC LEVEL control on
the front panel

Front+Sidel: Adjust with both the
LEVEL knob (left) and the
MIC LEVEL control.

Rear2/WRR Level

Side2/Front/Front+Side2

Selects the knob that adjusts the

audio levels of a wireless

microphone and a device connected

to the AUDIO IN CH-2 connector

on the rear panel.

Side2: The LEVEL knob (right) on
the side panel

Front: The MIC LEVEL control on
the front panel

Front+Side2: Adjust with both the
LEVEL knob (right) and the
MIC LEVEL control.

Audio CH3 Level

Side3/Front/Front+Side3

Selects the knob that adjusts the

level of audio recorded on channel

3.

Side3: The LEVEL knob on side
panel

Front: The MIC LEVEL control on
the front panel

Front+Side3: Adjust with both the
LEVEL knob and the MIC
LEVEL control.

Audio CH4 Level

Sided/Front/Front+Side4

Selects the knob that adjusts the

level of audio recorded on channel

4.

Side4: The LEVEL knob on side
panel

Front: The MIC LEVEL control on
the front panel

Front+Side4: Adjust with both the
LEVEL knob and the MIC
LEVEL control.

Menu List
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Menu items

Sub-item

Settings

Description

WRR Setting
Makes settings related
to the wireless tuner.

WRR Valid CH Sel

All/CHI

Selects whether to enable channels 1
and 2 of the wireless receiver (All)
or channel 1 only (CH1).

WRR CH Select

TX1/TX2

Specifies the target channel for other
sub-items.

TX1: Channel 1

TX2: Channel 2

WRR Delay Comp

On/Off

Enables (On) or disables (Off) delay
compensation for wireless audio
input. (When On is selected, the
audio in all E-E output is delayed by
about 8 ms.)

TX

Displays the name of the transmitter
whose signals are being received on
the channel selected by WRR CH
SELECT.

TX Audio Peak

---/Peak

Displays whether the AF level of the
transmitter whose signals are being
received on the channel selected by
WRR CH SELECT are over peak.

TX Input Level

---/Mic/Line

Displays whether the input level of
the transmitter whose signals are
being received on the channel
selected by WRR CH SELECT is
set to microphone (Mic) or line
(Line).

TX ATT Level

Sets the ATT level of the transmitter
whose signals are being received on
the channel selected by WRR CH
SELECT. (The setting range varies
depending on the transmitter.)

TX LCF Frequency

Sets the low cut filter frequency of
the transmitter whose signals are
being received on the channel
selected by WRR CH SELECT.
(The setting range varies depending
on the transmitter.)

TX System Delay

Auto/0.0ms to 8.0ms

Specifies the amount of audio delay.

Auto: Automatically adjusts the
amount of delay so that the
delay in the audio received
from the wireless transmitter is
zero.

0.0ms to 8.0ms: Sets the amount of
anticipated wireless system
delay, for cases in which
several wireless systems are
being used over a devices such
as an audio mixer.

Menu List
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Menu items Sub-item Settings Description

Timecode TC Out Auto/Generator Selects the source for timecode
Makes settings related output.

to timecode. Auto: During recording, output

values generated by the
timecode generator, and during
playback output values
obtained by the timecode
reader.

Generator: Output values
generated by the timecode
generator during both recording
and playback.

DF/NDF DF/NDF When the Country setting is other
than PAL Area, selects drop-frame
mode (DF) or non-drop-frame mode
(NDF).

LTC UBIT Fix/Time Specifies the data recorded in LTC
user bits.
Fix: Record user-specified data.
Time: Record the current time.

Counter Display Counter/Duration Select the method used to reset the
counter value displayed on the
viewfinder screen.

Counter: Continue to increment
until the RESET button is
pressed.

Duration: Reset each time that
recording is started.

Rec Start: The next frame or the
previous frame where a Rec
Start essence mark is set.

Clip: Pressing the NEXT button
moves to the start frame of the
next clip. Pressing the PREV
button moves to the start frame
of the current clip. (Pressing the
PREV button at the start frame
of the current clip moves to the
start frame of the previous
clip.)

Essence Mark Ret Shot Mark 1 On/Off Specify whether to input Shot
9 Makes settings related Mark1 marks using the RET button
g Fo shot mmks and clip on the lens.
o Eﬁf;(bﬂfit]gre Ret Shot Mark 2 On/Off Specify whether to input Shot
@ ' Mark2 marks using the RET button
% on the lens.
=}
c Index Pic Pos Osec to 10sec (in 1 sec Specifies which frame to use as the
§ steps) clip thumbnail image
|} Find Mode Clip/Rec Start Specify the frame to be cued up
) when the PREV or NEXT button is
cg pressed.
w
®
%’.
Q
[

124 | Menu List



MAINTENANCE

Menu items

Sub-item

Settings

Description

Camera Config
Makes settings related
to various camcorder
operations.

Rec Tally Blink

On/Off

Turns warning flashes by the
TALLY indicator on or off. The
warnings alert you an almost
exhausted battery pack or low
remaining media capacity.

Rec Review

3sec/10sec/Clip

Selects the recording review time.
Clip: Review all of the most
recently recorded clip.

HD SDI Remote I/F

Off/Chara/G-Tally/
R-Tally

Selects whether to use the function
that enables recording control from
this camcorder of an external device
connected to the HD/SD SDI OUT
connector (HDSDI output). When
the function is used, also selects the
indication that shows whether the
external device is recording.

Off: Do not use the remote
recording control function.

Chara: Indicate by the remote
device indication in the
viewfinder screen.

G-Tally: Indicate by the TALLY
indicator in the viewfinder
(green tally).

R-Tally: Indicate by the REC
indication (recording/Rec tally)
on the viewfinder screen.

Color Bars Select ARIB/100%/75% Selects the color bar type.

RM Common On/Off Selects whether to share (On) or not

Memory share (Off) settings between times
when a remote control unit is
connected and times when the
camcorder is used locally.

RM Rec Start RM/CAM/PARA For times when a remote control

unit is connected, selects whether
recording start/stop buttons are
enabled on the camcorder or the
remote control unit.

RM: Remote control unit

CAM: Camcorder

PARA: Both

Menu List
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MAINTENANCE

Menu items Sub-item Settings Description
Preset White Color Temp<P> 1500K to 3200K to Specifies the white balance preset
Makes settings related 50000K value.
to white balance preset "G lor Temp -99 to +0 to +99 Specifies finer color temperature
values. Balance<P> settings, for use when satisfactory
video cannot be obtained with Color
Temp<P>.
R Gain <P> —99 to 0 to +99 Specifies the R gain preset value.
B Gain <P> -99 to 0 to +99 Specifies the B gain preset value.
AWB Enable <P> On/Off Turns on and off execution of the
AWB (auto white balance) function
when the WHITE BAL switch is set
to PRST.
White Filter ND Filter On/Off Turns the function that assigns
Makes settings related  C.Temp electrical CC filters to ND filters on
to filters. or off.
ND FLT 3200K/4300K/5600K/ Selects the color temperature for
C.Temp<1> 6300K when electrical CC filters are
assigned to ND filters.
ND FLT 3200K/4300K/5600K/ Selects the color temperature for
C.Temp<2-4> 6300K when electrical CC filters are
assigned to ND filters.
Electrical 3200K/4300K/5600K/ Selects the color temperature for
CC<A> 6300K when the electrical CC filter
switching function is assigned to an
assignable switch.
Electrical 3200K/4300K/5600K/ Selects the color temperature for
CC<B> 6300K when the electrical CC filter
switching function is assigned to an
assignable switch.
Electrical 3200K/4300K/5600K/ Selects the color temperature for
CC<C> 6300K/----- when the electrical CC filter
switching function is assigned to an
assignable switch.
Select “----" if you do not want to
use C.
Electrical 3200K/4300K/5600K/ Selects the color temperature for
CC<D> 6300K/----- when the electrical CC filter

switching function is assigned to an
assignable switch.

Select “----" if you do not want to
use D.

Menu List
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Menu items Sub-item

Settings

Description

DCC Adjust DCC Function Select DCC/Fix

Makes settings related
to DCC (dynamic
contrast control).

Enables or disables automatic knee
point adjustment when the
OUTPUT/DCC switch is set to
CAM, DCC: ON.

DCC: Automatically adjust the
knee point according to the
luminance of the subject.

Fix: Set the knee point to a fixed
value.

DCC D Range

400%/450%/500%/
550%/600 %

Specifies the dynamic range when
the OUTPUT/DCC switch is set to
CAM, DCC: ON.

DCC Point

-99 to +0 to +99

Adjusts the DCC minimum knee
point.

DCC Gain

-99 to +0 to +99

Specifies gain with respect to the
DCC detected value.

DCC Delay Time

—99 to 0 to +99

Specifies the DCC control speed
(speed of reaction to changes in the
video).

DCC Peak Filter

—99 to 0 to +99

Adjusts response sensitivity with
respect to peaks in DCC detected
values.

Menu List
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MAINTENANCE

Menu items

Sub-item

Settings

Description

Auto Iris2
Makes settings related
to auto iris.

Iris Window

1/2/3/4/5/6/Var

Selects the type of iris detection
window.
Var: Variable

Iris Window Ind

On/Off

Turns on or off the function that
displays a frame marker for the auto
iris detection window.

Iris Level

—99 to 0 to +99

Adjusts the level of the auto iris
target value.

Iris APL Ratio

—99 to 0 to +99

Adjusts the mix ratio of auto iris
detection peak value and average
value.

Iris Var Width

40 to 500 to 999

Adjusts the width of the detection
window when the setting of Iris
Window is VAR.

Iris Var Height

70 to 500 to 999

Adjusts the height of the detection
window when the setting of Iris
Window is VAR.

Iris Var H Position

—479 to 0 to +479

Specifies the horizontal position of
the detection window when the
setting of Iris Window is VAR.

Iris Var V Position

—464 to 0 to +464

Specifies the vertical position of the
detection window when the setting
of Iris Window is VAR.

Iris Speed

-99 to +0 to +99

Specifies the control speed (speed of
reaction to changes in the video).
(Larger values specify quicker
reaction times.)

Clip High Light

On/Off

Turns on or off the function that
disregards highlights and forces a
flatter reaction to high luminance.

Genlock

Makes settings related
to genlock.

Genlock

On/Off

Turns the genlock function on or off.

H Phase(HD)

-999 to £0 to +999

Specifies the H phase of HD output
when genlock is enabled.

H Phase(SD)

-99 to +0 to +99

Specifies the H phase of SD output
when genlock is enabled.

Reference

Internal/Genlock

Displays the type of reference signal
used by the camcorder.
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Menu items Sub-item Settings Description

ND Comp ND Offset Adjust On/Off ND filter color compensation

Makes settings related function.

to ND filte'r color Clear ND Offset Execute/Cancel Clears ND filter color compensation

compensation. .

Although the values (execute by selecting

differences are very Execute).

slight, each of the built-

in ND filters has

different color

characteristics. When

you switch between ND

filters, the white

balance may be

disturbed. You can

correct for these slight

color differences

automatically by

registering

compensation values

for each filter.

Lens Auto FB Adjust Execute/Cancel Executes auto flange back

Executes auto flange adjustment, only for supported

back adjustment. lenses (execute by selecting
Execute).

Auto Shading Auto Black Shading Execute/Cancel Executes auto shading

Executes auto black compensation (execute by selecting

shading compensation. Execute).

Reset Black Shading Execute/Cancel Clears black shading compensation

values (execute by selecting
Execute).

Master Gain (TMP) —-6dB/-3dB/0dB/3dB/ Specifies a temporary master gain
6dB/9dB/12dB/18dB/ value. (The value is the same as the
24dB/30dB/36dB/42dB  value selected with the GAIN

switch.)

APR APR(SLS) Execute/Cancel Suppresses white flecks in SLS
mode by executing the automatic
pixel noise reduction function
(execute by selecting Execute).

APR Preset Execute/Cancel Deletes white flecks data that was

added by execution of the APR and
automatic black balance adjustment
functions (execute by selecting
Execute).

Trigger Mode i.LINK Trigger Internal/Both/External Select Internal when recording start

Makes settings related Mode
to triggers for starting

and stopping recording.

and stop operations target SxS
memory cards only. Select External
when they target only devices
connected to the i.LINK (HDV/DV)
or HD/SD SDI OUT connectors.
Select Both when they target both
memory cards and external devices.

Menu List

sbumas pajielaq pue nus|y 9 Jaydeyn

129



sbumeg pejieleq pue nusy 9 Jsideyd

130

MAINTENANCE

Menu items Sub-item Settings Description

Clock Set Date/Time Sets the current date and time.

Sets the internal clock.  [2H/24H 12H/24H Selects the 12-hour format (12H) or
the 24-hour format (24H) for
display of times.

Date Mode YYMMDD/MMDDYY/ Selects the display format for dates.
DDMMYY YYMMDD: Year, Month, Day
MMDDYY: Month, Day, Year
DDMMYY: Day, Month Year

Language Language English/Chinese Selects the language for messages

Selects the language for from English or Chinese.

messages.

Hours Meter Hours(Sys) Displays the cumulative hours of

Makes settings related use (cannot be reset).

to the digital hours Hours(Reset) Displays the hours of use (can be

meter. reset).

Reset Execute/Cancel Resets Hours(Reset) to 0.
(Execute by selecting Execute.)

Version Version ¥ Displays the software version of the

Displays the version of camcorder (VX.XX).

the camcorder, and Version Up Execute/Cancel Updates the camcorder (execute by

updates the camcorder.

selecting Execute).

This cannot be selected unless an SxS
memory card is inserted.

a) When an optional CBK-HD02

Menu List
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FILE

Menu items Sub-item Settings Description
All Display Mode Date&Time/Model Selects the items to be displayed in
Makes settings related Name the list box that appears when a file
to ALL file operations. is saved or loaded.
All File Load Execute/Cancel Loads an ALL file (execute by
selecting Execute).
All File Save Execute/Cancel Stores an ALL file (execute by
selecting Execute).
File ID Assigns a name to a file. Names can
be up to 16 characters in length.
All Preset Execute/Cancel Return all items to their preset
values (execute by selecting
Execute).
Store All Preset Execute/Cancel Store the current settings of all items

as the preset values (execute by
selecting Execute).

Clear All Preset Execute/Cancel Clear the preset values of all items
(execute by selecting Execute).

3Sec Clr Preset On/Off Turns on or off the function that
clears each preset value when the
MENU CANCEL/PRST/ESCAPE

switch is pushed up and held for
three seconds on the CANCEL/

PRST side.
Scene 01 Standard File number and file ID
Makes settings related ]2 Standard File number and file ID
to scene file operations. "3 Standard File number and file ID Q
04 Standard File number and file ID %
Os Standard File number and file ID 2
OStandard Standard settings ;
Display Mode Date&Time/Model Selects the items to be displayed in o
Name the list box that appears when a file g
is saved or loaded. 2
Scene Recall Mem  Execute/Cancel Loads a file from internal memory g
(execute by selecting Execute). 5
Scene Store Mem Execute/Cancel Stores a file in internal memory g
(execute by selecting Execute). ®
Scene Recall SxS Execute/Cancel Loads a file from an SxS memory g
card (execute by selecting Execute). Q
Scene Store SxS Execute/Cancel Stores a file to an SxS memory card
(execute by selecting Execute).
File ID Assigns a name to a file. Names can

be up to 16 characters in length.
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FILE

Menu items Sub-item

Settings

Description

Reference Reference Store
Makes settings related

to reference file

operations.

Execute/Cancel

Stores the current settings of
reference file items in the reference
file that is maintained in internal
memory (execute by selecting
Execute).

Reference Clear

Execute/Cancel

Clear the reference file (execute by
selecting Execute).

Reference Load

Execute/Cancel

Load a reference file from an SxS
memory card (execute by selecting
Execute).

Reference Save

Execute/Cancel

Store a reference file to an SxS
memory card (execute by selecting
Execute).

File ID

Assigns a name to a file. Names can
be up to 16 characters in length.

Scene White Data

On/Off

Selects whether to load (On) or not
load (Off) white balance data when
Scene >Scene Recall or Scene
>Standard is executed.

Menu List
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Menu items Sub-item Settings Description
Lens Display Mode Date&Time/Model Selects the items to be displayed in
Makes settings related Name the list box that appears when a file
to lens file operations. is saved or loaded.
Lens Recall Mem Execute/Cancel Loads a file from internal memory
(execute by selecting Execute).
Lens Store Mem Execute/Cancel Stores a file in internal memory
(execute by selecting Execute).
Lens Recall SxS Execute/Cancel Loads a file from an SxS memory
card (execute by selecting Execute).
Lens Store SxS Execute/Cancel Stores a file to an SxS memory card
(execute by selecting Execute).
File ID Assigns a name to the most recently
loaded file. Names can be up to 16
characters in length.
Source Displays the number of the selected
file.
Lens No Offset Execute/Cancel Clears a file (execute by selecting

Execute).

Lens Auto Recall

Off/On/Serial Number

When the installed lens supports
serial communication, specifies
whether to automatically load that
reference file.

Off: Do not use this function.

On: Load the reference for the
model name and reflect the
contents of the file.

Serial Number: For lenses that
support serial number
communication, load the lens
file that corresponds to the
serial number and model name,
and reflect the contents of that
file. For lenses that do not
support serial number
communication, load the
reference for the model name
(in the same way as when On is
selected).

Serial Number

Displays the serial number of the
installed lens (only for lenses that
support serial communication).

Lens ID

Displays the model name of the
installed lens (only for lenses that
support serial communication).

L Manufacturer

Displays the name of the
manufacturer of the installed lens
(only for lenses that support serial
communication).

M V Modulation

—99 to 0 to +99

Sets a vertical SAW shading
compensation value in the lens file.

Menu List

sbumas pajielaq pue nus|y 9 Jaydeyn

133



sbumeg pejieleq pue nusy 9 Jsideyd

134

FILE

Menu items Sub-item Settings Description

Lens Lens Center H —40 to 0 to 40 Sets a center marker horizontal

Makes settings related position in the lens file.

to lens file operations. T eng'Center V —40 to 0 to 40 Sets a center marker vertical
position in the lens file.

Lens R Flare -99 to +0 to +99 Sets a R flare level in the lens file.

Lens G Flare -99 to +0 to +99 Sets a G flare level in the lens file.

Lens B Flare —99 to 0 to +99 Sets a B flare level in the lens file.

Lens W-R Offset -99 to 0 to +99 Sets a R white balance
compensation value in the lens file.

Lens W-B Offset -99 to 0 to +99 Sets a B white balance
compensation value in the lens file.

Shading Ch Sel Red/Green/Blue Selects the white shading
compensation target.

L R/G/B H Saw —99 to 0 to +99 Sets a horizontal SAW white
shading compensation value in the
lens file.

L R/G/B H Para —99 to 0 to +99 Sets a horizontal parabola white
shading compensation value in the
lens file.

L R/G/B V Saw -99 to 0 to +99 Sets a vertical SAW white shading
compensation value in the lens file.

L R/G/B V Para —99 to 0 to +99 Sets a vertical parabola white

shading compensation value in the
lens file.

Menu List



Assigning Functions to Assignable Switches

Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the
ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, and the RET
button on the lens.

The following tables lists the functions that are assigned when the camcorder is shipped from the factory.

Switch or button Function Assignable SW setting
ASSIGN. 0 switch No assignment Off

ASSIGN. 1 switch No assignment Off

ASSIGN. 2 switch No assignment Off

ASSIGN. 3 switch No assignment Off

ASSIGNABLE 4 switch  No assignment Off

ASSIGNABLE 5 switch ~ No assignment Off

RET button During recording or playback: Write a shot mark. Lens RET

In the other states: Conduct a recording review
(if playback is allowed).

COLOR TEMP. button Adjust the white balance with the preset white Color Temp SW 5600K
balance value of 5600K.

Functions That Can Be Assigned to the ASSIGN. 0 Switch

Assignable switch setting Function State when camcorder
is next powered on

Off No assignment —

Marker Turn the display of all markers on or off. Setting retained

ATW Hold Hold the white balance setting in the ATW (auto-tracking —

white balance) mode

Picture Cache Turn the picture cache function on or off. Setting retained

Freeze Mix Execute the freeze mix function. —

Focus Mag Turn the focus magnification function on or off. Setting not retained

Zebra Turn zebra display on or off. Setting not retained

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Assigning Functions to Assignable Switches
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Functions That Can Be Assigned to the ASSIGN. 2 Switch

Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the
switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2
switch or power the camcorder off and on again.

Assignable switch setting Function

Off No assignment

Front Mic Switch between stereo and monaural when a stereo microphone is connected.
Marker Turn the display of all markers on or off.

Picture Cache Turn the picture cache function on or off.

Zebra Turn zebra display on or off.

Clip Continuous Rec

Turn the Clip Continuous Rec mode on or off.

Digital Extender

Turn the screen magnification function on or off (only when the option for digital

extender is installed).

Functions That Can Be Assigned to the ASSIGN. 1 and 3 Switches, the
ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP. Button

Assignable switch setting Function

State when camcorder
is next powered on

Off No assignment —

Front Mic Switch between stereo (On) and monaural (Off) when a  Setting retained
stereo microphone is connected.

Marker Turn the display of all markers on or off. Setting retained

Last Clip Delete

Delete the most recently recorded clip.

ATW

Turn ATW (auto tracing white balance) mode on or off.

Setting not retained

ATW Hold Hold the white balance setting in the ATW mode. —

EZ Mode Execute EZ mode according to the setting of Setting retained
OPERATION >TLCS.

Turbo Gain Execute Turbo Gain according to the setting of Setting not retained
OPERATION >Gain Switch >Gain Turbo.

Rec Review Conduct a recording review. —

Rec Start or stop recording. —

Picture Cache

Turn the picture cache function on or off.

Setting retained

Freeze Mix Execute the freeze mix function. Setting not retained
Spotlight Turn the spotlight function in auto iris mode on or off.  Setting retained
Backlight Turn the backlight function in auto iris mode on or off.  Setting retained
EVF Mode Switch the viewfinder screen between B&W (On) and ~ Setting retained
color (Off).
BRT Disp Turn the display of the brightness level on or off. Setting retained
Histogram Turn the histogram display on or off. Setting retained
Lens Info Switch the depth of field indication between off, Setting retained

displayed in meters, and displayed in feet.

Assigning Functions to Assignable Switches



Assignable switch setting Function

State when camcorder
is next powered on

Zoom Tele/Wide

When a lens that supports serial communication is
installed, assign the Zoom Tele function to
ASSIGNABLE 4, and assign the Zoom Wide function to
ASSIGNABLE 5 (displayed only when <4> and <5> are
set).

Zoom Wide/Tele

When a lens that supports serial communication is
installed, assign the Zoom Wide function to
ASSIGNABLE 4, and assign the Zoom Tele function to
ASSIGNABLE 5 (displayed only when <4> and <5> are
set).

Manual Focus Assist

Turn the manual focus assist function on or off.

Setting retained

Focus Mag Turn the focus magnification function on or off. Setting not retained
Zebra Turn zebra display on or off. Setting not retained
Lens RET During recording or playback: Write a shot mark. —

In the other states: Conduct a recording review
(if playback is allowed).

Return Video ¥

Display return video signals.

Shot Mark1 Write Shot Mark 1. —
Shot Mark2 Write Shot Mark2. —
OK Mark Add or delete an OK mark. —
Color Temp SW 3200K  Adjust the white balance with a 3200K preset value. Setting retained
Color Temp SW 4300K  Adjust the white balance with a 4300K preset value. Setting retained
Color Temp SW 5600K  Adjust the white balance with a 5600K preset value. Setting retained
Color Temp SW 6300K  Adjust the white balance with a 6300K preset value. Setting retained

Electrical CC

Function that switches the electrical CC filter (3200K/
4300K/5600K/6300K) applied to white balance
adjustment values.

Each press of the switch or button switches in the order
3200K—4300K—5600K—6300K.

These can also be applied from a menu (apply with
Electrical CC<A><B><C><D>).

This function is not available when White Filter >ND
Filter C.Temp in the Maintenance menu is set to On.
If you set ND Filter C.Temp to On after assigning the
function, the assignable switch ceases to function.

Setting retained

CC5600K

Apply a 5600K electrical CC filter to white balance
adjustment values.

Setting retained

Clip Continuous Rec

Turn the Clip Continuous Rec mode on or off.

Setting retained

Assigning Functions to Assignable Switches
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Functions That Can Be Assigned to the RET Button on the Lens

Assignable switch setting Function State when camcorder
is next powered on

Off No assignment —

Lens RET During recording or playback: Write a shot mark. —

In the other states: Conduct a recording review (if
playback is allowed).

Return Video Display return video signals. —
Rec Review Execute recording review. —
Shot Mark1 Write Shot Mark1. —
Shot Mark2 Write Shot Mark2. —
OK Mark Add or delete an OK mark. —
Focus Mag Turn the focus magnification function on or off. Setting not retained
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Saving and Loading User Setting Data

Saving and Loading
Settings

You can save setup menu settings in the
camcorder’s internal memory and on SxS
memory cards. This allows you to quickly recall
an appropriate set of menu settings for the current
situation.
Setting data is saved in the following categories.
ALL files: ALL files save the setting data of all
menus. You can save up to 64 ALL files on
an SxS memory card.

Device specific data (shading, output levels, and
other data that requires adjustment for the specific
device) is not saved.

Scene files: Scene file save adjustments to
PAINT menu items for the purpose of
shooting a particular scene. You can save up
to five scene files in the camcorder’s internal
memory and up to 64 scene files on an SxS
memory card.

Reference files: Reference files save the
reference values that are set when you
execute FILE >Scene > Standard in the setup
menu. You can save one reference file in the
camcorder’s internal memory and one on an
SxS memory card.

Lens files: Lens files save the setting data used to
compensate for lens characteristics, such as
flare, white shading, white balance and
center markers. You can save up to 32 lens
files in the camcorder’s internal memory and
up to 64 lens files on an SxS memory card.

The first settings stored in a file are called
“preset” values.

Even after loading files to set up the camcorder,
and overwriting original files with new settings,
you can still recover preset values and reset files
to their initial states (see page 140).

Saving Setting Data

This section explains how to save setting data in
an ALL file.

Before starting, insert a writable SxS memory
card into a memory card slot.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >All in the setup menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 140).

2 Select All File Save >Execute.
An ALL file list box appears.
File numbers where “No File” is displayed
are empty file numbers. File numbers with a
file name or a date and time are the number
of files that already contain data.

3 Turn the MENU knob to select the
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the save, select [Execute],
and then press the MENU knob.
To cancel the save, select [Cancel], and
then press the MENU knob.
If you choose to execute the save, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section). A completion message appears and
the ACCESS lamp goes out when the data
has been saved to the SxS memory card.

If an error message appears

One of the following error messages may appear
during execution of the save, or as soon as you
select [Execute]. In this case, the file is not saved
to the SxS memory card.

Saving and Loading Settings
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Error message Problem What to do

NG:Cannot Save No recordable Insert

media is recordable

inserted. media.
NG:Media Full The mediais  Use media with

full. free capacity

remaining.

To assign names to files

Assigning a name before you save data in an ALL
file can make it easier to distinguish your files.
The following characters can be used in file
names.

Alphanumeric characters (a—z, A-Z, 0-9) and
special characters (! #$ % &' () *+,-./:;<=
>?7@[\]~)

1 Select FILE >All >File ID in the setup
menu.

2 Turn the MENU knob to select a
character, and then press the MENU
knob.

3 Repeat step 3.

When you have finished entering
characters, press the MENU knob to
move the cursor to “SET”, and then
press the MENU knob.

The specified name is displayed.

When you save the file (see page 139), the
data will be saved under this name.

Loading Setting Data
[ Note |

When you load a file from an SxS memory card, the data

saved in the camcorder’s internal memory is overwritten.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >All in the setup menu.

2 Select All File Load >Execute.
A list box of ALL files appears.
File numbers where “No File” is displayed
are empty file numbers. File numbers with a
file name or a date and time are the number
of files that already contain data.

Saving and Loading Settings

3 Turn the MENU knob to select the
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute],
and then press the MENU knob.
To cancel the load, select [Cancel], and
then press the MENU knob.
If you choose to execute the load, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section). The ACCESS lamp goes out and a
completion message appears when the data
has been loaded from the SxS memory card.

If an error message appears

One of the following error messages may appear
during execution of the load, or as soon as you
select [Execute]. In this case, the file is not loaded
from the SxS memory card.

Error message Problem What to do

* There is no Insert the
readable media media that

* The specified
file does not
exist on the
media

NG:No Data

contains the
file you want.

Resetting a File after Changing Its
Contents

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >All in the setup menu.

2 Select [All Preset], and then press the
MENU knob.

3 To execute the reset, select [Execute],
and then press the MENU knob.
To cancel the reset, select [Cancel], and
then press the MENU knob.
If you choose to execute the reset, all settings
in the ALL file are reset to preset values.



Saving and Loading
Scene Files

Scene files allow you to save the following types

of data.

 Values set in the PAINT menu

« Shutter speeds set in standard mode or ECS
mode

* White balance data
The data that is saved and loaded depends on the
setting of FILE >Reference >Scene White Data
in the setup menu.

Saving Scene Files

To save a scene file to an SxS memory card,
insert the card into a memory card slot and then
proceed as follows.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >Scene in the setup menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 140).

2 Select Scene Store Mem or Scene Store
SxS.
Select Scene Store Mem if you want to save
the data in the camcorder’s internal memory,
and select Scene Store SxS if you want to
save the data on an SxS memory card.

3 Press the MENU knob.
A list box of scene files appears.
File numbers where “No File” is displayed
are empty file numbers

4 Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.

5 To execute the save, select [Execute],
and then press the MENU knob.
To cancel the save, select [Cancel], and
then press the MENU knob.
If you selected Scene Store SxS in step 2, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section) when you execute the save.
When the data has been saved to the SxS
memory card, a completion message appears
and the ACCESS lamp goes out.

Loading Scene Files

To load a scene file from an SxS memory card,
insert the SxS memory card into a memory card
slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >Scene in the setup menu.

2 Select Scene Recall Mem or Scene
Recall SxS.
Select Scene Recall Mem if you want to load
the file from the camcorder’s internal
memory, and select Scene Recall (SxS) if
you want to load the file from an SxS
memory card.

3 Press the MENU knob.
A list box of scene files appears. File
numbers where “No File” is displayed are
empty file numbers.

4 Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute],
and then press the MENU knob.
To cancel the load, select [Cancel], and
then press the MENU knob.
If you selected Scene Recall SxS in step 2,
the ACCESS lamp lights (in blue on the
right-side panel and in orange in the card slot
section) when you execute the load.
When the data has been loaded from the SxS
memory card, a completion message appears
and the ACCESS lamp goes out.

Saving and Loading Scene Files
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Saving and Loading
Lens Files

Setting Lens File Data

Use FILE >Lens (see page 133) in the setup menu
to set the data in lens files.

You can set the following data and save it as a
lens file.

Setting data Sub-items

V modulation shading M V Modulation

compensation values

Lens Center H
Lens Center V

Center marker position

Flare level Lens R Flare
Lens G Flare
Lens B Flare
White balance Lens W-R Offset
compensation value Lens W-B Offset
White shading L R/G/B H Saw
compensation value L R/G/B H Para
L R/G/B V Saw

L R/G/B V Para

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

Saving Lens Files

To save a lens file to an SxS memory card, insert
the card into a memory card slot and then proceed
as follows.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >Lens in the setup menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 140).

Saving and Loading Lens Files

2 Select Lens Store Mem or Lens Store
SxS, and press the MENU knob.
Select Lens Store Mem if you want to save
the data in the camcorder’s internal memory,
and select Lens Store SxS if you want to save
the data on an SxS memory card.

3 To execute the save, select [Execute],
and then press the MENU knob.
To cancel the save, select [Cancel], and
then press the MENU knob.
If you select [Execute], a list box of lens file
number appears. File numbers where “No
File” is displayed are empty file numbers.

4 Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.

5 To execute the save, select [Execute],
and then press the MENU knob.
To cancel the save, select [Cancel], and
then press the MENU knob.
If you selected Lens Store SXS in step 2, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section) when you execute the save.
When the data has been saved to the SxS
memory card, a completion message appears
and the ACCESS lamp goes out.

Loading Lens Files

To load a lens file from an SxS memory card,
insert the SxS memory card into a memory card
slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 97) for
information about menu operations.

1 Select FILE >Lens in the setup menu.

2 Select Lens Recall Mem or Lens Recall
SxS, and press the MENU knob.
Select Lens Recall Mem if you want to load
the file from the camcorder’s internal
memory, and select Lens Recall SxS if you
want to load the file from an SxS memory
card.

3 To execute the load, select [Execute],
and then press the MENU knob.



To cancel the load, select [Cancel], and
then press the MENU knob.

If you select [Execute], a list box of lens files
appears. File numbers where “No File” is
displayed are empty file numbers.

4 Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute],
and then press the MENU knob.
To cancel the load, select [Cancel], and
then press the MENU knob.
If you selected Lens Recall SxS in step 2, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section) when you execute the load.
When the specified lens file has been loaded
from the SxS memory card, a completion
message appears and the ACCESS lamp goes
out.

Loading Lens Files Automatically

When you are using a lens that support serial

communication, you can set up the camcorder by

automatically loading the lens file that

corresponds to the lens settings (Lens Auto Recall

function).

To use the Lens Auto Recall function, set FILE

>Lens >Lens Auto Recall in the setup menu to

one of the following.

On: Load the lens file that corresponds to the
model name.

Off: Do not use the Lens Auto Recall function.

Serial Number: Load the lens file that
corresponds to the model name and serial
number (when the lens supports
communication of the serial number).

If the lens does not support communication of the

serial number, both settings load the lens file that

corresponds to the model name.

Saving and Loading Lens Files
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Chapler8

You can connect an RM-B 150/B750 Remote Control Unit and operate this camcorder. For connection and
operation of the RM-B150/B750, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for
Solid-State Memory Camcorder”).

Connecting External Monitors

Select the output signal and use an appropriate cable for the monitor to be connected.

HD/SD SDI
ouT

BNC cable (not supplied)

SDI'IN

===

4
VIDEO IN

VIDEO OUT
LN

BNC cable (not supplied)

Regardless of whether the signal is HD or SD, the m
same status information and menus can be .
i i SD signals down-converted for output have the

displayed on the external monitor as those on the following restrictions:

viewfinder screen. Images of 50P/50i/25P are output as PAL signals, those
of 59.94P/59.94i/29.97P are output as NTSC signals, and
those of 23.98P are output as 2-3 pulled-down NTSC
signals.

Connecting External Monitors



HD/SD SDI OUT connector (BNC)

The HD/SD SDI OUT connector can be used to
connect a device that supports SDI. The device
type can be a monitor, switcher, or VIR or other
recording device.

The output from this connector can be turned on
and off with OPERATION >Input/Output >SDI
Output in the setup menu (see page 101).

For connection, use a BNC cable (not supplied).

VIDEO OUT connector

The VIDEO OUT connector can be used to
connect a device that supports analog composite
signal. The device type can be a monitor or VTR
or other recording device.

The output signal varies as shown in the
following table depending on the setting of
OPERATION >Output&i.LINK in the setup
menu.

Setting Output signal
HD&HDV (in FAT HD-Y analog signal which
mode) has the same video format

HD (in UDF mode) with the signal output from

the HD/SD SDI OUT

connector.
SD&HDYV or Composite signal which has
SD&DV (in FAT the same video format with
mode) the signal output from the

SD (in UDF mode) HD/SD SDI OUT connector.
‘When OPERATION
>Format >HD/SD in the
setup menu is [SD], the
output composite signal is
the same as the NTSC or
PAL encoded signal that is
output from the HD/SD SDI
OUT connector ¥,

a) Use OPERATION >Format >Country (see page 100)

in the setup menu to switch between NTSC and PAL.

To input the VIDEO OUT connector output
signal to an external analog composite device, it
may be necessary to change the input signal
setting of that external device to be matched with
the analog composite signal setting for the
VIDEO OUT connector.

To input camcorder output audio to an external
device such as a monitor or VIR or other
recording device, connect the audio output of the
AUDIO OUT connector to the audio input of that
external device.

For connection, use a BNC cable (not supplied).

i.LINK (HDV/DV) connector

In FAT mode, i.LINK (HDV/DV) connector
supports HDV and DV input/output. However,
DV streams cannot be recorded on this
camcorder.

This connector can be used to connect a device
that supports i. LINK (HDV). The device type can
be a monitor, read/write device such as VTR or
HDD, or computer.

To input/output HDV signals

HDV input/output is supported when the video
format is an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.98P), Input/
Output >Output&i.LINK in the OPERATION
menu is set to [HD&HDV] or [SD&HDV], and
Input/Output >i.LINK I/O is set to [Enable].
When the video format is SP 1440/23.98P, a
59.94i HDV signal subjected to 2-3 pulldown
processing is output.

To input/output DV signals

DV input/output is supported under either of the

following conditions.

¢ Input/Output >i.LINK I/O in the OPERATION
menu is set to [Enable] on SD mode.

¢ On HD mode, the video format is other than DV
incompatible formats (HQ 1920/23.98P, HQ
1440/23.98P, and HQ 1280/23.98P), Input/
Output >Output&i.LINK is set to [SD&DV],
and Input/Output >i.LINK /O is set to
[Enable].

Connecting External Monitors
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Operating Clips with a
Computer

The clips recorded on SxS memory cards with
this camcorder can be controlled on a computer or
edited using the optional nonlinear editing
software.

For these purposes, the clips on an SxS memory
card can be operated by directly loading the card
in a computer or by connecting the camcorder or
the optional SBAC-US10 SxS Memory Card
USB Reader/Writer to the computer, using an
USB cable as shown below.

Using the ExpressCard Slot of a
Computer

If the computer is equipped with an ExpressCard/
34 or ExpressCard/54 slot, you can directly insert
the SxS memory card containing clips recorded
with this camcorder and access to the files.

For the operating requirements for the computer, see
“Using the Software” (page 11).

The SxS Device Driver Software and SxS UDF driver
software on the CD-ROM supplied with the camcorder
must be installed on your computer. Before installation,
be sure to read the enclosed SxS Device Driver Software
End-User License Agreement.

For information on installation of the driver
software, refer to the ReadMe on the supplied CD-
ROM.

For support information for the driver software, visit
the following URL:
http://www.sony.net/SxS-Support/

To the ExpressCard slot

—
A =

SxS memory card

Computer with SxS
Device Driver
Software installed

With a Windows computer
Check that a Removable Disk appears in My
Computer. This indicates normal status.

Operating Clips with a Computer

With a Macintosh computer
An icon is displayed on the menu bar.

USB Connection with a Computer

Preparations

When you connect the camcorder to a computer
using a USB cable (not supplied), the memory
card in the slot is acknowledged as an extended
drive by the computer.

When two memory cards are mounted in this
camcorder, they are acknowledged as two
independent extended drives by the computer.

USB cable
(not supplied)

¢ When connecting the USB cable to the computer, be
careful to check the form and direction of the USB
connector.

» The camcorder does not work on the bus power from
the computer.

To start USB connection

‘When a computer is connected to the PC connector of the

camcorder and at the same time an optional PHU-60K/

120K/120R Professional Harddisk Unit (powered from a

battery) is connected to the computer, battery exhaustion

on the PHU-60K/120K/120R (indicated by a Battery

End warning) disables the following.

* To guard the PHU-60K/120K/120R against access
from the computer

¢ To disconnect the PHU-60K/120K/120R’s cable from
the memory card slot or plug again the cable into the
slot




¢ To turn on the tally indicator on the viewfinder screen
to warn the operator

‘When you connect a computer to the PC
connector with a USB cable (not supplied), the
message “Connect USB Now?” is displayed to
prompt you to confirm that you wish to enable the
USB connection.

If you select “Cancel” or push the MENU
CANCEL/PRST/ESCAPE down to the ESCAPE
side or if you disconnect the USB cable, the
message “Connect USB Now?” disappears.

Cancel

If you select “Execute” and press the MENU
knob, the USB connection is enabled and this
camcorder is recognized as an extension drive.
You can carry out the same operations by using
the arrow buttons (ﬁ}, &, <=, =) (see page 20).

USB Connecting

If the USB connection is enabled during
recording/playback operation, the operation is
stopped and the message “USB Connecting”
appears on the viewfinder screen.

At this time, the output signal from the VIDEO
OUT connector, and HD/SD SDI OUT connector
changes to a black signal.

* The camcorder cannot be operated for recording,
playback, and so on while the message “USB
Connecting” is displayed.

* When the computer accesses the media loaded in the
camcorder, do not try to carry out the following
operations.

- Operating the camcorder (turning the power on/off,
switching the operation mode, etc.)

- Removing or loading a media from an active slot
(being accessed from the computer)

- Removing or connecting the USB cable

Disabling the USB connection

To disable the USB connection, follow the same
procedure as that for removing a device from the
computer.

To enable the USB connection again, first
disconnect the USB cable and then reconnect it.

The message “Connect USB Now?” appears
again.

If you connect the camcorder to the computer using an
i.LINK cable, you cannot use the computer to operate
files stored in a recording media loaded in the memory
card slot of this camcorder.

To remove an SxS memory card

Windows

1. Click on the icon of “Safely Remove
Hardware” on the task bar of the computer.

2. Select “Safely remove SxS Memory Card -
Drive(X:)” from the displayed menu.

3. Check that the Safe To Remove Hardware
message appears then remove the card.

Macintosh

Drag the SxS memory card icon on the desktop to
Trash.

If the SxS memory card icon is located on Finder,
click on the eject icon on its side.

To use the application software

To copy clips to the local disk of a computer, the
supplied application software must be used.
Install the application software on the supplied
CD-ROM to your computer.

Although the data regarding recorded materials
are stored over multiple files and folders, you can
easily handle the clips without considering such
data and directory structure by using the supplied
application software.

If you operate, e.g. copy the clips on the SxS memory
card by using the Explorer (Windows) or Finder
(Macintosh), the subsidiary data contained by the clips
may not be maintained. To avoid such a problem, use the
application software.

For installation and operations, refer to the User’s
Guide contained in the CD-ROM.

For support information on the application software,
visit on the cover page of the supplied CD-ROM.

To use a nonlinear editing system

For a nonlinear editing system, optional editing
software that corresponds to the recording
formats used with this camcorder is required.

Operating Clips with a Computer
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Store the clips to be edited on the HDD of your
computer in advance, using the supplied
application software.

Some editing software may not operate properly.
Be sure to confirm before use that it conforms to
the recording formats used with this camcorder.

Connecting an External Device (i.LINK Connection)

Connecting an External
Device (i.LINK
Connection)

FAT

You can record the same images as those
recorded on the memory card in this camcorder
on an external device connected to the i. LINK
(HDV/DV) connector, or record the playback
picture of the external device on the memory card
in the camcorder.

When you connect the camcorder to a non-linear
editing system that supports HDV format, you
can edit the images recorded on the memory card
in the camcorder.

* i.LINK connection is available only in FAT mode.
Use the i.LINK (HDV/DV) connector only for one-to-
one i.LINK connection.

‘When you change a setting which affects output
signals from the i. LINK (HDV/DV) connector, such as
HD/SD, HD System Line, System Frequency, and Rec
Format under OPERATION >Format in the setup
menu or i.LINK I/O and Down Converter under
OPERATION >Input/Output in the setup menu,
disconnect the i.LINK cable and change the setting.
Changing such a setting with the i.LINK cable
connected may cause improper operation of the
connected i.LINK device.

The external signal input via the i.LINK connection
that can be recorded on the camcorder is HDV streams
only. You cannot record DV streams via the i. LINK
connection.

Recording the Camera Picture on
an External Device

The picture being shot with this camcorder is
output as an HDV or DV stream via the i. LINK
(HDV/DV) connector. It can be recorded on a
connected HDV or DVCAM recorder in
synchronization with a recording start/stop
operation on this camcorder.

1 Perform the preparatory settings of the
camcorder.



¢ Set OPERATION >Input/Output >Output

& i.LINK in the setup menu (see

page 101) to “HD & HDV” or “SD &

HDV”.

HD & HDV or SD & HDV: To output an
HDV stream in HD mode when the
video format is set to an HDV
compatible format (SP 1440/59.94i,
SP 1440/50i, or SP 1440/23.94P)

SD & DV: To output a DV stream

Set OPERATION >Input/Output >i. LINK

1/0 in the setup menu to [Enable].

Set MAINTENANCE >Trigger Mode

>1.LINK Trigger Mode in the setup menu

(see page 129) to [Both] or [External].

Both: To perform recording both on the
memory card in this camcorder and on
the external device

External: To perform recording only on
the external device

2 Set the external device to recording
standby status.

For operations of the external device, refer to
the operation manual of that device.

3 Start recording.
The external device starts recording in
synchronization.

The status of the external device is displayed in
the i.LINK status indication area (see page 29) on
the viewfinder screen.

Indication Status of the external device
STBY i) In HDV recording standby
OREC §[IDI] In HDV recording

STBY i IDMA In DV recording standby
OREC ; IDIT In DV recording

¢ Operation may be different depending on the type of
external device.

When you execute the operation to make a recording

on the recording media loaded in the camcorder while
HDV signals are output from the i. LINK (HDV/DV)

connector, HDV signal output stops for about one

second before the recording starts, and then it resumes.

While you can record shot marks on the memory card
during recording, they are not added to the pictures
recorded on the external device.

Nonlinear Editing

You can transfer an HDV stream to a nonlinear
editing system connected via the i. LINK (HDV/
DV) connector.

The i.LINK (HDV/DV) connector of this camcorder is
a 6-pin connector. Check the number of pins of the
i.LINK connector on your computer and use an
appropriate i.LINK cable.

In searching pictures of this camcorder on the
computer, it may take some time until the display is
reflected on the computer.

If the playback clip is short or the playback starting
point is near the end of the clip, the i.LINK signal may
be interrupted between the clip and the next clip. When
you try to capture such a signal using the nonlinear
editing system, a malfunction may occur, depending
on the nonlinear editing software in use.

If you specify a search speed other than 4, 15, or 24
times normal with the nonlinear editing system, no
i.LINK signal is fed out. In such a case, the picture on
the LCD monitor may stay frozen.

High-speed playback picture may not be displayed on
the computer screen, depending on the nonlinear
editing software in use.

Setting on this camcorder
Set OPERATION >Input/Output >i.LINK I/O in
the setup menu to [Enable].

For operations of the nonlinear editing software,
refer to the operation manual of the software.

Recording External Input Signals

The HDV stream input from a device connected
via the i.LINK (HDV/DV) connector can be
recorded on an SxS memory card in this
camcorder.

The timecodes superimposed on the i. LINK input
are recorded regardless of the settings of the
camcorder.

DV stream cannot be recorded.

1 Set the external signal to a format that
can be recorded on the camcorder.
Select an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.94P) for
the video format.

seoIneQ [eulalxg Bunosuuo) g Jerdeyn
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2 Make the following settings with
OPERATION >Input/Output in the
setup menu (see page 101).
¢ Set Output&i.LINK to [HD&HDV] or

[SD&HDV].
¢ Set i.LINK I/O to [Enable].
¢ Set Source Select to [i. LINK].
The input video is displayed on the
viewfinder screen or the monitor connected
to the VIDEO OUT connector.
Audio signals are output through the built-in
speakers, the headphones connected to the
EARPHONE connector, and the speakers of
the monitor connected to the VIDEO OUT
connector.

w

Start the recording.

« An error is generated in the following cases. In such a
case, cancel Recording mode.
- The video format of input signal does not match that
specified on the camcorder.
- A copy-protected stream is being fed in.

If the input to the camcorder becomes no signal during
recording, the TALLY indicators, the tally indicator on
the front of the viewfinder, and the REC indication
(@REC) on the viewfinder screen flash, indicating that
no signal is being recorded on the SxS memory card.
When an input signal is resumed, recording is
restarted, incrementing the clip number on the memory
card.

Configuring a Shooting and Recording System

Configuring a Shooting
and Recording System

If you install the optional CBK-HDO?2 on this
camcorder, you can attach the XDCA-55 HD
Camera Adaptor and connect the XDCU-50 HD
Camera Extension Unit.

This allows you to configure a shooting and
recording system consisting of multiple
camcorders with camera extension units
connected to a remote control unit.

For more information about the XDCA-55 and
XDCU-50, refer to their respective operation
manuals.

When using the camcorder in this system, do not connect
a video light to the camcorder.



Chapterg

Check the functions of the camcorder before
setting out for a shooting session, preferably by
recording and playing back video and audio
signals.

Cleaning the Viewfinder

Use a dust blower to clean the CRT screen and
mirror inside the viewfinder barrel.

Clean the lens and protecting filter with a
commercially available lens cleaner.

Never use organic solvents such as thinners.

souruBURlN 6 Jerdey)

Disassembling the eyepiece for cleaning
(example: HDVF-20A)

© Viewfinder barrel
@ Eyecup holder
© Protecting filter
O Packing ring

@ Eyecup

1 Detachthe eyepiece from the viewfinder
barrel.

For the detaching procedure, see “Detaching
the Eyepiece” on page 34.

2 Remove the eyecup from the eyecup
holder.

Testing the Camcorder / Maintenance | 151
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3 Remove the protecting filter, together
with the packing ring, from inside the
eyecup holder.

4 Detach the protecting filter from the
packing ring.

Fog-proof filter

Depending on the temperature and humidity, the
protecting filter may mist because of vapor or
your breath. To ensure that the viewfinder is
always clear, replace the protecting filter with a
fog-proof filter (service part number: 1-547-341-
11).

Fitting the fog-proof filter

Replace the protecting filter on the packing ring
with the fog-proof filter.

Be sure to correctly assemble the fog-proof filter,
the packing ring, and the eyecup so that the
reassembled eyepiece is waterproof.

‘When cleaning the fog-proof filter, wipe it very gently
with a soft cloth to avoid damaging the anti-fogging
coating.

Maintenance

Note about the Battery Terminal

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.

Power may not be supplied to the unit properly if
the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they
become corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime.

Contact a Sony service or sales representative for
more information about inspections.



Operation Warnings

If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various

visible and audible indicators. These visible and audible indicators are:
 Error/warning message (“A” in the “Layout of the table of warning messages” below)

¢ WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication

(“D”), and battery remaining indicator (“E”).

A warning message, and the REC indication appear on the viewfinder screen.
The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the

minimum position to suppress the sound.

Layout of the table of warning messages

<«

WARNING indicator | Warning sound Tally/REC Battery remaining
B C D E
Problem Operation in the recorder | Action to take

module

* The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is
represented by graphic symbols as follows.

?\%: Continuous
5#3: 1 flash/s
{0:)))3: 4 flashes/s

* The warning sounds are represented by graphic symbols as follows.

Error Indication

ERROR

)M : Continuous beep
)M : 1 beep/s

WARNING indicator | Warning sound Tally/REC Battery remaining
3.:3 )N g.:g —
Problem Operation in the recorder | Action to take
module
| S Recording stops. Power the camcorder off and contact a Sony

service representative.

Operation Warnings
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Warning Indication

module

WARNING indicator | Warning sound Tally/REC Battery remaining
> S )N S S —
Problem Operation in the recorder | Action to take

Free space on the SxS
memory card has
become insufficient.

Media Near Full

Recording continues.

Replace it with another at the earliest opportunity.

WARNING indicator | Warning sound Tally/REC Battery remaining
Sed )M ot —
Problem Operation in the recorder | Action to take

module

No space is left on the
SxS memory card.
Recording, clip
copying and clip
division cannot be
performed.

Media Full

Recording stops.

Replace it with another.

‘WARNING indicator

Warning sound

Tally/REC

Battery remaining

)N

Y
o

Problem

Operation in the recorder
module

Action to take

Battery Near End

The battery power will
be exhausted soon.

Recording continues.

Charge the battery pack at the earliest

opportunity.

‘WARNING indicator | Warning sound Tally/REC Battery remaining
- &% DM 50:)))3 —)o:é
]
= Problem Operation in the recorder | Action to take
E’ module
§ The battery pack is Recording stops. Connect a power source via the DC IN connector

exhausted. Recording
cannot be performed.

or stop operation to charge the battery pack.

‘WARNING indicator

Warning sound

Tally/REC

Battery remaining

)N

L/
o

Problem

Operation in the recorder
module

Action to take

The internal
temperature has risen
above a safe operation
limit.

Temperature High

Recording continues.

Suspend operation, turn off the power, and wait
until the temperature falls.

Operation Warnings



Insufficient Voltage Voltage Low

Battery Error
Please Change Battery.

)
=
=
oy
e
=
]
2
2
]
=
=]
3
=~

Unknown Media(A)"

Bl
e
=
s
=
Q
o
w
<
=
A

Please Change.

WARNING indicator | Warning sound Tally/REC Battery remaining
et )N ;:.g g.:g
Problem Operation in the recorder | Action to take
module
The DC IN voltage has |Recording continues. Check the power supply.
become low (stage 1).
'WARNING indicator | Warning sound Tally/REC Battery remaining
&% )M —)o:))):— —)o::—
Problem Operation in the recorder | Action to take
module
The DC IN voltage is |Recording stops. Connect other power source.

too low (stage 2).
Recording cannot be

performed.
WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take

module

An error was detected
with the battery pack.

Recording stops.

Replace the battery pack

with a normal one.

WARNING indicator

Warning sound

Tally/REC

Battery remaining

Problem

Operation in the recorder
module

Action to take

The remaining power

Recording continues.

Refer to a Sony service representative to replace

of the backup battery the battery with a new one.

is insufficient.

‘WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take

module

A partitioned memory
card or one that
contains recorded clips
exceeding the number
permitted with this
camcorder is loaded.

Recording continues.

This card cannot be used with this camcorder.
Remove it and load a compatible card.

Operation Warnings
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WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

The maximum number
of clips for a single
memory card is
reached. No more clip
can be recorded on the
card.

Reached Clip Number Limit

Recording stops.

Replace it with another card.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

An error occurred with
the memory card. The
card requires
restoration.

Media Error

Recording stops.

Remove the card, load it again, and restore it.

WARNING indicator

Warning sound

Tally/REC Battery remaining

ia(A)“ Media(A)“ Needs to be Restored| Cannot Record to Media(Av)D

Problem

Operation in the recorder
module

Action to take

Recording cannot be
done, as the memory
card is defective.

Media Error
Cannot Record to Med

Recording stops.

As playback may be possible, it is recommended
to replace it with another card after copying the
clips, as required.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

Neither recording nor
playback can be done,
as the memory card is
defective.

Media Error

Recording stops.

It cannot be operated with this camcorder.
Replace it with another card.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

A card of a different
file system was
inserted.

Cannot Use Media(A,)”
Unsupported File System| Cannot Use Media(A)D

Recording stops.

It cannot be used with this camcorder. Replace it
with another card.

Operation Warnings



Video Format Mismatch

Copy Protected Input

=
£
2
7
3
2
=
=
=
<
S
a

Media Error
Playback Halted

Media(A)” Error

Cannot Record

=
1
e
S
&~
-
5]
=1
=
<
Qo

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

The external signal
input via the i. LINK
connection cannot be
recorded, as the Video
Format setting is
different from the
signal format of the
external input signal.

Recording stops.

Change settings of OPERATION >Format in the
setup menu to match it to that of the external
signal.

WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take
module
The external signal Recording stops. Check the input signal.
input via the i. LINK
connection cannot be
recorded, as the stream
is copy-protected.
'WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take
module
The external signal Recording stops. —
input via the i. LINK
connection cannot be
recorded, as itis a DV
stream.
'WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take

module

An error occurred in
reading data from the
memory card, and

Recording stops.

If this frequently occurs, change the memory card
after copying the clips, as required.

playback cannot be

continued.

‘WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the recorder | Action to take

module

Recording cannot be
done, as an error
occurred with the
memory card.

Recording stops.

If this frequently occurs, change the memory
card.

Operation Warnings
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module

WARNING indicator | Warning sound Tally/REC Battery remaining
3 )N 8¢ —
Problem Operation in the recorder | Action to take

The battery power of
the connected HDD
will be exhausted
soon.

=
=
=
]
s
i
z
>
ot
2
-
]
-]
Q
<
aQ
a
==

Recording continues.

Change the battery at the earliest opportunity.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

¥

)M

ot

Problem

Operation in the recorder
module

Action to take

The battery of the
connected HDD is
exhausted. Recording
cannot be performed.

HDD A2 Battery End

Recording stops.

Stop operation to change the battery.

WARNING indicator

Warning sound

Tally/REC Battery remaining

(AP

Problem

Operation in the recorder
module

Action to take

There is not enough
capacity for copying.

Change Medial

Recording continues
(disallowing copy).

Replace the card in slot A with another one.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

t The card has already
ten clips having the
same name as that you
tried to duplicate.

Change Media(A)?

Recording continues
(disallowing copy).

Replace the card in slot A with another one.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

There is not enough
capacity for dividing a
clip.

Not Enough Capacity | Reached Duplication Limit | Not Enough Capacity
Cannot Divide

Recording continues
(disallowing divide).

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

Will switch to other
slot soon.

=
5
=3
175)
j2}
3
=
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=
<
=
3
)

Recording continues.

Make sure that a memory card is loaded in the
other slot.

Operation Warnings



WARNING indicator | Warning sound Tally/REC Battery remaining
& _ _ — —
@) Problem Operation in the recorder | Action to take
=)
2 module
There is no clip to be  |Recording continues. —
displayed.
'WARNING indicator | Warning sound Tally/REC Battery remaining
& | - - -
: Problem Operation in the recorder | Action to take
o module
°
Z There is no clip with | Recording continues. —
the OK mark.
'WARNING indicator | Warning sound Tally/REC Battery remaining
g _ _ _ _
Problem Operation in the recorder | Action to take

module

The card has already
clips having the same
name as that you tried
to duplicate.

Same File Already Exists
Change Medial

Recording continues
(disallowing copy).

Replace the card in slot A with another one.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

AV

Operation in the recorder
module

Action to take

The memory card
{ comes to the end of its
service life.

Change Medial

Recording stops.

Make a backup copy and replace the card with
another one as soon as possible. Recording/
playback may not be performed properly if you
continue to use the card.

For details, refer to the Operating Instructions of
the memory card.

‘WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

The inserted memory
card contains clips
recorded in a format
that is not supported
by this camcorder.

Unsupported Clip Included | Media Reached Rewriting Limit
Cannot Use Media(A)l)

The card in slot A cannot be used with this
camcorder.

Operation Warnings
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WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the recorder
module

Action to take

The fan does not rotate
when started.

Fan Stopped D

Avoid use under high temperature conditions.
Power the camcorder off and contact a Sony
service representative.

1) (B) for the card in slot B

2) B for a HDD connected to slot B

Operation Warnings



I Appendix

Important Notes on
Operation

Use and storage

Do not subject the camcorder to severe shocks

 The internal mechanism may be damaged or the
body warped.

« If an accessory mounted on the accessory shoe
is subjected to severe shock, the accessory shoe
may be damaged. In such a case, stop using it
and contact your dealer or a Sony service
representative.

Do not cover the camcorder while operating
Putting a cloth, for example, over the camcorder
can cause excessive internal heat build-up.

After use
Always turn off the POWER switch.

Before storing the camcorder for a long period
Remove the battery pack.

Shipping

* Remove the media before transporting the
camcorder.

« If sending the camcorder by truck, ship, air or
other transportation service, pack it in the
shipping carton of the camcorder.

Care of the camcorder

Remove dust and dirt from the surfaces of the
lenses or optical filters using a blower.

If the body of the camcorder is dirty, clean it with
a soft, dry cloth. In extreme cases, use a cloth
steeped in a little neutral detergent, then wipe dry.
Do not use organic solvents such as alcohol or
thinners, as these may cause discoloration or
other damage to the finish of the camcorder.

In the event of operating problems
If you should experience problems with the

camcorder, contact a Sony service representative.

Use and storage locations

Store in a level, ventilated place. Avoid using or

storing the camcorder in the following places.

* Inexcessive heat or cold (operating temperature
range: —=5°C to +40°C (23°F to 104°F))

* Remember that in summer in warm climates the
temperature inside a car with the windows
closed can easily exceed 50°C (122°F).

* In damp or dusty locations

* Locations where the camcorder may be exposed
to rain

* Locations subject to violent vibration

* Near strong magnetic fields

* Close to radio or TV transmitters producing
strong electromagnetic fields.

* In direct sunlight or close to heaters for
extended periods

To prevent electromagnetic interference from
portable communications devices

The use of portable telephones and other
communications devices near this camcorder can
result in malfunctions and interference with audio
and video signals.

It is recommended that the portable
communications devices near this camcorder be
powered off.

Fitting the zoom lens

It is important to fit the lens correctly, as
otherwise damage may result. Be sure to refer to
the section “Mounting and Adjusting the Lens”
(page 37).

Viewfinder

Do not leave the camcorder with the eyepiece
pointing directly at the sun.

The eyepiece lens can concentrate the sun’s rays
and melt the interior of the viewfinder.

About the LCD panels

The LCD panel fitted to this camcorder is
manufactured with high precision technology,
giving a functioning pixel ratio of at least 99.99%.
Thus a very small proportion of pixels maybe

Important Notes on Operation
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“stuck”, either always off (black), always on (red,
green, or blue), or flashing. In addition, over a
long period of use, because of the physical
characteristics of the liquid crystal display, such
“stuck” pixels may appear spontaneously. These
problems are not a malfunction. Note that any
such problems have no effect on recorded data.

Phenomena specific to CCD image
sensors

The following phenomena that may appear in
images are specific to CCD (Charge Coupled
Device) image sensors. They do not indicate
malfunctions.

White flecks

Although the CCD image sensors are produced
with high-precision technologies, fine white
flecks may be generated on the screen in rare
cases, caused by cosmic rays, etc.

This is related to the principle of CCD image
sensors and is not a malfunction.

The white flecks especially tend to be seen in the

following cases:

* When operating at a high environmental
temperature

¢ When you have raised the master gain
(sensitivity)

In SLS mode, white flecks are more prominent
when you set the shutter speed (number of
frames) to higher values.

The problem may be alleviated by executing the
APR (automatic pixel noise reduction) function
with MAINTENANCE >APR in the setup menu
(see page 129). Pixel noise is reduced to some
extent by automatic black balance adjustment
(see page 50), but the detection capabilities of
that function are limited. For the most effective
correction, execute the APR function.

Vertical smear

When an extremely bright object, such as a strong
spotlight or flashlight, is being shot, vertical tails
may be produced on the screen, or the image may
be distorted.

Important Notes on Operation
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© Monitor screen

@ Vertical tails shown on the image

© Bright object (e.g. strong spotlight,
strong reflected light, flashlight, the sun)

Aliasing
When fine patterns, stripes, or lines are shot, they
may appear jagged or flicker.

Fragmentation

If pictures cannot be recorded/reproduced
properly, try formatting the recording medium.
While repeating picture recording/playback with
a certain recording medium for an extended
period, files in the medium may be fragmented,
disabling proper recording/storage. In such a
case, make a backup of clips in the medium then
perform formatting of the medium using
OPERATION >Format Media (see page 100) in
the setup menu.



Exchanging the Battery Specifications
of the Internal Clock

The camcorder’s internal clock is powered by a

lithium battery. If the message “BackUp Battery General

End” appears in the viewfinder, this battery must

be exchanged. Contact a Sony service Power requirements
representative. 12VDC (11 Vto 17.0V)

Power consumption
Approx. 29 W (main unit only, during recording
with the LCD monitor lit)

* Do not use a video light with power
consumption of over 50 W.

* When connecting a device to the DC OUT
connector, use one with current
consumption of 0.5 A or more.

Operating temperature
-5°C to +40°C (23°F to 104°F)

Storage temperature
—20°C to +60°C (—4°F to 140°F)

Recording/playback formats

UDF mode

* HD422
Video codec: MPEG-2 422P@HL
Video rate: 50 Mbps/CBR
Video samples: 1920 x 1080, 1280 x 720
Proxy video: MPEG-4
Audio: LPCM 4CH, 24 bits, 48 kHz
Proxy audio: A-law

HD420

Video codec: MPEG-2 MP@HL(1440)
Video rate: 35 Mbps/VBR

Video samples: 1440 x 1080

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz
Proxy audio: A-law

Video codec: MPEG-2 MP@HL
Video rate: 35 Mbps/VBR

Video samples: 1280 x 720

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz
Proxy audio: A-law

Exchanging the Battery of the Internal Clock / Specifications
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* IMX
Video codec: MPEG-2 422P@ML Intra
Video rate: 50 Mbps
Video samples: 720 x 486 (NTSC)/576 (PAL)
Proxy video: MPEG-4
Audio: LPCM 4CH, 24/16 bits, 48 kHz
Proxy audio: A-law

DVCAM

Video rate: 25 Mbps

Video samples: 720 x 480 (NTSC)/576 (PAL)
Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz

Proxy audio: A-law

FAT mode
* HD420
Video codec: MPEG-2 MP@HL
Video rate: 35 Mbps/VBR
Video samples: 1920 x 1080, 1280 x 720
Audio: LPCM 4CH, 16 bits, 48 kHz

Video codec: MPEG-2 MP@HL (1440)
Video rate: 35 Mbps/VBR

Video samples: 1440 x 1080

Audio: LPCM 4CH, 16 bits, 48 kHz

Video codec: MPEG-2 MP@H14
Video rate: 25 Mbps/CBR

Video samples: 1440 x 1080
Audio: LPCM 4CH, 16 bits, 48 kHz

DVCAM

Video rate: 25 Mbps

Video samples: 720 x 480 (NTSC)/576 (PAL)
Audio: LPCM 2CH, 16 bits, 48 kHz

Recording/playback time
‘With one SBP-16
FAT mode HQ: About 50 minutes
SP: About 70 minutes
DVCAM: About 65 minutes
UDF mode HD422 50/IMX50: About
30 minutes
HDA420 HQ: About 45 minutes
DVCAM: About 55 minutes
With one SBP-32/SBS-32G1A
FAT mode HQ: About 100 minutes
SP: About 140 minutes
DVCAM: About 130 minutes
UDF mode HD422 50/IMX50: About
60 minutes
HD420 HQ: About 90 minutes
DVCAM: About 110 minutes
With one SBS-64G1A
FAT mode HQ: About 200 minutes
SP: About 280 minutes
DVCAM: About 260 minutes
UDF mode HD422 50/IMX50: About
120 minutes
HD420 HQ: About
180 minutes
DVCAM: About 220 minutes

The actual recording/playback time may differ
slightly from the values shown here, depending
on usage conditions, memory characteristics,

etc.

Continuous operation time
With the BP-GL95
Approx. 170 min.

Specifications

Mass
Main body only: 3.4 kg (7 1b 7.9 0z)

Dimensions

See page 167.

Supplied accessories

See page 166.

Camera Block

Pickup device
2/3—lype, CCD image sensor
Effective picture elements:
1920 (H) x 1080 (V)

Format
3-chip RGB




Optical system

F1.4 prism system

Frequency response
20 Hz to 20 kHz (within +3 dB)

ND filters
1: Clear
2:1,ND
3: 1/,,ND
4: 1¢,ND

Dynamic range
90 dB (typical)

Distortion
0.08% max. (with input level 40 dBu)

Sensitivity
F11 (System frequency: 59.94i)
F12 (System frequency: 50i)
(20001x, 89.9% reflection, 3200K)

Built-in speaker
Monaural
Output: 300 mW

Minimum illumination
0.016 Ix (F1.4, +42 dB, 16-frame accumulation)

Video S/N
54 dB (Noise Suppress Off)
59 dB (Noise Suppress On)

Display

LCD monitor

Screen size

8.8 cm diagonal (3.5-inch)

Horizontal resolution
1000TV lines or more

Aspect ratio
16:9

Modulation

45% or more (27.5 MHz, at screen center)

Picture elements
640 (H) x 3 x 480 (V) Sequence delta

Black level
3+1% (when Black in the setup menu is set to
[=0D)

Transmission system

Hybrid (semi-transmissive) type

Gain
-6,-3,0,3,6,9, 12, 18, 24, 30, 36, 42 dB, AGC

Shutter speed
59.94i/P, 50i/P: gy to /5000 sec.
29.97P: 40 to Ung0p sec.
25P: 1/33 to l/2000 sec.
23.94P: /3, to 0 sec.

Media Block

Slow shutter
2 to 8, 16 frames

Card slots
Type: Express Card34
Number of slots: 2
Connector: Conforms to PCMCIA Express Card
Standard

Dynamic range
600%
460% (1080/29.97P, 1080/25P, 1080/23.98P)

Writing rate
50 Mbps or more

Reading rate

50 Mbps or more

Smear
-135dB

Audio Block

Inputs/Outputs

Input/Output connectors

Sampling frequency
48 kHz

Quantization
16 bits/24 bits

Headroom
20 dB (the factory default setting)
(20, 18, 16, 12 dB), EBU

Signal inputs

GENLOCK IN: BNC type
1.0 Vp-p, 75 Q, unbalanced

TC IN: BNC type
0.5 Vto 18 Vp-p, 10 kQ

AUDIO IN CH-1/CH-2: XLR type, 3-pin,
female
(With automatic detection and switching
function)

MIC: -70 to —20 dBu

Specifications
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LINE: +4, 0, -3 dBu
MIC IN: XLR type, 5-pin, female
—70 to —20 dBu
WRR CH1/CH2
D-sub 15-pin
WRR analog: —40 dBu
WRR digital: -40 dbFS
HD/SD SDI
When an option is installed
4-channel audio

OPERATION MANUAL
Japanese version (1)
English version (1)

CD-ROM
- Utility Software for XDCAM (application
software, device driver software) (1)
- Manuals for Solid-State Memory Camcorder
(PDF OPERATION MANUAL and
SUPPLEMENT) (1)

Signal outputs

VIDEO OUT: BNC type, switching between SD

analog composite and HD-Y
HD/SD SDI OUT 1/2: BNC type
0.8 Vp-p, unbalanced (switching between
HD and SD)
Complied to SMPTE292M/259M
4-channel audio (CH1 to CH4)
AUDIO OUT: XLR type, 5-pin, male
+4, 0, -3 dBu (balanced)
TC OUT: BNC type
1.0 Vp-p, 75 Q
EARPHONE (stereo minijack)
8Q,5mW

Recommended Additional
Equipment

SD Record and Playback Option

SD Record and Playback Key
CBK-MDO02

Others

DC IN: XLR type, 4-pin, male
11to 17 VDC

DC OUT: 4-pin
11 to 17 V DC, maximum rated current:
0.5A

LENS: 12-pin
Supplying power to the lens
11 to 17 V DC, maximum rated current:
1.0A

REMOTE: 8-pin

LIGHT: 2-pin

USB: 4-pin (type A), 4-pin (type B)

i.LINK (HDV/DV): 6-pin, complies with
IEEE1394

VF: 26-pin, rectangular, 20-pin round

For wireless receiver: D-sub 15-pin

Supplied Accessories

Shoulder strap (1)
Cold shoe kit (1 set)
Lens mount cap (1)

Flange back adjustment chart

Specifications

Power supply and related equipment

AC Adaptor
AC-DN10/DN2B

Battery Pack
BP-L80S/L60S

Battery Charger
BC-M150/L500/L70

Lens, Viewfinder and Related Equipment

Lens

2/3—lype bayonet mount lenses only

Viewfinder
HD viewfinder: HDVF-200/20A/C35W/
C950W/C730W

Viewfinder Rotation Bracket
BKW-401

Equipment for remote control

Remote Control Unit
RM-B150/B750
RCP-1000/1500/1530

SDI/COMPOSITE Input and 50 Pin Interface
CBK-HDO02

HD Camera Adaptor
XDCA-55 (when an optional CBK-HD02
installed)

HD Camera Extension Unit
XDCU-50




SxS Memory Card
SxS PRO SBP-16 (16 GB)
SxS PRO SBP-32 (32 GB)
SxS-1 SBS-32G1A (32 GB)
SxS-1 SBS-64G1A (64 GB)

Dimensions

Professional Harddisk Unit
PHU-60K/120K/120R (in FAT mode)

Media Adaptor
MEAD-MSO01 (for “Memory Stick PRO-HG
Duo HX” series)
MEAD-SDO1 (for SDHC card)

Mobile Storage Unit
PXU-MS240

Audio equipment

Microphone
ECM-678/674/673/680S

Microphone Holder
CAC-12

269 (10 5/8)

332 (13 '/8)

(in mm (inches))

Design and specifications are subject to change
without notice.

Wireless Microphone
DWR-S01D
WRR-8555/860C/861/862

Other peripheral devices

Tripod adaptor
VCT-14/U14

Video Light
UC-D200A (PROTECH)
Ultralight (Anton Bauer)

Pad
CBK-SP01 Soft Type Shoulder Pad

Equipment for maintenance and easier handling

Hard Carrying Case
LC-H300

Soft Carrying Case
LC-DS300SFT

Maintenance Manual

¢ Always make a test recording, and verify that it was

recorded successfully.

SONY WILL NOT BE LIABLE FOR DAMAGES
OF ANY KIND INCLUDING, BUT NOT
LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF
FAILURE OF THIS UNIT OR ITS RECORDING
MEDIA, EXTERNAL STORAGE SYSTEMS OR
ANY OTHER MEDIA OR STORAGE SYSTEMS
TO RECORD CONTENT OF ANY TYPE.
Always verify that the unit is operating properly
before use. SONY WILL NOT BE LIABLE FOR
DAMAGES OF ANY KIND INCLUDING, BUT
NOT LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF THE
LOSS OF PRESENT OR PROSPECTIVE
PROFITS DUE TO FAILURE OF THIS UNIT,
EITHER DURING THE WARRANTY PERIOD
OR AFTER EXPIRATION OF THE
WARRANTY, OR FOR ANY OTHER REASON
WHATSOEVER.
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Chart of Optional Components and Accessories

ECM-680S/678/
M 674/673
Microphone

CAC-12
>\7 Microphone Holder

HDVF-200/20A/
C35W/C950W/

Xipuaddy

HD monitor/SD monitor

XDCAM HD series recorder

PDW-F1600/HD1500, PDW-F75

C730W Viewfinder

PMW-500

— RM-B150/B750

o u| RCP-730/750/751/
920/921
MSU-900/950/700
Remote Control Unit

VCT-14/U14
\
Tripod Adaptor

Tripod

Case

LC-H300
Hard Carrying Case

Iw

HDCAM series recorder
HDW-2000 series recorder, HDW-S280

WRR-855S UHF Synthesized Tuner Unit
WRR-860C/861/862 UHF Synthesized Diversity Tuner
DWR-S01D Digital Wireless Receiver

SBP-16/32

—_— |[:I SBS-32G1A/64G1A
| L’J SxS Memory Card

MEAD-MS01, MEAD-SD0O1 Media Adaptor

CBK-MDO01 SD Record and Playback Key

s PXU-MS240 Mobile Storage Unit

PHU-60K/120K/120R
Professional Harddisk Unit

CBK-HD02 SDI/COMPOSITE Input and 50 Pin
Interface + XDCA-55 HD Camera Adaptor

P-GL95/GL65/L80S/
60S Charger

BC-L70 Battery BC-M150Battery
Charger
attery Pack

@ BC-L500 Battery
Charger

AC-DN10/DN2B
AC Adaptor

a) The carrying case is large enough to hold the camcorder with lens and microphone mounted. However,
remove them if they protrude more than 25 cm (9 7/8 inches) from the front of the main unit.
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About i.LINK

This section explains the specifications and
features of i. LINK.

What is i.LINK?

i.LINK is a digital serial interface designed to

integrate devices equipped with i. LINK

connectors. i.LINK allows your device to:

¢ Perform two-way transmission and reception of
data such as digital audio and digital video
signals.

¢ Control other i.LINK devices.

 Easily connect multiple devices with a single
i.LINK cable.

Your i.LINK device is capable of connecting to a

wide range of digital AV devices for data transfer

and other operations.

Other advantages include the following feature.

When connected to multiple i. LINK devices,

your i.LINK device can perform data transfer and

other operations not only

with the directly connected devices but also with

any of the devices that are connected to those

devices. Therefore, you do not need to be

concerned with device connection order.

However, depending on the features and

specifications of the connected devices, you may

need to use certain functions differently, and you

may not be able to transfer data or perform certain

operations.

i.LINK, a nickname for IEEE 1394 proposed by
Sony, is a trademark supported by many
companies worldwide.

IEEE 1394 is an international standard defined by
IEEE, the Institute of Electrical and Electronics
Engineers, Inc.

The camcorder can be connected to one device with the
i.LINK cable (DV cable). When you connect with an
HDV or DV device that has two or more i. LINK
connectors, refer to the

Operating Instructions supplied with the connected
device.

Ahout data transfer speed of i.LINK

i.LINK defines a maximum data transfer speed of

approximately 100, 200 and 400 Mbps D that are

described as S100, S200 and S400 respectively.

For i.LINK devices, a maximum data transfer

speed that the device supports is identified on

“Specifications” page of the Operating

Instructions supplied with the device or near its

i.LINK connector.

1) When connecting with the device that support
different data transfer speed, the actual data transfer
speed may be different from those described on the
i.LINK connectors.

What is Mbps?

Mega bits per second. A measure of the rate at
which data is transmitted per second. In case of
100 Mbps, 100 Mega bits of data can be
transmitted per second.

i.LINK operation with your camcorder

For details on operation when other equipment
with i.LINK (HDV or DV) connector is
connected, see page 148.

For details on connection with i.LINK cable and

necessary software, refer to the Operating
Instructions supplied with the connected device.

Ahout the required i.LINK cable

Use the Sony 6-pin-to-4-pin or 6-pin-to-6-pin
i.LINK cable to connect the i.LINK devices.

i.LINK and g, are trademarks.

About i.LINK
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MPEG-4 Visual Patent
Portfolio License

THIS PRODUCT IS LICENSED UNDER THE
MPEG-4 VISUAL PATENT PORTFOLIO
LICENSE FOR THE PERSONAL AND NON-
COMMERCIAL USE OF A CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE
WITH THE MPEG-4 VISUAL STANDARD
(“MPEG-4 VIDEO”)

AND/OR

(ii) DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN
A PERSONAL AND NON-COMMERCIAL
ACTIVITY AND/OR WAS OBTAINED FROM
A VIDEO PROVIDER LICENSED BY MPEG
LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING
THAT RELATING TO PROMOTIONAL,
INTERNAL AND COMMERCIAL USES AND
LICENSING MAY BE OBTAINED FROM
MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/
sales of any storage media storing MPEG-4 Visual video
information (ii) distribution/broadcasting of MPEG-4
Visual video information in any manner (such as online
video distribution service, internet broadcasting, TV
broadcasting). Other usage of this product may be
required to obtain license from MPEGLA. Please contact
MPEG LA for any further information. MPEG LA,
L.L.C., 250 STEELE STREET, SUITE 300, DENVER,
COLORADO 80206, http://www.mpegla.com

MPEG-2 Video Patent
Portfolio License

ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY
MANNER THAT COMPLIES WITH THE
MPEG-2 STANDARD FOR ENCODING
VIDEO INFORMATION FOR PACKAGED
MEDIA IS EXPRESSLY PROHIBITED
WITHOUT A LICENSE UNDER
APPLICABLE PATENTS IN THE MPEG-2
PATENT PORTFOLIO, WHICH LICENSE IS
AVAILABLE FROM MPEG LA, L.L.C,, 250
STEELE STREET, SUITE 300, DENVER,
COLORADO 80206.

“PACKAGED MEDIA” means any storage
media storing MPEG-2 video information such as
DVD movie which are sold/distributed to general
consumers. Disc replicators or sellers of the
PACKAGED MEDIA need to obtain licenses for
their own business from MPEG LA. Please
contact MPEG LA for any further information.
MPEG LA. L.L.C., 250 STEELE STREET,
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

MPEG-4 Visual Patent Portfolio License / MPEG-2 Video Patent Portfolio License
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Symbols

! (warning) indicator 27

A

AC power 32
ACCESS lamps 18, 22
Accessories (optional) 168
Accessory fitting shoe 13
ALARM knob 16
Area setting 36
Arrow buttons (<=, =, ¢+, &) 20
ASSIGN. 0 switch 16
ASSIGN. 1/2/3 switches 15
ASSIGNABLE 4/5 switches 21
Assignable switches, assigning functions 135
ATW (Auto Tracing White Balance) 17
Audio control section 20
AUDIO IN CH-1/CH-2 connectors 23
AUDIO IN CH1/CH2/CH3/CH4
switches 21

AUDIO IN selectors 23
Audio input system 39
Audio level

adjusting 56

adjusting playback level 16

meters 30
AUDIO OUT connector 23
AUDIO SELECT CHI1/CH2 switches 21
AUTO W/B BAL switch 15

BACKLIGHT button 20
BATT indicator 27
Battery
attachment shoe 13
of the internal clock, exchanging 163
pack 31
remaining 28
BKW-401 33
Black balance, adjusting 50

BRIGHT control 26

C

Camera operator tally indicator 25
Clip Continuous Rec 76
Clip(s)
batch copy 91
copying 90
cueup 82
deleting 70,91
displaying properties 88
dividing 94
operating with a computer 146
operations 79
playing 69, 82
protecting 90
selecting 82
Clock setting 37
Color LCD 18
COLOR TEMP. button 16
Color temperature 28
Connection 144
monitors 144
using i.LINK 148
CONTRAST control 26
Cover 17

D

Date, setting 37

DC IN connector 13

DC OUT 12V connector 13

DCC (Dynamic Contrast Control) 16
Diopter adjustment ring 25

DISP SEL/EXPAND button 19
DISPLAY switches 19
DISPLAY/ASPECT switch 26

E

EARPHONE jack 23
EJECT buttons 22
Electric color temperature filter 30
ESSENCE MARK button 20
Essence mark thumbnail screen 93
Expand thumbnail screen

displaying 92

to increase the number of divisions 93
Extender 27

Index
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External devices 144

control 29
External input 30
External power source 28
Eyecup 25

F

F FWD button/indicator 19
F REV button/indicator 18
Filter position 30
FILTER selector 15
Fitting for optional microphone holder 14
Flange focal length, adjusting 38
Focus
adjustment mode 29
position 28
Frame Rec 74
Framing shots 77
Freeze Mix 77
F-RUN/SET/R-RUN switch 20

G

GAIN selector 16

Gain value 30

GENLOCK IN connector 22
Green tally 28

Green tally indicator 26

H

HD/SD SDI OUT connector 23
HOLD button 19

iLINK 169
cable 169
connection 148
i.LINK (HDV/DV) connector 24
Index picture 81
changing 94
Indicators and status display 25
Initial value 98
Input source 29
Internal clock 37
Interval Rec 72
Iris
position 30

Index

L

LCD panel 18
Lens
cable clamp 14
locking lever 14
mount 14
mount cap 14
mount securing rubber 14
mounting 37
LENS connector 14
Lens file(s)
loading 142
loading automatically 143
saving 142
setting data 142
LEVEL CH1/CH2/CH3/CH4 knobs 20
LIGHT connector 14
LIGHT switch 12
Line input audio equipment, connecting 42

Maintenance 151
Media
remaining capacity 25, 30
status 28
MENU button 20
MENU CANCEL/PRST/ESCAPE switch 17
MENU knob 15
MENU ON/OFF switch 17
MIC IN (+48 V) connector 14
MIC LEVEL control 15
Microphone holder 26
fitting 14
Microphone, connecting 39
MONITOR knob 16
MONITOR switches 16
Monitor, connecting 144

ND filter 15

NEXT button 19
Nonlinear editing 147, 149
Number of system lines 29



0

OK/NG/KP mark(s) 80, 89
adding 89
deleting 89
setting 71
Operation status 28
of i.LINK device 29
Optional components 168
OUTPUT/DCC switch 16

P

PC connector 22

PEAKING control 26

Picture Cache 71

PLAY/PAUSE button/indicator 18

Plug 25

Power source voltage/battery remaining
capacity 28

Power supply 31

POWER switch 12

Preset values, resetting 140

PRESET/REGEN/CLOCK switch 21

PREV button 19

R

REC indicator 27
REC START button 14
Recording
external input signals 149
from pre-stored video 71
on an external device 148
remaining time 66
review 68
time-lapse video 72
Recording mode 49
special settings indication 28, 29
Red tally indicator 27
REMOTE connector 23
Reset 98, 140
RESET/RETURN button 19

S

SxS memory card slots 22

SxS memory cards 63
ejecting 65
formatting 65

loading 64

restoring 67

selecting 65
Scene files

loading 141

saving 141
SDIIN connector 22
Search

with the essence mark thumbnail screen

83

with the expand thumbnail screen 83

SET button 20
Setup menu 95
basic operations 97
FILE menu 131
MAINTENANCE menu 118
menu list 99
OPERATION menu 99
PAINT menu 112
SHIFT button 21
Shooting 63
basic operations 68
stop motion animations 74
with Slow & Quick motion 75
Shot mark(s)
adding 93
adding during playback 83
deleting 94
recording 70
Shoulder pad 14
adjusting the position 46
Shoulder strap fitting 13
Shoulder strap, using 45

Shutter
setting 53
speed 53

SHUTTER selector 14

Slot cover 22

SLOT SELECT button 22

Speaker 18

Specifications 163

Status information 61

Status screens 61
ASSIGN SWITCH 61
AUDIO 61
BATTERY/MEDIA 62
CAMERA 61
VIDEO 61

STOP button 19

Stopper 25
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System configuration 150

T

TALLY indicator 26
Tally indicator 25
TALLY indicators 23
TALLY switch 23,26
TC IN connector 22
TC OUT connector 22
Testing 151
THUMBNAIL button 20
THUMBNAIL indicator 20
THUMBNAIL menu 84
operations 86
Thumbnail screen 79
displaying OK clip thumbnails only 86
displaying the all clips thumbnail 87
Thumbnail(s)
changing the screen type 86
operations 84
Time, setting 37
Timecode 29
setting 58
synchronizing 59
TLCS automatic adjustment 55
TLCS control mode 29
Tripod mount 14
Tripod, mounting 43

u

UHF portable tuner, attaching 41
User bits setting 59
User setting data

loading 140

saving 139
v
Video format 89
setting 47

Video level indication 29
Video light, connecting 44
VIDEO OUT connector 22
Viewfinder
adjusting focus 35
adjusting position 33
adjusting screen 35
attaching 32

Index

cleaning 151
connectors 13
detaching eyepiece 34
fitting shoe 13
HDVF-20A (optional) 25
positioning knob 14
positioning lever 13
positioning ring 13
screen 27
screen display 27
status display 26
Viewfinder cable 26
Voltage capacity 28
VTR SAVE indicator 27

w

WARNING indicator 18

Warnings 153

WHITE BAL switch 16

White balance memory 30

White balance, adjusting 51

Wireless microphone reception level 28
Write protect 64

/4

ZEBRA switch 26
Zoom
position 28



The material contained in this manual consists of
information that is the property of Sony
Corporation and is intended solely for use by the
purchasers of the equipment described in this
manual.

Sony Corporation expressly prohibits the
duplication of any portion of this manual or the
use thereof for any purpose other than the
operation or maintenance of the equipment
described in this manual without the express
written permission of Sony Corporation.
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